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Trademark/copyright information

SYNRAD and WinMark Pro are registered trademarks of SYNRAD, Inc.

ActiveMark, Fenix, Firestar, and Power Wizard are trademarks of SYNRAD, Inc.

All other trademarks or registered trademarks are the property of their respective owners.

© 2012 by SYNRAD, Inc.  

All rights reserved.
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Warranty information
SYNRAD, Inc. warrants that for a period of ninety (90) days after your receipt of the software, that the 

disk on which the Software is distributed will be free from defects in material and workmanship under 

normal operating conditions. SYNRAD will replace a defective disk at no charge provided you return the 

defective disk along with a copy of your receipt to SYNRAD within 90 days of the date you took posses-

sion of the software. The warranty is the only express warranty pertaining to this software program and 

no other representations or claims of any nature shall be binding or obligate SYNRAD, Inc., including 

implied warranties of merchantability or fitness for a particular period. This limited warranty gives you 

specific rights. You may have others, which vary from state to state.

SYNRAD, Inc. and SYNRAD Authorized Distributors have the sole authority to make warranty state-

ments regarding SYNRAD products. SYNRAD, Inc. and its Authorized Distributors neither assumes nor 

authorizes any representative or other person to assume for us any other warranties in connection with the 

sale, service, or shipment of our products. SYNRAD, Inc. reserves the right to make changes and improve-

ments in the design of our products at any time without incurring any obligation to make equivalent 

changes in products previously manufactured or shipped. Buyer agrees to hold SYNRAD harmless from 

any and all damages, costs, and expenses relating to any claim arising from the design, manufacture, or use 

of the product, or arising from a claim that such product furnished Buyer by SYNRAD, or the use thereof, 

infringes upon any Patent, foreign or domestic.

Single user, one computer license
SYNRAD, Inc. grants you a non-exclusive “single-user” license to use our computer application (the “Soft-

ware”) and the related documentation according to the terms set forth in this agreement. SYNRAD, Inc. 

reserves all rights, including ownership of all copies of this software not expressly granted to you. 

You may:

a. Use the Software on only one computer at time.

b. Have the Software installed on only one computer at a time (this means you need to purchase two 

copies if you wish to run it at home and at work.

c. Make one backup copy of the Software, which is automatically subject to this agreement, in support of 

your use of this Software.

d. Transfer the Software, including all copies and Documentation, to another party if the other party 

agrees to accept the terms and conditions of this agreement. Your transfer of the Software terminates 

your license from SYNRAD , Inc.

You may not:

a. Distribute the Software, Documentation, Photographs, or copies or portions thereof in any manner or 

form or use.

b. Copy or transfer the Software. Documentation, or Photographs, in whole or in part, except as pro-

vided above.

c. Duplicate or electronically distribute the Software. Documentation, or Photographs, except as pro-

vided above.

d. Alter, merge, modify, adapt, decompile, or reverse engineer the Software.

e. Remove, obscure, or alter any SYNRAD, Inc. patent, copyright, or other proprietary rights notice.



Contact information  xvi

WinMark Pro v6.3 User Guide

Contact information

Worldwide headquarters
SYNRAD’s worldwide headquarters are located north of Seattle in Mukilteo, Washington, U.S.A. Our 

mailing address is: SYNRAD, Inc. 

 4600 Campus Place 

 Mukilteo, WA 98275 U.S.A.

Phone us at: 1.800.SYNRAD1 (1.800.796.7231)

Outside the U.S.: +1.425.349.3500

Fax: +1.425.349.3667

Email: synrad@synrad.com

Sales and Applications

SYNRAD’s Regional Sales Managers work with customers to identify and develop the best CO
2
 laser solu-

tion for a given application. Because they are familiar with you and your laser application, use them as a 

first point of contact when questions arise. Regional Sales Managers also serve as the liaison between you 

and our Applications Lab in processing material samples per your specifications. 

Customer Service

For assistance with order/delivery status, service status, or to obtain a Return Authorization (RA) number, 

contact SYNRAD and ask to speak to a Customer Service representative.

Technical Support

SYNRAD’s Regional Sales Managers are able to answer many technical questions regarding the instal-

lation, use, troubleshooting, and maintenance of our products. In some cases, they may transfer your call 

to a Laser, Marking Head, or Software Support Specialist. You may also email questions to the Technical 

Support Group by sending your message to support@synrad.com or to support@winmark.com.

Reference materials

Your Regional Sales Manager can provide reference materials including Outline & Mounting drawings, 

Operator’s Manuals, Technical Bulletins, and Application Newsletters. Most of these materials are also 

available directly from SYNRAD’s web site at http://www.synrad.com.

European headquarters
For assistance in Europe, contact SYNRAD’s European subsidiary, Synrad Europe, at: 

 Synrad Europe 

 Münchener Straße 2A Phone: +49 (0) 89 89 1462-0 

 D-82152 Planegg Fax: +49 (0) 89 89 1462-69 

 Germany E-mail: info@ synrad-europe.com

mailto: synrad@synrad.com
mailto: support@synrad.com
mailto: support@winmark.com
http://www.synrad.com
info@ synrad-europe.com
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Hazard information
Hazard information includes terms, symbols, and instructions used in this manual or on the equipment to 

alert both operating and service personnel to the recommended precautions in the care, use, and handling 

of Class 4 laser equipment.

Terms
Certain terms are used throughout this manual or on the equipment labels. Please familiarize yourself with 

their definitions and significance.

  Imminent hazards which, if not avoided, will result in death or serious injury.

  Potential hazards which, if not avoided, could result in death or serious injury.

   Potential hazards or unsafe practices which, if not avoided, may result in minor or   

   moderate injury.

Potential hazards or unsafe practices which, if not avoided, may result in product 

damage.

   Important information or recommendations concerning the subject under discussion.

   Points of particular interest for more efficient or convenient equipment operation;   

   additional information or explanation concerning the subject under discussion.

General hazards
Following are descriptions of general hazards and unsafe practices that could result in death, severe injury, 

or product damage. Specific warnings and cautions not appearing in this section are found throughout the 

manual.

Danger:

Warning:

Caution:

Important Note:

Caution:

Danger

serious 

personal 

injury

SYNRAD CO
2
 lasers are Class 4 laser products that emit invisible 

infrared laser radiation in the 10.6 µm CO
2
 wavelength band. 

Do not allow laser radiation to enter the eye by viewing direct or re-

flected laser energy. CO
2
 laser radiation can be reflected from metallic 

objects even though the surface is darkened. Direct or diffuse laser 

radiation can inflict severe corneal injuries leading to permanent eye 

damage or blindness. All personnel must wear eye protection suitable 

for 10.6 µm CO
2
 radiation when in the same area as an exposed laser 

beam. Eyewear protects against scattered energy but is not intended 

to protect against direct viewing of the beam—never look directly 

into the laser output aperture or view scattered laser reflections from 

metallic surfaces. 

Enclose the beam path whenever possible. Exposure to direct or dif-

fuse CO
2
 laser radiation can seriously burn human or animal tissue, 

which may cause permanent damage. 

Note:
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Warning

serious 

personal 

injury

U.S. customers should refer to and follow the laser safety precautions 

described in the American National Standards Institute (ANSI) 

Z136.1-2007 document, Safe Use of Lasers. Procedures listed in this 

Standard include the appointment of a Laser Safety Officer (LSO), 

operation of the product in an area of limited access by trained per-

sonnel, servicing of equipment only by trained and authorized person-

nel, and posting of signs warning of the potential hazards. 

European customers should appoint a Laser Safety Officer (LSO) who 

should refer to and follow the laser safety precautions described in EN 

60825-1, 2007—Safety of Laser Products.

Warning

serious 

personal 

injury

Materials processing with a laser can generate air contaminants such 

as vapors, fumes, and/or particles that may be noxious, toxic, or 

even fatal. Material Safety Data Sheets (MSDS) for materials being 

processed should be thoroughly evaluated and the adequacy of provi-

sions for fume extraction, filtering, and venting should be carefully 

considered. Review the following references for further information 

on exposure criteria:

ANSI Z136.1-2007, Safe Use of Lasers, section 7.3.

U.S. Government’s Code of Federal Regulations: 29 CFR 1910, Sub-

part Z.

Threshold Limit Values (TLV’s) published by the American Confer-

ence of Governmental Industrial Hygienists (ACGIH).

It may be necessary to consult with local governmental agencies 

regarding restrictions on the venting of processing vapors.

Warning

serious 

personal 

injury

The use of controls or adjustments or performance of procedures 

other than those specified herein may result in hazardous radiation 

exposure.

Danger

serious 

personal 

injury

SYNRAD CO
2
 laser products are not intended for use in explosive, 

or potentially explosive, atmospheres.
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SYNRAD CO
2
 laser products should be installed and operated in manufacturing or laboratory facilities 

by trained personnel only. Due to the considerable risks and hazards associated with the installation and 

operational use of any equipment incorporating a laser, the operator must follow product warning labels 

and instructions to the user regarding laser safety. 

To prevent exposure to direct or scattered laser radiation, follow all safety precautions specified through-

out this manual as well as precautions given in laser and marking head Operator’s Manuals. Exercise safe 

operating practices per ANSI Z136.1-2007 at all times when actively lasing. 

Always wear safety glasses or protective goggles with side shields to reduce the risk of damage to the eyes 

when operating the laser. 

A CO
2
 laser is an intense heat source and will ignite most materials under proper conditions. Never oper-

ate the laser in the presence of flammable or explosive materials, gases, liquids, or vapors.

The use of controls or adjustments or performance of procedures other than those specified herein may re-

sult in exposure to hazardous invisible laser radiation, damage to, or malfunction of the laser. Severe burns 

will result from exposure to the laser beam. 

Safe operation of the laser requires the use of an external beam block to safely block the beam from travel-

ing beyond the desired work area. Do not place your body or any combustible object in the path of the 

laser beam. Use a water-cooled beam dump or power meter, or similar non-scattering, noncombustible 

material as the beam block. Never use organic material or metals as the beam blocker; organic materials, in 

general, are apt to combust or melt and metals act as specular reflectors which may create a serious hazard 

outside the immediate work area.

Other hazards

The following hazards are typical for SYNRAD CO
2
 laser products when incorporated for intended use: 

(A) risk of injury when lifting or moving the unit; (B) risk of exposure to hazardous laser energy through 

unauthorized removal of access panels, doors, or protective barriers; (C) risk of exposure to hazardous 

laser energy and injury due to failure of personnel to use proper eye protection and/or failure to adhere to 

applicable laser safety procedures; (D) risk of exposure to hazardous or lethal voltages through unauthor-

ized removal of covers, doors, or access panels; (E) generation of hazardous air contaminants that may be 

noxious, toxic, or even fatal.

Additional laser safety information

The SYNRAD web site (http://www.synrad.com/LaserFacts/lasersafety.html) contains an online laser safety 

handbook that provides information on (1) Laser Safety Standards for OEM’s/System Integrators including 

product classification, product housing, product features, and other CDRH requirements; (2) Laser Safety 

Standards for End Users including Class I installations, Class 4 installations, laser hazards, ANSI Standard, 

U.S. State requirements, and OSHA; (3) References and Sources including CDRH, ANSI/OSHA; and 

(4) Assistance with Requirements. 

In addition, the Occupational Safety and Health Administration (OSHA) provides an online Technical 

Manual (located at http://www.osha.gov/dts/osta/otm/otm_iii/otm_iii_6.html). Section III, Chapter 6 and 

Appendix III are good resources for laser safety information. 

Another excellent laser safety resource is the Laser Institute of America (LIA). Their comprehensive web 

site is located at www.laserinstitute.org.

http://www.synrad.com/LaserFacts/lasersafety.html
http://www.osha.gov/dts/osta/otm/otm_iii/otm_iii_6.html
www.laserinstitute.org
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Agency compliance
The Agency compliance section includes subsections: 

■ Center for Devices and Radiological Health (CDRH) requirements

■ Federal Communications Commission (FCC) requirements

■ European Union (EU) requirements

SYNRAD lasers are designed, tested, and certified to comply with certain United States (U.S.) and Eu-

ropean Union (EU) regulations. These regulations impose product performance requirements related to 

electromagnetic compatibility (EMC) and product safety characteristics for industrial, scientific, and medi-

cal (ISM) equipment. The specific provisions to which systems containing SYNRAD lasers must comply 

are identified and described in the following paragraphs. Note that compliance to CDRH, FCC, and EU 

requirements depends in part on the laser version selected—Keyswitch or OEM.

In the U.S., laser safety requirements are governed by the Center for Devices and Radiological Health 

(CDRH) under the auspices of the U.S. Food and Drug Administration (FDA) while radiated emission 

standards fall under the jurisdiction of the U.S. Federal Communications Commission (FCC). Outside the 

U.S., laser safety and emissions are governed by European Union (EU) Directives and Standards.

In the matter of CE-compliant laser products, SYNRAD, Inc. assumes no responsibility for the compliance 

of the system into which the product is integrated, other than to supply and/or recommend laser compo-

nents that are CE marked for compliance with applicable European Union Directives.

Because OEM laser products are intended for incorporation as components in a laser processing system, 

they do not meet all of the Standards for complete laser processing systems as specified by 21 CFR, Part 

1040 or EN 60825-1. SYNRAD, Inc. assumes no responsibility for the compliance of the system into 

which OEM laser products are integrated.

Center for Devices and Radiological Health 
(CDRH) requirements

Keyswitch models

SYNRAD Keyswitch model lasers comply with requirements for Class 4 laser products imposed by the 

Radiation Control for Health and Safety Act of 1968. Under this Act, the U.S. Food and Drug Adminis-

tration (FDA) issued a performance standard in the Code of Federal Regulations (CFR) for laser products. 

This performance standard, (21 CFR, Subchapter J, Part 1040.10) was developed to protect public health 

and safety by imposing requirements upon manufacturers of laser products to provide an indication of the 

presence of laser radiation, to provide the user with certain means to control radiation, and to assure that 

all personnel are adequately warned of potential hazards through the use of product labels and instructions. 

Product features incorporated into the design of SYNRAD Keyswitch lasers to comply with CDRH re-

quirements are integrated as panel controls or indicators, internal circuit elements, or input/output signal 

interfaces. Specifically, these features include a keyswitch (Keyswitch versions), lase and laser ready indica-

tors, remote interlock for power on/off, a laser aperture shutter switch, and a five-second delay between 

power on and lasing. Incorporation of certain features is dependent on the laser version (Keyswitch or 

OEM). 
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OEM models

SYNRAD OEM lasers are OEM products intended for incorporation as components in laser processing 

systems. As supplied by SYNRAD, these lasers do not meet the requirements of 21 CFR, Subchapter J 

without additional safeguards. In the U.S., the Buyer of these OEM laser components is solely responsible 

for the assurance that the laser processing system sold to an end user complies with all laser safety require-

ments before the actual sale of the system. Under CDRH regulations, the Buyer must submit a report to 

the CDRH prior to shipping the system. In jurisdictions outside the U.S., it is the sole responsibility of the 

Buyer of these OEM components to ensure that they meet all applicable local laser safety requirements. In 

cases where the Buyer is also the end-user of the OEM laser product, the Buyer/end-user must integrate the 

laser so that it complies with all applicable laser safety standards as set forth above.

Federal Communications Commission 
(FCC) requirements
The United States Communication Act of 1934 vested the Federal Communications Commission (FCC) 

with the authority to regulate equipment that emits electromagnetic radiation in the radio frequency spec-

trum. The purpose of the Communication Act was to prevent harmful electromagnetic interference (EMI) 

from affecting authorized radio communication services. The FCC regulations that govern industrial, 

scientific, and medical (ISM) equipment are fully described in 47 CFR, Part 18, Subpart C.

FCC caution to the user

The Federal Communications Commission warns the user that changes or modifications of the unit not 

expressly approved by the party responsible for compliance could void the user’s authority to operate the 

equipment.

European Union (EU) requirements

Laser safety standards

Under the Low Voltage Directive, 2006/95/EC, the European Norm (EN) document EN 60825-1 was de-

veloped to protect persons from laser radiation by imposing requirements upon manufacturers of laser prod-

ucts to provide an indication of laser radiation; to classify laser products according to the degree of hazard; 

to require both user and manufacturer to establish procedures so that proper precautions are adopted; to 

ensure adequate warning of the hazards associated with accessible radiation through signs, labels, and 

instructions; to improve control of laser radiation through protective features; and to provide safe usage of 

laser products by specifying user control measures.

Keyswitch models

SYNRAD Keyswitch models are designed to comply with the requirements imposed by EN 

60825-1 for Class 4 laser products. 

OEM models

SYNRAD OEM lasers are OEM products intended for incorporation as components in laser 

processing systems. As supplied by SYNRAD, these lasers do not meet the requirements of 

EN 60825-1 without additional safeguards. European Union Directives state that “OEM 

laser products which are sold to other manufacturers for use as components of any system for 
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subsequent sale are not subject to this Standard, since the final product will itself be subject 

to the Standard.” This means that Buyers of OEM laser components are solely responsible for 

the assurance that the laser processing system sold to an end-user complies with all laser safety 

requirements before the actual sale of the system. Note that when an OEM laser component is 

incorporated into another device or system, the entire machinery installation may be required 

to conform to EN 60825-1, EN 60204-1:2006, Safety of Machinery; the Machinery Directive 

EN 2006/42/EC; and/or any other applicable Standards. In cases where the Buyer is also the 

end-user of the OEM laser product, the Buyer/end-user must integrate the laser so that it com-

plies with all applicable laser safety standards as set forth above.

Electromagnetic interference standards

The European Union’s Electromagnetic Compatibility (EMC) Directive, 2004/108/EC, is the sole Direc-

tive developed to address electromagnetic interference (EMI) issues in electronic equipment. In particular, 

the Directive calls out European Norm (EN) documents that define the emission and immunity standards 

for specific product categories. For SYNRAD lasers, EN 55011 and CISPR:11 define radiated and conduct-

ed RF emission limits while the generic Standards EN 61326 and EN 50082-1 define immunity require-

ments published by the International Electromechanical Commission (IEC). 

When integrating SYNRAD’s OEM lasers, the Buyer and/or integrator of the end system is responsible for 

meeting all applicable Standards to obtain the CE mark.
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Getting Started
Use information in this section to install WinMark Pro software and to create a sample 
drawing for laser marking.

This section contains the following chapters:

■	 Chapter 1 – Introduction 

describes new features, computer system requirements, software upgrades, version 

information, mark file compatibility, and technical support availability.

■	 Chapter 2 – Installation 

explains how to install WinMark Pro Laser Marking software.

■	 Chapter 3 – Starting WinMark Pro 

explains basic concepts and initial setup of operating parameters.

■	 Chapter 4 – WinMark Pro Drawing Editor 

describes WinMark Pro’s drawing environment and tool set.

■	 Chapter 5 – Creating a drawing 

steps through the creation of a sample mark file (drawing).

■	 Chapter 6 – File development 

explains offline and on-line file development.

■	 Chapter 7 – WinMark Launcher 

describes opening and marking WinMark Pro files using WinMark Launcher.

■	 Chapter 8 – WinMark Digital Scope 

describes using Digital Scope to test and troubleshoot laser control and I/O prob-

lems.
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1 Introduction
The Introduction chapter includes sections:

 New features

 Requirements

 Software upgrades

 Version 6.3 information

 Legacy version information

 WinMark Pro OS compatibility

 WinMark Pro hardware compatibility

 Mark file compatibility

 Technical support

Welcome to SYNRAD’s WinMark Pro® Laser Marking Software—software that gives you the power to 

create mark files containing a variety of objects including text, bar code, and even imported professional 

graphics for laser marking your products. In addition to creating virtually any image, WinMark Pro is 

capable of controlling every aspect of the laser marking process including incrementing serial numbers, 

changing laser parameters, and interfacing with automated parts handling equipment. 

New features
WinMark Pro version 6 software is specifically designed to support SYNRAD’s new FH Series Flyer mark-

ing heads and Fenix™ Flyer Laser Markers. New software features found in version 6 include:

 MSI Microsoft® Windows® Installer  UID/Composite 2D Codes

 32-bit and 64-bit USB Drivers  Rotate imported bitmaps at fractional angles

 Improved file import functionality  Micro QR 2D Code 

 Object-specific PWM Frequency  MicroPDF barcodes

 Imports DXF/DWG hatch fills  Radial marking (around cylindrical objects)

 Banner marking  Abort mark from I/O

Please review the Release Notes included with your copy of WinMark Pro. The Release Notes describe new 

features added since the release of this manual. 

Check the WinMark Pro web site (http://www.winmark.com/) frequently for the very latest program up-

dates and releases. 

http://www.winmark.com/
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Requirements
The Requirements section includes subsections:

 Marking head requirements

 WinMark Pro installation requirements

 Operating System (OS) requirements

Important Note: Install WinMark Pro v6.3 before you connect FH Flyer or Fenix Flyer to your com-

puter’s USB port and power it up. If WinMark Pro is not installed first, the Windows 

operating system will arbitrarily assign a USB driver that is not compatible with 

Flyer’s USB port protocols. 

Note: WinMark Pro version 6 software is NOT compatible with Windows® 95 or Windows® 98 operat-

ing systems and is NOT compatible with computers or marking heads requiring ISA-bus Fiber 

Link Controller Card’s. 

Marking head requirements
WinMark Pro v6.3 is specifically designed to operate FH Flyer marking heads and Fenix Flyer Laser Mark-

ers over a Ethernet or USB connection; there is no additional hardware to install. An Ethernet connection 

is required if Flyer will operate over a network in WinMark control mode or access a network share file in 

Stand-alone mode.

In manufacturing environments we highly recommend the use of Ethernet communications instead of 

USB. The Ethernet protocol is better designed for noise immunity and error-free data transfer between 

devices.

Although legacy FH Index and Tracker marking heads, with PCI-bus Fiber Link Controller Cards 

(FLCCs), may function properly when driven by WinMark v6.3, these heads have not been fully tested for 

v6.3 compatibility. We highly recommend using WinMark Pro v4.6 when controlling non-Flyer heads.

WinMark Pro installation requirements
WinMark Pro v6.3 Laser Marking Software has the following minimum requirements:

 16-MB RAM 

 30-MB of free hard disk space 

 CD-ROM drive

 Two open USB ports 

Operating System (OS) requirements
WinMark Pro v6.3 is designed to operate on Microsoft® Windows® 7, Vista®, and XP Operating Systems 

(OS). See the Microsoft web site for a list of minimum hardware requirements for your particular OS.
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Software upgrades
Unlike many other software packages that cost hundreds of dollars to upgrade, WinMark Pro upgrades 

are made available free of charge on the WinMark Pro web site. Users should periodically check our web 

site at: http://www.winmark.com/ to download the latest released version of WinMark Pro Laser Marking 

Software.

Version 6.3 information (Flyer/Fenix Flyer)
(Windows 7/Vista/XP – Ethernet/USB compatible)

WinMark Pro version numbers (6.3.0.××××) and build numbers (×.×.×.7317) are used to track the intro-

duction of new features. A detailed Version History is available from the WinMark Pro web site.

Version 6.3 allows WinMark Pro to operate SYNRAD FH Flyer marking heads and Fenix Flyer Laser 

Markers on Windows 7, Vista, and XP operating systems. Flyer marking heads and Fenix Flyer Laser Mark-

ers require an Ethernet or USB connection for communications.

WinMark Pro v6.3 is a Microsoft .NET Framework-based application. During installation, WinMark Pro 

v6.3 will install .NET Framework files onto your computer, if they do not currently exist. If WinMark 

Pro is un-installed, .NET files are not removed, because these files may now be used by other applications 

installed after the original WinMark installation.

Note: The WinMark Pro version 6.x mark file structure is not compatible with FH Smart marking heads 

and should not be used for FH Smart file development.

Legacy version information
The Legacy version information section includes subsections:

 Version 5.x

 Version 4.x

 Version 3.1

 Version 2.x

 WinMark Lite

 Version 1.x

Version 5.x (Flyer/Fenix Flyer)
(Windows Vista/XP/2000 - Ethernet/USB compatible)

Version 5, beginning with the release of 5.0.0.5558, was developed to support FH Flyer and Fenix Flyers on 

Windows Vista, XP, and 2000 operating systems. Version 5.0 is not recommended or tested to operate PCI-

bus FH Index/Tracker marking heads. Version 5 does not support ISA-bus marking heads. 

Note: The WinMark Pro version 5.x mark file structure is not compatible with FH Smart marking heads 

and should not be used for FH Smart file development.

http://www.winmark.com/


Getting Started  

Chapter 1 – Introduction

6

WinMark Pro v6.3 User Guide

Version 4.x (FH Index/Tracker/Fenix)
(Windows XP/2000/NT4/98 - PCI compatible)

Version 4, beginning with the release of 4.0.0.3773, extends WinMark Pro functionality to Windows XP, 

2000, NT4, and 98 operating systems using PCI-bus Fiber Link Controller Cards. Version 4.0 does not sup-

port Windows 95 operating systems or ISA-bus FLCCs. The last version 4 release, 4.6.2.5245 is available 

from the WinMark Pro web site at: http://www.winmark.com/download.htm.

Version 3.1 (FH Index/Tracker/Fenix) 
(Windows NT4 - PCI compatible)

Version 3.1.0.3767 (as well as build 2.1.0.3509NT) allows WinMark Pro to operate on Windows NT4 

operating systems. These builds are compatible only with PCI-bus FLCCs.

Version 2.x (FH Index/Tracker/Fenix) 
(Windows 98/95 – PCI/ISA/DAC compatible)

WinMark Pro versions 2.0.0.3087 through 2.1.0.3767 add support for FH Series Tracker marking heads on 

Windows 98/95 operating systems. Beginning with build 3468 (v2.1.0.3468), WinMark Pro supports PCI-

bus FLCCs. The last version 2 release, 2.1.0.4056 is available from the WinMark Pro web site.

WinMark Lite (Fenix)
WinMark Lite was packaged with early Fenix Laser Markers, providing an inexpensive method for de-

veloping and marking simple files. Automation features such as I/O capability and serialization were not 

supported. Version 2.1.0.3767 is the last software build to support WinMark Lite functionality.

Version 1.x (DH/SH) 
(Windows 98/95 – ISA/DAC compatible)

WinMark Pro versions 1.0.0.1150 through 1.0.3.2055 support legacy DH/SH Series heads running on 

Windows 98/95 operating systems using an ISA-bus Fiber Link Controller Card (DH Series) or a DDA06 

Digital-to-Analog card (SH Series). Versions 1.0.5.2625 through 1.0.6.2856 added support for Fenix Laser 

Markers and FH Series Index marking heads on Windows 98/95 operating systems using an ISA-bus Fiber 

Link Controller Card (FLCC).

http://www.winmark.com/download.htm
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WinMark Pro OS compatibility
When upgrading your computer and/or operating system (OS), use the matrix shown in Table 1-1 to deter-

mine what WinMark Pro software version(s) and marking head/communication methods are supported. 

Table 1-1  Operating system (OS) compatibility matrix

 Win 95 Win 98 Win NT4 Win 2000 Win XP Vista Win 7

WinMark Pro Version

v2.1.x.xxxx Yes Yes No No No No No

v3.1.0.xxxxNT – – – – Yes No No No No

v4.x.x.xxxx – – Yes Yes Yes Yes No No

v5.x.x.xxxx – – – – – – Yes Yes Yes1, 2 No

> v6.2.0.6977 – – – – – – – – Yes Yes1, 2 Yes1

Communication Method

ISA-bus DAC Yes Yes3 No No No No No  

(SH w/ DDA06 card)

ISA-bus FLCC Yes Yes3 No No No No No 

(DH/Fenix/Index/Tracker)

PCI-bus FLCC – – Yes Yes Yes Yes No4 No4 

(DH/Fenix/Index/Tracker)

Ethernet/USB – – – – – – Yes5 Yes Yes1 Yes1 

(Flyer/ Fenix Flyer)

1 Builds 6977 and above incorporate new 64-bit and 32-bit USB drivers. All previous v6/v5 builds require a 32-bit computer when 

using a USB connection.

2 Because the Vista OS creates a separate “virtual” Registry for each user, WinMark Pro’s Application, Drawing, and Object defaults 

could be user-configured differently for each account. In applications where mark file consistency is important, all users should 

login under same account.

3 WinMark Pro version 2.x only.

4 NOT recommended. A 64-bit FLCC driver does not exist. Do NOT upgrade firmware in FLCC-connected heads.

5 WinMark Pro version 5.x only.



Getting Started  

Chapter 1 – Introduction

8

WinMark Pro v6.3 User Guide

WinMark Pro hardware compatibility
Use the hardware compatibility matrix shown in Table 1-2 to determine the highest WinMark Pro soft-

ware upgrade possible based on your existing computer OS and marking head/communication method.

Table 1-2  Hardware compatibility matrix

 WinMark Pro WinMark Pro WinMark Pro WinMark Pro WinMark Pro 

 v2.1.0.xxxx v3.1.0.xxxx v4.x.x.xxxx v5.x.x.xxxx > v6.1.0.6977

Operating System

Windows 95 Yes No No No No

Windows 98 Yes No Yes No No

Windows NT4 – – Yes Yes No No

Windows 2000 – – – – Yes Yes No

Windows XP – – – – Yes Yes Yes

Windows Vista – – – – – – Yes1, 2 Yes1, 2

Windows 7 – – – – – – – – Yes1

Communication Method

ISA-bus DAC Yes  No No No No 

(SH w/ DDA06 card)

ISA-bus FLCC Yes No No No No 

(DH/Fenix/Index/Tracker)

PCI-bus FLCC – – Yes Yes No3 No3 

(DH/Fenix/Index/Tracker)

Ethernet/USB – – – – – – Yes Yes 

(Flyer/Fenix Flyer)

1 Version v6.1.0.6977 incorporates new 64-bit and 32-bit USB drivers. All previous v6/v5 builds require a 32-bit computer when 

using a USB connection. Ethernet communications supported on both 32-bit and 64-bit computers.

2 Because the Vista OS creates a separate “virtual” Registry for each user, WinMark Pro’s Application, Drawing, and Object defaults 

could be user-configured differently for each account. In applications where mark file consistency is important, all users should 

login under same account.

3 NOT recommended. A 64-bit FLCC driver does not exist. Do NOT upgrade firmware in FLCC-connected heads.
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Mark file compatibility
The Mark file compatibility section includes subsections:

 Across operating systems

 Across WinMark Pro versions

Across operating systems
WinMark Pro .mkh mark files are compatible across all supported Windows operating systems.

Across WinMark Pro versions
All WinMark Pro .mkh mark files are forward compatible—files created with older versions will run in 

newer versions of software. Mark files are not backwards compatible—files created in newer versions will 

not open in previous versions of WinMark because they may not function properly. The key is the build 

number. Mark files created with software build numbers less than or equal to the build number of the cur-

rent marking software will always open and mark. 

When using WinMark Pro v6.3 to open mark files created with software versions v4 and earlier, Object de-

lays (Pline Start Delay, Pline End Delay, Interseg Delay, and Off Vector Delay) may require modification 

due to the development of an improved delay algorithm and FH Flyer’s/Fenix Flyer’s much faster optical 

scanners.

Technical support
For assistance with many common software and hardware issues, view our Laser Marking FAQ on the Win-

Mark Pro web site at http://www.winmark.com/ or on the WinMark Pro CD.

For in-depth software or marking head support, contact the Technical Support Group via email at sup-

port@winmark.com or support@synrad.com. 

By phone, contact us at 1.800.SYNRAD1 (1.800.796.7231) between the hours of 8:30 A.M. to 5:00 P.M. 

Pacific Standard Time. Outside the United States, dial +1.425.349.3500.

http://www.winmark.com/
mailto: support@winmark.com
mailto: support@winmark.com
mailto: support@synrad.com
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2 Installation
The Installation chapter includes sections:

 Inventory

 WinMark Pro installation

 WinMark File Import Filters 

 Un-installing WinMark Pro

Inventory
The WinMark Pro® software package includes the following items:

Table 2-1  Shipping box contents

Shipping Box Contents Qty

WinMark Pro Software CD .................1

Hardlock (USB or parallel port) ..........1

Figure 2-1  WinMark Pro inventory
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WinMark Pro installation
The WinMark Pro installation section includes subsections:

 WinMark Pro

 WinMark Launcher

 WinMark Digital Scope

 Samples folder

 Hardlock

 USB Device Drivers

WinMark Pro
To install WinMark Pro Laser Marking Software on your computer, perform the following steps:

Important Note: Before installing or upgrading WinMark Pro software, first remove power or unplug 

the USB cable from the Flyer/Fenix Flyer head to prevent Windows from arbitrarily 

assigning a USB driver that is not compatible with Flyer’s USB port protocols.

Note: Before upgrading to a newer version of WinMark Pro, backup your existing .mkh mark files and 

then un-install any previous versions of WinMark Pro.

1 Locate the WinMark Pro CD included with the materials shipped with your WinMark Pro purchase.

2 Back up or archive any existing WinMark Pro .mkh mark files and un-install the previous version of 

WinMark Pro.

3 Exit all programs, turn off any antivirus software, then insert the WinMark Pro CD into the CD-

ROM drive.

4 Use Windows Explorer to open the CD and then double-click the WinMark_v6.3_Software folder. 

Open the Version 6.3.x.xxxx folder to review the Release Notes and access WinMark’s setup.exe file.

5a To install WinMark Pro v6.3, and associated device drivers, on a Windows® 7 or Windows® Vista™ 

operating system, right-click the setup.exe file and choose “Run as Administrator…”.

Important Note: When upgrading from a v4 build to version v6, the WinMark Pro installer automati-

cally performs a “clean install” because v6 is uses a different subset of registry keys. 

The “Perform Clean Installation” and “Keep Current Program Settings” options are 

grayed out to indicate this installation is a “clean installation”.

Upgrading from one v6 build to another does allow the option of preserving existing 

WinMark settings in the computer’s System Registry. Choose Yes to preserve cur-

rent WinMark Pro v6 registry settings including custom date code formats, object 

defaults, shift codes, auto startup info, and saved serial numbers. Choose No to erase 

all previous WinMark v6 Registry entries and perform a clean installation. 



Getting Started  

Chapter 2 – Installation

12

WinMark Pro v6.3 User Guide

If you install WinMark Pro v6.3 and later decide to downgrade to WinMark v4, 

performing a clean installation of v4 will erase v4 and v6 Registry settings.

Note: Due to Microsoft’s implementation of registry virtualization, Windows Vista may require you to 

log on as an Administrator to perform certain functions like file importation or to save custom 

date code formats.

5b To install WinMark Pro v6.3, and associated device drivers, on a Windows® XP operating system, 

double-click the setup.exe file.

6 WinMark Pro v6.3 is a Microsoft .NET™ Framework-based application. If Microsoft .NET Frame-

work Service Pack 1, or higher, is not installed on the computer, the installer will prompt you to 

click Accept to install the .NET Framework. You must have the .NET Framework runtime and as-

sociated files installed to run WinMark Pro.

If WinMark Pro is un-installed, the .NET package is not removed, because these files may be used by 

other applications installed after the original WinMark installation.

7 When the .NET Framework installation us complete, reboot if prompted to do so. Otherwise the 

WinMark installer will continue.

8 If Microsoft C++ Redistributable x86 file runtime components are not installed on the computer, the 

installer will prompt you to click Install to install C++ Redistributable files. You must have these files 

installed to run WinMark Pro.

9 Follow instructions in the installer dialog boxes to complete the WinMark Pro installation. You must 

click “I Agree” to accept the WinMark Pro license agreement and continue the installation.

Note: Beginning with WinMark build 6.3.0.7328, the WinMark installer write Windows Registry values 

when installation is complete so there is no need to run WinMark once as an Administrator 

before other, more restricted users, log on to run WinMark.

10 After installation is complete, remember to turn on any antivirus software.

WinMark Launcher
As part of the software installation, WinMark Launcher (Launcher.exe) is placed in the Program Files/Win-

Mark folder and a shortcut is placed on the desktop. Launcher allows operators to load existing .mkh files 

for marking without opening WinMark’s Drawing Editor. Using WinMark Pro’s Startup Options… menu, 

Launcher can be configured to load a specific file and to start marking automatically when the computer is 

powered up.

WinMark Digital Scope
Digital Scope (DigScope.exe) is a stand-alone program included in the WinMark folder. Use Digital Scope 

to test individual inputs and outputs, turn the laser beam on or off, or adjust the laser’s output power level. 

This “manual” control is especially useful when testing or troubleshooting I/O connections to/from the 

Flyer/Fenix Flyer marking head.
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Samples folder
A Samples folder is also placed in the WinMark folder during installation. This folder contains a sample 

communications DLL; Microsoft® Visual Basic®, Microsoft® Visual C++®, and Microsoft® C#® (in a .NET 

framework) sample code that demonstrates the use of WinMark’s ActiveMark™ control methods; a folder 

of importable bitmap and vector graphics files; and sample mark files illustrating all of WinMark Pro’s 

available stroke fonts. 

Hardlock
A Hardlock is installed on the marking computer to prevent unauthorized use of WinMark Pro software. 

If the Hardlock is not installed, WinMark Pro is still fully functional except that (1) marking output is 

disabled and (2) with FH Flyer and Fenix Flyer, certain file operations are not allowed. In this “demo” or 

off-line mode, WinMark Pro is still able to develop, modify, and save new or existing mark files.

Important Note: When copying files from a computer or server to the Flyer/Fenix Flyer Filestore, the 

WinMark Pro Hardlock (USB or parallel port type) must be installed on the com-

puter before the file transfer can proceed.

Note: With the exception of WinMark Lite Hardlocks (usually marked as “L” or “Lite”), any WinMark 

Hardlock will function with any version of WinMark Pro.

USB port Hardlock

To install a USB port Hardlock, perform the following steps:

1 Locate the USB Hardlock included with the materials shipped with your WinMark Pro purchase.

2 Connect the USB Hardlock to any USB port on your computer.

If the Found New Hardware Wizard dialog appears when the USB Hardlock is first connected to the com-

puter’s USB port, perform the following steps:

1 When asked, “Can Windows connect to Windows Update to search for software?”, click No, not 

this time and then click Next.

2 When prompted, “What do you want the wizard to do?”, click Install the software automatically 

(Recommended) and click Next.

3 Click Finish to complete the USB driver installation for the Hardlock.

Parallel port Hardlock

To install a parallel port Hardlock, perform the following steps:

1 Locate the parallel port Hardlock included with the materials shipped with your WinMark Pro pur-

chase. 

2 Disconnect the printer cable (if installed) from the back of your computer.
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3 Connect the parallel port Hardlock to the computer’s parallel port.

4 Connect the printer cable (if installed) to the opposite side of the parallel port Hardlock.

USB Device Drivers

Hardlock driver

WinMark Pro installs a driver that allows it to communicate with the USB port or parallel port Hardlock. 

During computer boot-up, the Windows OS automatically starts the Hardlock driver as a service. Once 

started, the driver can be accessed by WinMark Pro, WinMark Launcher, or Digital Scope.

WinMark Pro versions 6.2.0.6977 and above include both 32-bit and 64-bit USB drivers for Flyer/Fenix 

Flyer heads. The Windows OS automatically selects and loads the correct driver.

Flyer/Fenix Flyer USB driver

WinMark Pro installs a specialized USB driver that communicates with FH Flyer marking heads and Fenix 

Flyer Laser Markers. During computer boot-up, the Windows OS automatically starts the USB driver as a 

service. Once started, the driver can be accessed by WinMark Pro, WinMark Launcher, or Digital Scope.

Important Note: Before installing or upgrading WinMark Pro software, first disconnect power or un-

plug the USB cable from the Flyer/Fenix Flyer head. This ensures that the Windows 

OS will load and install the latest Flyer USB driver; otherwise, Windows will arbi-

trarily assign a USB driver that is not compatible with Flyer’s USB port protocols. If 

this happens, see the Troubleshooting section of the FH Flyer Marking Head Operator’s 

Manual or the Fenix Flyer CO
2
 Laser Marker Operator’s Manual for information on 

re-installing the correct USB driver.

If the Found New Hardware Wizard dialog appears when your Flyer/Fenix Flyer head is first connected to 

the computer’s USB port, perform the following steps:

1 When asked, “Can Windows connect to Windows Update to search for software?”, click No, not 

this time and then click Next.

2 When prompted, “What do you want the wizard to do?”, click Install the software automatically 

(Recommended) and click Next.

3 Click Finish to complete the USB driver installation for the Flyer Laser Marking Device.

WinMark File Import Filters
WinMark Pro v6.3 automatically loads the File Import Filters during installation. These filters allow you to 

import a wide variety of graphic file formats. See Chapter 13, WinMark Pro menu commands, in the Com-

mands & Properties section for a complete list of supported import file types.
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Un-installing WinMark Pro
If you decide to remove WinMark Pro software from your computer, perform the following steps:

1 Click the Start button on the taskbar.

2 Select Programs and then locate the Synrad WinMark folder.

3 Click the Uninstall Synrad WinMark icon.

4 Follow the on-screen instructions.

After the un-install is complete, some WinMark components (like .MKH mark files) will remain. To com-

pletely remove all WinMark-related files, go to C:\Program Files and delete the WinMark folder.

Important Note: If you un-install build 6.3.0.7328 (or later) and then re-install WinMark version 

6.1.0.6789 or earlier, you may need to run the Sentinel HASP Run-time Setup 

program (available at http://www3.safenet-inc.com/support/hasp-srm/vendor.aspx) 

to re-initialize WinMark Pro’s USB or parallel port Hardlock functionality.

http://www3.safenet-inc.com/support/hasp-srm/vendor.aspx
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3 Starting WinMark Pro 
The Starting WinMark Pro chapter includes sections:

 Basic concepts

 Opening WinMark Pro

 Changing focusing lens size

 Setting measurement units

Basic concepts
You create a mark file by placing text, barcodes, polyline objects, or imported graphics into a drawing. Each 

individual object, including the Drawing Canvas itself, has its own unique set of properties whose default 

settings can be modified by the user. Each class of objects has specific sets of properties where each property 

defines some characteristic of that object; for example, all text objects have a Text Height property. In ad-

dition, all objects share a set of general properties that define their position and how the laser transfers that 

object’s image to the workpiece. This ability to precisely control marking output by customizing drawing 

and object properties is one of the strengths of WinMark Pro Laser Marking Software. 

In automated marking systems, ultimate control is provided by WinMark Pro’s ActiveMark™ technology. 

Adding WinMark Pro’s ActiveMark (ActiveX®) controls to your Microsoft Visual Basic, MS Visual C++, 

or MS Visual C# program offers virtually unlimited control of the marking process. See Chapter 18, Active-

Mark (ActiveX) technology, for an introduction to ActiveMark technology.

FH Flyer marking heads and Fenix Flyer Laser Markers, in conjunction with WinMark v6.3, support the 

Modbus I/P protocol for interaction with PLCs or other MODBUS network devices. See Chapter 19, Flyer 

Modbus protocol, for details.

Flyer control modes

WinMark control mode

When operating in WinMark control mode, WinMark Pro controls Flyer/Fenix Flyer heads through an 

Ethernet or USB connection. WinMark Pro asserts normal control of marking operations—initiating a 

mark manually (using the Mark button or F1 key) or automatically (by an input signal)—causes WinMark 

to stream vector data to the head where it is converted to microvector data and marked in real-time. 

Flyer/Fenix Flyer responds by sending cycle time and mark progress data back to WinMark Pro where it is 

displayed in the Launcher window.

Stand-alone mode

Stand-alone operation means that mark files are downloaded to Flyer’s Filestore before a mark session 

begins so it is not necessary to transmit vector data to Flyer/Fenix Flyer during the mark. In stand-alone 

mode, Flyer/Fenix Flyer can operate autonomously—communicating to automation equipment using 

discrete I/O signals—with no connection to the WinMark Pro computer. In situations where it is desirable 

to monitor mark session progress, an Ethernet or USB connection to WinMark Pro allows you to monitor 

cycle time and mark progress information. See the Stand-alone Operation chapter in the FH Flyer Marking 

Head Operator’s Manual or the Fenix Flyer CO
2
 Laser Marker Operator’s Manual for details.
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Stand-alone Master Control File mode

Stand-alone Master Control File operation is a specialized subset of stand-alone operation where Flyer/

Fenix Flyer loads a master file on boot-up. This Master Control File (MCF) is read once, only on boot-up, 

and configures the Flyer head to mark multiple files (previously stored in the Filestore or on a network 

share) in a user-controlled sequence determined by input bit status. If required, you can monitor cycle 

time and mark progress information from WinMark Pro through an Ethernet or USB connection. See the 

Stand-alone Operation chapter in the FH Flyer Marking Head Operator’s Manual or the Fenix Flyer CO
2
 

Laser Marker Operator’s Manual for details.

Opening WinMark Pro
Open WinMark Pro by double-clicking the Shortcut to WinMark icon ( ) on your desktop, or perform 

the following steps:

Note: When communicating with a Flyer marking head or Fenix Flyer Laser Marker, first apply power to 

the Flyer/Fenix Flyer head, wait 30 seconds for the head to boot-up, and then open WinMark Pro.

1 Click Start on the taskbar.

2 Select Programs and then locate the Synrad WinMark folder.

3 Click the Synrad WinMark icon.

If a user password is required, then the Enter Password dialog box opens. Type the correct case-sensi-

tive password and click OK. 

4 The first time WinMark Pro opens after a new installation, the Lens Selection dialog box appears and 

prompts you to enter the size of the focusing lens currently installed on the marking head. The lens 

size entered here determines overall dimensions of the Drawing Canvas. 

Double-click the desired lens or make a lens selection and then click OK.

If no marking heads are connected when WinMark Pro opens, the Device Simulation dialog box appears 

(see Figure 3-1) and prompts you to search again for a Flyer/Fenix Flyer head. If no head is available, open 

WinMark in demo mode by clicking Use Simulated Head and then selecting a specific head type.

Figure 3-1  Device Simulation dialog box
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Changing focusing lens size
If you change the focusing lens on your marking head to a lens with a different field size, you will need to 

enter the new lens size so that WinMark Pro properly scales the drawing when marking.

To change lens settings, perform the following steps:

1 From the Tools menu, select General Settings….

2 In the Applications Settings dialog box, click the “Device” tab that corresponds with the head you are 

currently using.

3  Click Lens, and then click the arrow button. 

4 In the drop-down list (Figure 3-2), select the lens matching the one currently installed on your 

marking head.

Figure 3-2  Lens Selection dialog box

Note: When using an FH Flyer marking head or Fenix Flyer Laser Marker, select a lens from the FH/

Fenix lens group only.

5 Click the Apply button. The Drawing Canvas display changes to show the new lens dimensions. 

Click OK when finished.

Tip: To use an existing mark file with a new lens having a different field size, follow Steps 1 through 5 

above and then open your existing mark file. Select all objects (from the Edit menu, choose Select 

All) and paste them into your new, blank drawing. All selected objects and their corresponding 

object properties are pasted into the new drawing. Save this new drawing with another name or ap-

pend the lens size to the existing filename.
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Setting measurement units
You can set WinMark Pro to display all measurements in inches, centimeters, or millimeters.

To change measurement units, perform the following steps:

1 From the Tools menu, select General Settings….

2 In the Applications Settings dialog box, click the Application Settings tab.

3 Click Show Units Type (Figure 3-3), and then click the arrow button. 

4 From the drop-down list, select the appropriate measurement units.

5 Click Apply to apply the change, and then click OK.

Figure 3-3  Changing “Show Units Type”

Note: When using WinMark Pro’s ActiveMark (ActiveX) controls, all units of measure are calculated 

in inches. Your application or user-interface must convert measurement values from centimeters 

or millimeters to inches as required. In your .mkh mark files, make sure that the Show Units Type 

property is set to inches—unpredictable object placement or operation may result if Show Units 

Type is set to millimeters or centimeters in ActiveX applications.
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4 WinMark Pro Drawing 
Editor

The WinMark Pro Drawing Editor chapter includes sections:

 Main Window  Slide Bar

 Toolbar  Flyer Filestore

 Mark button  Object List

 Stand-alone Toolbar  Property List

 Tool Box  Help Window

 Drawing Canvas  Status Bar

Main Window
To aid creation of mark files, the Drawing Editor’s Main Window (Figure 4-1) is divided into several distinct 

areas. Each item is described in further detail below.

Drawing Canvas Status Bar

Help

Window

Property

List

Object ListStand-alone ToolbarToolbar

Slide Bar

Mark button Flyer Filestore

Tool Box

Figure 4-1  WinMark Pro Main Window
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Toolbar
Icons on WinMark Pro’s Toolbar (Figure 4-2) provide shortcuts to common editing functions. To use a 

shortcut, select one or more objects on the Drawing Canvas and click the appropriate Toolbar button.

Figure 4-2  Toolbar icons

The following shortcuts are provided on the Toolbar:

  New – create a new, blank drawing. Drawing Canvas dimensions are based on the current Lens 

selection.

  Open – open an existing WinMark Pro (.mkh) mark file.

  Save – save the current active mark file.

  Print Drawing – print the active drawing.

  Cut – cut selected objects and place them on the Clipboard.

  Copy – copy selected objects to the Clipboard.

  Paste – paste the current Clipboard contents into the drawing.

  Zoom In – Zoom in towards the center of the mark view.

  Zoom Out – Zoom out away from the center of the mark view.

  Zoom Page – Zooms the view to fit the Drawing Canvas in the Main Window.
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  Zoom Extents – Zooms the view to encompass all mark objects in the drawing, even those objects 

placed off the Drawing Canvas.

  Align – opens a dialog box that allows you to align two or more objects horizontally and/or verti-

cally.

  Transform – opens a dialog box that allows you to precisely resize, scale, rotate, or position objects.

  Rotate +45 – rotate selected objects clockwise in 45-degree increments.

  Rotate –45 – rotate selected objects counterclockwise in 45-degree increments.

  Mirror X – mirror selected objects in the X (horizontal) axis.

  Mirror Y – mirror selected objects in the Y (vertical) axis.

  Center – center selected objects around the (0, 0) origin point.

  Toggle Property Window – toggle the Property Window display On or Off.
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Mark button
Click the Mark button (Figure 4-3) to open the Launcher window, for the specified head, in preparation 

for marking. Once the Launcher window is open, click the Start-F1 button or press F1 on the computer’s 

keyboard to initiate marking. The Launcher window remains open until closed by the user. When mark-

ing in WinMark control mode (where WinMark streams vector data to the head in real-time), the laser 

“starburst” icon is displayed in red. 

Figure 4-3  Mark button (WinMark control mode)

When operating in stand-alone mode (Standalone Marking property is Yes), the starburst icon on the 

Mark button changes to blue (Figure 4-4). During an actual stand-alone mark session, the blue starburst 

flashes on-off to provide a visual indication that marking is in progress. If the Launcher window is closed, 

you can still click the Mark button to open the window in order to inspect cycle time/mark progress data 

or halt marking.

Figure 4-4  Mark button (Stand-alone control mode)

Tip: In either WinMark control mode or stand-alone control mode, you can right-click the Mark button 

to directly access the “Device” tab.

Stand-alone Toolbar
WinMark’s Stand-alone Toolbar (Figure 4-5) appears when FH Flyer or Fenix Flyer is configured for stand-

alone operation (when the Standalone Marking property is Yes).

Figure 4-5  Stand-alone Toolbar icons
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The following operations are available from the Stand-alone Toolbar:

Warning

serious 

personal 

injury

Pressing the Mark Current File on Canvas button forces FH Flyer/Fe-

nix Flyer to begin marking immediately after the mark file is down-

loaded into RAM.

Before pressing the Mark Current File on Canvas button, ensure that 

all laser safety precautions described in laser and marking head manu-

als have been followed. To prevent injury, always ensure that all per-

sonnel in the area are wearing the appropriate protective eyewear and 

are physically clear of the mark area before starting a mark session.

  Mark Current File on Canvas – When a file is created or opened on the Drawing Canvas, click this 

button to download the file to Flyer/Fenix Flyer RAM, where the vector elements are converted 

to microvectors and immediately marked. This button is grayed out (inactive) when the Drawing 

Canvas is empty or when the file on the Drawing Canvas was uploaded from Flyer’s Filestore and has 

not been modified.

Note: The WinMark Pro Hardlock (USB or parallel port type) must be installed on the computer run-

ning WinMark before this operation can proceed.

Note: This action does not save the file to the Filestore. To save the file permanently, use the Save Cur-

rent File to Filestore button.

Tip: To view the filename of the mark file currently residing in RAM (the file that will be marked in 

stand-alone mode), hover your cursor over the Mark button or right-click the Mark button to view 

head properties on the “Device” (Flyer) tab.

  Upload Current Mark File – When a file exists in Flyer’s RAM, click this button to upload the file to 

WinMark’s Drawing Canvas. This allows you to view and/or change file properties. If the modifica-

tion is intended to be permanent, you must resave the file to the Filestore.
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  Open Network Mark File – If FH Flyer or Fenix Flyer is configured for network file sharing through 

the FH Flyer or Fenix Flyer Ethernet port, use this button to open a .mkh mark file stored on a net-

work server or drive. The Open Network Mark File button downloads the file to Flyer’s temporary 

RAM for marking. This action does not save the file to the Flyer Filestore. The Open Network Mark 

File button is grayed out (inactive) if a network share is not available.

  Save Current File to Filestore – Click the Save Current File to Filestore button to save the mark file 

displayed on the Drawing Canvas to the Flyer Filestore. You are prompted for a filename and can 

specify a path, if one or more subfolders exist in the Filestore. 

Note: The WinMark Pro Hardlock (USB or parallel port type) must be installed on the computer run-

ning WinMark before this operation can proceed.

Tool Box
Icons in the Tool Box (Figure 4-6) represent the drawing and editing tools you use in WinMark Pro. To 

select a tool, place the cursor over the tool and click the left mouse button. The cursor changes into the 

appropriate icon. When drawing with a Line, Freehand, Rectangle, or Arc Tool, press and hold the left mouse 

button while dragging to create the desired size, length, or direction and then release the mouse button.

Figure 4-6  Tool Box
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The following tools are available in the Tool Box:

  Selection Tool – selects or deselects objects on the Drawing Canvas. Click the left mouse button to 

select an object. Hold the left mouse button and drag to select multiple objects within the selection 

area, or hold the CTRL key and left click objects to add them to the selection set. Click on a blank 

section of the drawing to deselect all objects. Click the Selection Tool icon to regain the arrow cur-

sor after using a tool such as the Zoom Tool, which does not default to an arrow cursor.

  Zoom Tool – zooms in or out of the Drawing Canvas. After selecting the Zoom Tool, click the 

left mouse button to zoom in; click the right mouse button to zoom out. The “zoomed” image is 

centered on the position of the Zoom Tool when you click. To enlarge a specific area, hold the left 

mouse button and drag to define the zoom area.

Tip: The following tools add or import objects onto the Drawing Canvas using WinMark Pro’s default set 

of object properties. You can edit these properties (on the Tools/General Settings…/Object Defaults 

tab) so that any new objects created reflect the specific settings required for your application.

  Text Tool – places a text object in the drawing. Click the Text Tool on the Drawing Canvas to set an 

insertion point and open the Text Caption Editor dialog box. After entering text in the dialog box, 

you can select the text box to modify its position or change text attributes such as font type or size 

using text properties shown in the Property List. 

  Line Tool – draws straight point-to-point lines. If Snap to Grid (Tools/General Settings…/Application 

Settings tab) is Yes, the line’s origin and destination endpoints snap to the nearest grid line intersec-

tion.

  Freehand Tool – draws irregular, freehand lines. If Snap to Grid is Yes, any curves drawn are snapped 

to the nearest grid line and intersection. 

  Rectangle Tool – draws square or rectangular objects. If Snap to Grid is Yes, lines and corners are 

snapped to the nearest grid line and intersection. 
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  Arc Tool – draws elliptical and circular objects. By default, the Arc Tool draws ellipses; hold the 

SHIFT key down while dragging to constrain the object to a circle. If Snap to Grid is Yes, the arc’s 

outer diameter is snapped to the nearest grid line.

  Bar Code Tool – places a bar code object in the drawing. Click the Bar Code Tool then click in the 

drawing to set an insertion point. Barcode Number is highlighted on the Format tab. Type the 

characters you want converted into bar code form. Modify bar code attributes on the Format tab.

  2D Code Tool – places a 2D Data Matrix, QR Code, or Micro QR Code object in the drawing. 

Click the 2D Code Tool then click in the drawing to set an insertion point. 2D Barcode Text is 

highlighted on the Format tab. Type the characters you want converted into 2D code form. Modify 

2D code attributes on the Format tab.

  Spot Tool – places a spot on the drawing that represents the diameter of the laser beam. Spots are 

useful as guides for aligning the laser beam. If the correct Power and Spot Lase Duration values 

are specified in the Property List, spots can be perforate, or drill, the workpiece.

  Graphic Tool – imports graphic image files into the drawing. Click the Graphic Tool to open the 

Open dialog box. Select a file type, click on the file to import, and then click Open to place the 

graphic on the Drawing Canvas.

Drawing Canvas
The Drawing Canvas is the area where graphics and text objects are arranged to create a mark file for laser 

marking the workpiece. The white center area on the Drawing Canvas, shown in Figure 4-7, is the optimal 

mark area for the currently installed lens. The yellow shaded border indicates the maximum marking field 

of the lens. Note that objects placed in the shaded area, especially near the corners, may exhibit a slight 

degradation in mark quality. 

Overall dimensions of the Drawing Canvas correspond to the focusing lens size entered as the Lens prop-

erty (on the Tools/General Settings…/“Device” tab). These dimensions, Field Width and Field Height, as 

well as Optimal Field Width and Optimal Field Height are now read-only properties in WinMark Pro v6.3. 

Modifying these property values in older versions of WinMark will affect the overall scaling and propor-

tionality of the marked image. 

Dotted Origin Lines running across the canvas identify the horizontal and vertical centers of the work area. 

The intersection of the Origin Lines (X=0, Y=0) indicates the center of the focusing lens field and provides 

a reference for aligning the image on the parts to be marked. Figure 4-5 shows X-Y values for the four 

quadrants defined by the Origin Lines. Note that WinMark Pro’s XY coordinates are not Cartesian coordi-

nates—positive X values are located to the right of the vertical origin while positive Y values are located 

below the horizontal origin.
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Figure 4-7  Drawing Canvas

Slide Bar
Grab the Slide Bar with the Pointer and pull to the left or right to change the horizontal display area of 

various sections of the Main Window.

Flyer Filestore
The Flyer Filestore window displays the contents of FH Flyer’s/Fenix Flyer’s Filestore. When connected to 

a Flyer head, use the Flyer Filestore to view contents of the Filestore. This window allows you to create, 

move, or delete files, subfolders, and folders. See the FH Flyer Marking Head Operator’s Manual or the Fenix 

Flyer CO
2
 Laser Marker Operator’s Manual for details. 

If the Filestore view is not shown when WinMark Pro connects to your Flyer/Fenix Flyer head, click Win-

Mark’s View menu and then click Flyer Files.

Object List
Each object placed on the Drawing Canvas is added to the Object List and is associated with a set of object 

properties that define some characteristic of that object. For example, drawing a single rectangle creates an 

entry in the Object List named “Polyline1”. The Drawing Canvas itself also contains a unique set of proper-

ties and always appears first in the Object List as “Drawing”. 

Property List
The Property List consists of six tabs: Special, Automation, Marking, Format, and All. These tabs group sets of 

object properties by function. When an entity on the Object List is selected, properties that affect that en-

tity are displayed on the appropriate tabs in the Property List window. You can then view or edit individual 

Drawing or object properties.

Typical Marking

Area

Maximum Marking

Area (Shaded Yellow)

– X

– Y
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Note: The Tracking tab was removed from the Property List because tracking properties are specific to an 

individual marking head. These properties now reside on the “Device” tab. To access this tab, go 

to the Tools menu, select General Settings… , and choose the “Device” tab.

Tip: Use the Toggle Property Window Toolbar button ( ) to quickly show/hide Object List, Property List, 

and Help Window views. 

 

To reposition or resize the Object List/Property List/Help Window or the Flyer Filestore Window, click 

the window and drag it across the screen until it is at the position and pre-set size you require. 

Help Window
When a property is selected from the Property List tab, a description or explanation of that property ap-

pears in the Help Window.

Status Bar
The Status Bar displays information about tools and their current XY position as well as information about 

icons on the Toolbar.
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5 Creating a drawing
The Creating a drawing chapter includes sections:

 Opening a new drawing

 Adding text

 Adding bar codes

 Adding other objects

 Importing a graphics file

 Precision positioning

Opening a new drawing
WinMark Pro creates a new drawing with a blank Drawing Canvas each time it opens. If WinMark Pro is 

already open, select New from the File menu or click the New button ( ) on the Toolbar.

Note:  When a Flyer marking head or a Fenix Flyer Laser Marker is connected and communicating with 

WinMark Launcher or Digital Scope, close Launcher or Digital Scope before opening WinMark 

Pro.

Adding text

1 Select the Text Tool ( ) from the Tool Box.

2 Position the cursor on the Drawing Canvas and click the left mouse button to set an insertion point. 

The Text Caption Editor dialog box appears.

3 In the Text Caption Editor dialog box (Figure 5-1), enter the desired text string. If multi-line text is 

required, press ENTER to start a new line of text.

Figure 5-1  Text Caption Editor dialog box

4 Click OK. The text appears on the canvas within a bounding outline.
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5 Use the Font Type property to select either stroke, TrueType®, or OpenType® (including PostScript®) 

formatted fonts. Any TrueType, OpenType, or PostScript formatted font installed in Window’s Fonts 

folder is available for laser marking. Experiment with changing Font Type, Text Justification and 

other text properties on the Format tab.

Tip:  When a text object already exists on WinMark’s Drawing Canvas, simply double-click the text object 

to open the Text Caption Editor dialog.

Adding bar codes
The Adding bar codes section includes subsections:

 1D bar codes

 2D codes

1D bar codes

1 Select the Bar Code Tool ( ) from the Tool Box.

2 Position the cursor on the Drawing Canvas and click the left mouse button to set an insertion point.

3 In the Property List, click the Format tab and enter information in the Barcode Number field.

4 Select the appropriate Barcode Style for the code type you wish to mark. Experiment with changing 

various 1D bar code properties on the Format tab.

2D codes

1 Select the 2D Code Tool ( ) from the Tool Box.

2 Position the cursor on the Drawing Canvas and click the left mouse button to set an insertion point.

3 In the Property List, click the Format tab and then enter data in the 2D Barcode Text field or click 

the ellipsis (…) to enter data in the Text Caption Editor dialog box.

4 Select the appropriate 2D Barcode Style for the 2D code type you wish to mark. Experiment with 

changing various 2D code properties on the Format tab.
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Adding other objects
The Adding other objects section includes subsections:

 Rectangles and circles

 Spots

Rectangles and circles

1 Select the Rectangle Tool ( ) or Arc Tool ( ) from the Tool Box.

2 Click and hold the left mouse button to set a starting point, and then drag to define the object’s size 

and shape. Hold the SHIFT key down while dragging the mouse to create squares instead of rectangles 

(Rectangle Tool) or circles instead of ellipses (Arc Tool).

3 Release the mouse button when the desired size and shape is reached.

Tip: To precisely size objects, open the Object Transformations dialog, uncheck Maintain Aspect Ratio, and 

type in specific values (to four-digit accuracy!) in both New Width and New Height fields.

Spots

1 Select the Spot Tool ( ) from the Tool Box.

2 Position the cursor on the Drawing Canvas and click the left mouse button to set an insertion point.

3 In the Property List, click the Format tab and enter a Spot Lase Duration time in milliseconds (ms).

Importing a graphics file

1 Select the Graphic Tool ( ) from the Tool Box or, on the File menu, click Import. The Open dialog 

box appears, asking you to locate a file for import. For demonstration purposes, we will import a 

sample vector graphics file included with WinMark Pro.

2 In the WinMark folder, double-click the Samples folder.

3  In the Samples folder, double-click the SampleImports folder.

4 In the Files of type drop-down list, select (*.eps) Encapsulated PostScript.

5 Select the Synrad.eps file and click Open. The SYNRAD logo appears on the Drawing Canvas (Figure 

5-2).
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Figure 5-2  Sample imported graphic file

Tip: You can control scaling of imported vector files using Vector Import Scale and Vector Import 

Scale Value properties (Tools/General Settings…/Object Defaults tab). The default Vector Import 

Scale property value is “One to one”, meaning that vector drawings import at full size. Depending 

on the lens field/Drawing Canvas size, the image may extend out of the marking field. If this occurs, 

change scaling to “Best Fit”, “X axis”, or “Y axis” and re-import the image.  

 

You can also resize images manually by grabbing a corner handle of the bounding box with the Selec-

tion Tool and dragging the pointer. Remember that the marking head will not mark any portions of 

objects that extend off the Drawing Canvas.

WinMark Pro expects vector files to be drawn in inches, so a graphic file containing a 3 mm × 6 mm 

rectangle drawn in millimeters will import at a size of 3 inches by 6 inches (assuming that Vector Import 

Scale property is set to “One to one”). To scale imported vector files correctly, use the Vector Import 

Scale Value property. The default value is 1.0—a drawing scaled in inches imports as inches. For a draw-

ing scaled in millimeters, enter a value of 0.3937008 (1/25.4) so that the drawing imports in the correct 

scaling units.

Importing files with arcs
Before importing files containing arcs, ellipses, or circles, set the Import Arcs as Polylines property (on 

the Tools/General Settings…/Object Defaults tab), to obtain the best results for your intended process. The 

default value, Yes, causes WinMark to import circular arcs as polylines. This is ideal for cutting applications 

where polyline objects are best marked (or cut) using continuous motion. Set Import Arcs as Polylines 

to No to import arcs as editable WinMark Pro circle (arc) objects. This setting is useful if arcs need to be 

edited or marked in a specific clockwise or counter-clockwise direction. When using this setting, WinMark 

processes each arc in a series of connected independently defined arcs, so Pline Start Delay/Pline End 

Delay values may produce hot spots on sensitive materials if not carefully adjusted.
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Precision positioning
In many applications, very precise dimensioning and mark placement is required for objects in the draw-

ing. In these cases, use the Object Transformations dialog box to precisely resize, scale, or position selected 

objects on the Drawing Canvas.

1 Add an object to the Drawing Canvas or use the Selection Tool and click an existing object in the 

drawing.

Note: When an object is selected, a bounding outline appears around the selected object or objects.

2 From the Objects menu, click Transformations… or click the Transform button ( ) on the Toolbar.

3 In the Object Transformations dialog box (Figure 5-3), change X- and Y-position values (with four-

digit accuracy!), scale the selection by entering a percentage or resize by entering precise width and 

height dimensions.

Figure 5-3  Object Transformations dialog box

4 Click Apply to preview transformed objects without closing the Object Transformations dialog box. 

Click OK to accept the transformation and close the dialog or click Cancel to leave the object un-

changed.
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6 File development
The File development chapter includes sections:

 On-line mark file development

 Off-line mark file development

On-line mark file development
On-line mark file development is possible when communicating in real-time with an FH Flyer marking 

head or a Fenix Flyer Laser Marker (via Ethernet or USB). The only requirement is to have a Hardlock and 

the appropriate communications link installed on the development or test computer.

Off-line mark file development
When WinMark Pro is installed on a computer that has no Hardlock or Flyer head connected, WinMark 

opens in “Device Simulation” (demo) mode as shown in Figure 6-1. You are prompted to select a specific 

head, which determines the types of properties that are available. After a head type is selected, WinMark 

prompts you to select a focusing lens, which determines the field size of the Drawing Canvas. In demo 

mode, WinMark Pro allows you to create and save mark files just as you normally would.

When connected to a Flyer/Fenix Flyer head without a Hardlock installed, the computer cannot send 

microvector (mark) data to the head and you cannot save, paste, or download files to the Flyer Filestore. 

In this case (no Hardlock installed), a dialog box asks if you want to continue in demo mode with marking 

output disabled. Click Yes to launch WinMark Pro, click No to close the WinMark application.

Note: To open demo files on another computer, the build number (×.×.×.1234) of the off-line WinMark 

Pro version must be less than or equal to the build number of the WinMark version installed on 

the marking computer. 

Figure 6-1  Device Simulation dialog box
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Tip: When your development computer is used primarily for creating off-line mark files, use WinMark 

Pro’s command line switch to open WinMark in demo mode with a simulated Flyer head and lens 

selection of your choice. This feature eliminates the need to make head/lens selections in multiple 

dialog boxes when WinMark opens. 

 

To create the demo mode command line, right-click the WinMark Pro desktop icon and choose 

Properties. On the Shortcut tab, enter the command line string in the Target: box. Type this com-

mand line exactly as shown below including quote marks and spaces:  

 

“C:\Program Files\WinMark\WinMark.exe” /demo /Flyer /“200 mm” 

 

The lens selection option must be one of the following (with quotes and spaces): “80 mm”, “125 

mm”, “125 mm HP”, “200 mm”, or “370 mm”.  

 

Click Apply and then click OK. Now, double-clicking the WinMark Pro desktop icon will immedi-

ately launch WinMark in Flyer simulation mode with a Drawing Canvas sized to the specified focus-

ing lens. To reset the WinMark icon path, replace the command line with the string: “C:\Program 

Files\WinMark\WinMark.exe” (including the quote marks). 

 

Note that only the Flyer head is recognized for demo mode. If the head or lens type is not speci-

fied or is entered incorrectly, WinMark will open in standard demo mode with all dialog box entry 

required.  

 

Alternately, you can leave the WinMark icon in its default configuration for standard operation and 

use the Start/Run… dialog to launch WinMark in command line demo mode. To do this, click the 

Start button and choose Run… . In the Run dialog box, type the command line in the Open: box.
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7 WinMark Launcher
The WinMark Launcher chapter includes sections:

 Introduction

 Launcher display

 Opening a drawing

 Marking parts

 Modifying a drawing

 Launcher in stand-alone mode

Introduction
WinMark Launcher allows you to open and mark existing mark files outside of the Drawing Editor environ-

ment. This eliminates the possibility of inadvertent changes to archival mark files and, as shown in Figure 

7-1, provides a simplified graphical interface for operators. 

Mark Preview Window

Mark

Log

Window

Progress Window

Figure 7-1  Launcher window

Note:  When a Flyer/Fenix Flyer head is connected and communicating with WinMark Pro or Digital 

Scope, close WinMark or Digital Scope before opening WinMark Launcher.

Note: After installing, or upgrading to a newer version, open WinMark Pro first, before opening 

Launcher. This allows WinMark Pro to initialize lens selection and Device ID data in the com-

puter’s System Registry before a mark session begins.
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Start WinMark Launcher by double-clicking the Launcher icon ( ) on your desktop or perform the fol-

lowing steps:

1 Click Start on the taskbar.

2 Select Programs and then locate the Synrad WinMark folder.

3 Click the Synrad WinMark Launcher icon.

4 Launcher opens and automatically loads the last file marked.

Launcher display
The Launcher display section includes subsections:

  Progress window

  Mark Preview window

  Mark Log window

Launcher’s graphical display comprises several distinct windows. Each is described below.

Progress window
The Progress window provides status information about the ongoing mark session. Piece Count provides a 

running total of pieces marked in the current mark session in cases where Mark Count is zero or greater 

than one. Total Time displays the total elapsed time in this mark session. Piece % is a progress bar illustrat-

ing percent of marking complete on the current piece (part to be marked). Object % illustrates the percent 

of marking complete on the current object in the mark file. 

Mark Preview window
Mark Preview displays the actual mark being made in real-time. During marking, a red outline box sur-

rounds the object currently being laser marked. 

Fast Preview check box

Checking Fast Preview grays out individual elements in the mark file, showing only mark location. In time-

critical applications, this option saves the small amount of time involved in redrawing the screen. 

Zoom to Fit check box

Selecting the Zoom to Fit check box zooms the Launcher view to the extents of the mark. This view is use-

ful when an operator must verify a manual text input, serial port read, or serialization event while marking 

very small objects.
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Mark Log window
The Mark Log window records and displays every step or event in the mark sequence as it occurs in real-

time during the marking process.

Write to Log File check box

Checking Write to Log File creates a Windows Log File (.log) and writes each log event displayed in the 

Mark Log window to the marking computer’s hard drive or specified network location. Selecting the Write 

to Log File check box opens the Save As dialog box which prompts you for a filename and storage location. 

Using the Write to Log File feature will affect cycle times of the mark because each event is written to the 

hard drive or network location in real-time.

Data in the saved mark log is formatted as follows:

 DD MM HH:MM:SS “mark event description”; 

where DD is the two-digit day, MM is the two-digit month, and HH:MM:SS are Hours:Minutes:Seconds 

as read from the system clock. “Mark event description” is a copy of the same data displayed in the Mark 

Log window.

Opening a drawing
To open an existing mark file, perform the following steps:

1 Click Open… under the File menu.

2 In the Open dialog box, locate and select the file you wish to mark.

3 Double-click the file or click OK to load the selected mark file.

Marking parts
Once a mark file is loaded into WinMark Launcher, begin marking by pressing F1 or click the Start-F1 

button. By changing Startup Option settings in WinMark Pro, Launcher can be configured to (1) load a 

specific file when opened, (2) automatically launch when the computer boots-up, and (3) automatically 

start marking when Launcher opens. 

Danger

serious 

personal 

injury

When the Start marking immediately after Launcher loads check box in 

the Startup Options dialog is selected, the laser will begin firing imme-

diately after WinMark Launcher loads on start-up, provided that all 

input states set in the mark file’s Event Automation, if any, are valid. 

Because exposure to invisible infrared laser radiation in the 10.6 µm 

CO
2
 wavelength band can inflict severe corneal injuries and seriously 

burn human tissue, appropriate safeguards must be in place to prevent 

serious personal injury or equipment damage.
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Tip: When running time-sensitive applications, minimizing the Launcher window helps to shorten cycle 

times by reducing the time that the Windows Operating System spends on refreshing the display.

Modifying a drawing
To edit the currently open mark file, perform the following steps:

1 Click Modify Drawing… under the File menu.

2 If a user password is required, then the Enter Password dialog box opens. Type the correct case-sensi-

tive password and click OK.

3 Edit the mark file as required in WinMark’s Drawing Editor.

4 When editing is complete, save the file and close WinMark Pro before marking from Launcher.

Launcher in stand-alone mode
When Launcher is used with a Flyer or Fenix Flyer head in stand-alone mode, the Launcher display ap-

pears as shown in Figure 7-2.

Figure 7-2  Launcher window in stand-alone mode

In this mode, Launcher is only receiving mark status information and starting/halting mark sessions. If a 

Startup Drawing is not specified, you can load any file in the head’s Filestore. To do this, go to the File 

menu and choose Open Drawing on Head.

Note that the Progress window is grayed out since WinMark is not sending mark data to the head. In 

stand-alone mode, mark data is generated internally in the Flyer head. 
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8 WinMark Digital Scope
Digital Scope is a stand-alone program designed to test or verify the functionality of WinMark Pro’s laser 

control and I/O capability.

Note:  When a Flyer marking head or a Fenix Flyer Laser Marker is connected and communicating with 

WinMark Pro or WinMark Launcher, close WinMark or Launcher before opening Digital Scope.

Start Digital Scope by double-clicking the Digital Scope icon ( ) on your desktop or perform the follow-

ing steps:

Note: After installing, or upgrading to a newer version, open WinMark Pro first, before opening Digital 

Scope. This allows WinMark Pro to initialize lens selection and Device ID data in the computer’s 

System Registry before a mark session begins.

1 Click Start on the taskbar.

2 Select Programs and then locate the Synrad WinMark folder.

3 Click the Synrad Digital Scope icon.

4 Digital Scope opens as shown in Figure 8-1.

Input Bit Status

Output Bit

Status

Lase On/Off
Duty Cycle Slider

Laser Timeout:

Figure 8-1  Digital Scope display

A description of each Digital Scope control follows:

Input Bit Status

Input bit “buttons” pop-in to indicate that an input connected to the Flyer head is active. See Chapter 11, 

Automation basics, for a list of valid FH Flyer/Fenix Flyer input bits.
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Duty Cycle Slider

Click and drag the Duty Cycle Slider to set laser power by varying the laser’s pulse width modulation 

(PWM) between 0–99% duty cycle. Power output is displayed in the Laser Duty Cycle display box.

Output Bit Status

Click an output bit “button” to activate an output connected to the Flyer head. See Chapter 11, Automa-

tion basics, for a list of valid FH Flyer/Fenix Flyer output bits.

Lase On/Off

Click the Toggle Lase button to turn the laser On. The laser will fire at the specified Laser Duty Cycle. Click 

again to toggle the laser Off.

Laser Timeout:

If you need to fire the laser (by clicking the Toggle Lase button), but need to halt firing automatically, enter 

a value in the Laser Timeout: field. You can enter integer values between 1 and 3600 seconds. After click-

ing Toggle Lase, a counter appears to count down the seconds remaining until lasing is halted.

Note:  Digital Scope automatically sends a command to center FH Flyer or Fenix Flyer optical scanners 

when the Toggle Lase button is pressed.

Important Note: If the Fast Acting Safety Interlock (FASI) feature is enabled on the FH Flyer/Fenix 

Flyer head, then input IN3 must be active (a high level voltage must applied) before 

the laser will fire.
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Basic Operation
Use information in this section to begin laser marking.

This section contains the following chapters:

■ Chapter 9 – Marking basics 

explains how font selections and graphics file formats affect mark speed and quality.

■ Chapter 10 – Marking parts 

explains how to mark single pieces or parts in batches.

■ Chapter 11 – Automation basics 

describes the basic procedures in connecting to automated parts handling equip-

ment. 

■ Chapter 12 – ActiveMark automation 

describes the basics of WinMark Pro’s ActiveMark (ActiveX) technology when 

used in a Microsoft Visual C++ or MS Visual Basic programming environment.

WinMark Pro v6.3 User Guide

Basic Operation 
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9 Marking basics
The Marking basics chapter includes sections:

 Types of marks

 Key marking parameters

 Optimization

When creating a mark file, your choice of font for text and your choice of file format for imported graphic 

images are the primary factors that influence the overall speed and quality of the mark. The following sec-

tions lead you through the creation of text and graphic files to illustrate how your choices affect marking. 

The Optimization section provides examples of how to optimize a file for speed or for mark quality.

Danger

serious 

personal 

injury

Before performing the marking tutorials in this chapter, ensure that 

all personnel in the area are wearing protective eyewear. Read and 

follow all laser safety and fume extraction precautions described in 

your laser and marking head Operator’s Manuals.

CO
2
 lasers emit invisible infrared laser radiation at the 10.6 µm CO

2
 

wavelength band. Since direct or diffuse laser radiation can inflict 

severe corneal injuries, always wear eye protection when in the same 

area as an exposed laser beam. Do not allow the beam to contact a 

person. CO
2
 lasers emit an invisible beam that is capable of seriously 

burning human tissue.

Always be aware of the beam’s path and always use a beam block 

while testing.

Warning

serious 

personal 

injury

In order to halt marking before a mark has been completed, you must 

press the ESC key on the keyboard. In some instances, you must press 

and hold the ESC key until marking is halted. Because WinMark Pro 

is busy sending microvector and control data to the marking head 

in real-time, keyboard status is checked only intermittently during a 

mark. 

To halt lasing immediately you can toggle the laser’s Keyswitch to Off, 

open the laser’s Remote Reset input, or open the FASI input (if the 

Fast Acting Safety Interlock is enabled). Although lasing is disabled 

immediately, WinMark Pro is unaware of laser status and will con-

tinue the mark session until it is complete or halted.
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Important Note: Power settings provided in this tutorial are based on the use of a 25 W laser marking 

an anodized aluminum substrate through a 125 mm focusing lens. When working 

through the examples below, be sure to adjust power levels accordingly for higher or 

lower power lasers, for the spot size (power density) of your lens, and for the specific 

substrate you are marking.

Types of marks
The Types of marks section includes subsections:

 Text

 Graphics

 Bar codes

 2D codes

There are two distinct methods used to mark objects. The first method, vector marking, is made by moving 

the beam from one X-Y point to another X-Y point (a vector) along a straight or curved path. This type of 

mark is very fast, limited only by the speed of the optical scanners moving the beam-steering mirrors. The 

second method of marking, raster marking, is accomplished by switching the beam on and off as it scans 

across the image area. At the end of a scan line, the beam is switched off, returns and moves down one 

step, and then is switched on and makes another pass. This raster scanning continues through the length 

of the image. If Bi-Directional Raster is enabled, marking occurs as the beam moves both directions across 

the image. In addition, you can specify either a horizontal or a vertical orientation for raster scanning. 

Raster marking is slower than vector marking, but raster scanning can create filled objects and text or even 

reproduce photographic images. Figure 9-1 illustrates both types of marking.

Vector outline Raster fill

Figure 9-1  Vector versus raster marking

Text
When creating text, there are two basic categories of fonts to choose from: (1) stroke fonts or (2) vector 

outline fonts. Stroke fonts are the type of fonts typically used in CAD programs because they are drawn 

(or marked) very quickly using point-to-point vectors. Twelve different stroke font styles are built into 

WinMark Pro® to improve high-speed coding of text, date codes, and serial numbers.
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Vector outline fonts include typefaces designed in TrueType®, OpenType®, and PostScript® formats. When 

True Type is the chosen Font Type, any TrueType (.ttf) formatted font installed in Windows’s Fonts folder 

is available for use by WinMark Pro. When the Font Type is set to Open Type, any OpenType (.ttf or 

.otf) formatted font installed in the Windows’ Fonts folder or any PostScript (.pfm) formatted font with a 

shortcut residing in the Windows’ Fonts folder is available to WinMark Pro. If the Text Filled property is 

set to No, the font is marked as a vector outline; if Text Filled is Yes, the font is filled by raster scanning the 

beam, effectively “coloring in” the outline to produce a solid fill. Figure 9-2 illustrates examples of stroke, 

TrueType, and filled TrueType formatted fonts.

Figure 9-2  Font types

The tutorial section below illustrates the relative marking speeds of stroke and TrueType formatted fonts.

Mark a stroke font:

1 Select the Text Tool from the Tool Box, position it on the Drawing Canvas, and click the left mouse 

button to set an insertion point. The Text Caption Editor dialog box appears.

2 In the Text Caption Editor dialog box, type: “ABCDEFG123”.

3 Click OK. ABCDEFG123 appears on the canvas within a bounding outline.

4 On the Format tab, set Font Type to Stroke and then in Stroke Font, select a stroke font to mark.

5 Choose a Text Height that will allow the text to easily fit on the Drawing Canvas. 

6 Click the Marking tab. Set Velocity to 60 in./sec. and set Power (duty cycle percentage) to 60%.

7 Position a sheet of anodized aluminum under the lens, ensure all personnel are wearing safety glasses, 

and then click the Mark button.

8 When the Synrad WinMark dialog box appears, click Start-F1.

9 Observe how the mark is produced. After completion of the mark, note the cycle time.

10 Save the file as Stroke demo.mkh.
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Mark an unfilled TrueType font:

1 Open a new drawing.

2 Select the Text Tool, position it on the Drawing Canvas, and click the left mouse button to set an 

insertion point.

3 In the Text Caption Editor, type: “ABCDEFG123”.

4 On the Format tab, set Font Type to TrueType and then in TrueType Font, select a font to mark. Set 

Text Filled to No and set Text Curve Detail to 500 (WinMark’s default value).

5 Set Text Height to the same value used in the stroke font example. 

6 Click the Marking tab. Set Velocity to 60 in./sec. and Power to 60%.

7 Position a sheet of anodized aluminum under the lens, ensure all personnel are wearing safety glasses, 

and then click the Mark button.

8 When the Synrad WinMark dialog box appears, click Start-F1.

9 Observe how the mark is produced. After completion of the mark, note the cycle time.

10 Save the file as Unfilled TrueType demo.mkh.

Mark a filled TrueType font:

1 Open a new drawing.

2 Select the Text Tool and click to set an insertion point. 

3 In the Text Caption Editor, type: “ABCDEFG123”.

4 On the Format tab, set Font Type to TrueType and then in TrueType Font select the same font used 

in the unfilled font example above.

5 Set Text Filled to Yes, Filled Font Resolution to 500, Text Curve Detail to 500, and set Text Height 

to the same value used in the stroke and unfilled font examples. 

6 Click the Marking tab. Set Velocity to 100 in./sec. and Power to 60%.

7 Position a sheet of anodized aluminum under the lens, then mark the text.

8 Again, observe how the marking head is producing the mark and note the cycle time.

9 Save the file as Filled TrueType demo.mkh.

The three text examples just demonstrated show the importance of choosing fonts (and marking param-

eters) to match the marking application. In processes where speed is an issue such as in marking part 

numbers, date codes, or other identifying information at high throughput speeds, stroke fonts can mark 11/
2
 

times faster than unfilled vector outline fonts and ten times faster than filled vector outline fonts. When 

filled vector outline fonts are required to convey a quality “look” or match a corporate logotype, longer 

cycle times are inevitable.
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Graphics
When creating graphics, there are two basic types of file formats: (1) bitmap and (2) vector graphics. 

Bitmap (raster files) such as TIFF, BMP, and JPEG formats are the types of files created by pixel-based 

paint programs. Bitmap file elements are marked using a raster scanning technique. CAD and illustration 

programs generate vector files such as EPS and DXF formats that are marked quickly using mathematical-

based vector movements. A third graphics format, metafile, can contain both bitmap and vector elements. 

Common metafile formats include WMF and CGM.

Mark a bitmap graphics file:

1 Open a new drawing and then click the File Import Tool. The Open dialog box appears, asking you to 

locate a file for import. For this example, we will import a sample file included with WinMark Pro.

2 In the WinMark folder, double-click the Samples folder.

3  In the Samples folder, double-click the SampleImports folder.

4 In the Files of type drop-down list, select (*.tif) Tagged Image File Format.

5 Select the Family.tif file and click Open. The bitmap file is shown in Figure 9-3.

Figure 9-3  Family.tif

6 Click on the family image to select it, then use the Object Transformations dialog box to scale the im-

age to fit the Drawing Canvas.

7 Click the Marking tab. Set Velocity to 175 in./sec., Power to 60%, and Resolution to 600.

8 Position a sheet of anodized aluminum under the lens, ensure all personnel are wearing safety glasses, 

and then click the Mark button.

9 When the Synrad WinMark dialog box appears, click Start-F1.

10 Observe how the mark is produced. After completion of the mark, note the cycle time.

11 Save the file as Bitmap demo.mkh.
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Tip: For best results before importing bitmap images, re-size the image to its intended mark size and 

check image resolution in a photo-editing or paint program. Then, in WinMark Pro, go to the Tools/

General Settings…/Object Defaults tab and set Resolution to the resolution value of the image you 

plan to import. This step forces WinMark to import the image at full size. 

 

If aliasing (Moire effect or stair-stepped edges) is seen in the mark, set the Resolution property (on 

the Marking tab) to a multiple of the native image resolution.

Mark a vector graphics file:

1 Open a new drawing and then click the File Import Tool. The Open dialog box appears, asking you to 

locate a file for import. For this example, we will import a sample file included with WinMark Pro.

2 In the WinMark folder, double-click the Samples folder.

3  In the Samples folder, double-click the SampleImports folder.

4 In the Files of type drop-down list, select (*.dxf) AutoCAD Drawing Interchange.

5 Select the Chairbin.dxf file and click Open. Chairbin.dxf (Figure 9-4) is a vector graphic illustrating 

an office chair as a wire-frame line drawing.

Figure 9-4  Chairbin.dxf

6 Click on the Chairbin image to select it.

7 Click the Marking tab. Set Velocity to 60 in./sec. and Power (duty cycle percentage) to 60%.

8 Position a sheet of anodized aluminum under the lens, then mark the drawing.

9 Observe how the mark is produced. After completion of the mark, note the cycle time.

10 Save the file as Vector demo.mkh.
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Vector graphics are used for marking objects at high throughput speeds when cycle times are important. 

Bitmap graphics are appropriate when a filled logo or photographic image is being marked and quality is 

the most important marking factor. You can import both vector and bitmap files into the same drawing to 

shorten cycle times and obtain the best quality mark possible. 

Bar codes
WinMark Pro’s bar code library contains 23 different bar codes or bar code subsets for product coding. 

See Chapter 16, Object properties, in the Commands & Properties section for a list of available bar code 

formats.

1 Open a new drawing.

2 Select the Bar Code Tool and click to set an insertion point. 

3 On the Format tab, in the Barcode Number field, type: “123456”.

4 On the Format tab, set Barcode Style to Code 3 of 9, Barcode Resolution to 300, and Barcode 

Show Text to No.

Note: Setting the Barcode Resolution value too high may introduce reader errors if line width begins 

to encroach on the white space between bars.

5 If coding a dark material that will mark lighter, set Barcode Inverted to Yes. 

Tip: Most bar codes are marked, or printed, as dark lines on a light background because the bar code 

must create a sharp color contrast against the material’s background in order for the bar code to 

be readable. When creating a contrasting mark on dark material, set Barcode Inverted to Yes. 

This causes WinMark to mark the spaces between bars (instead of the bars) and add a “quiet zone” 

around the code so that a contrasting space between dark bars is created.

6 Click the Marking tab and set Velocity to 80 in./sec. at a Power level of 60%.

7 Position a sheet of anodized aluminum under the lens, then mark the bar code.

Tip: When marking heat-sensitive materials (like plastics), start with Barcode Resolution settings in 

the range of 200–250. Bar codes on materials such as mild or stainless steels mark best at resolu-

tions around 600–650. To decrease mark (cycle) time, Barcode Resolution should not be set much 

higher than the lowest resolution that provides consistently readable results. 
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2D codes
When a 2D code is needed for your coding operation, choose from Data Matrix, QR Code, or Micro QR 

Code.

1 Open a new drawing.

2 Select the 2D Code Tool and click to set an insertion point. 

3 On the Format tab, in the 2D Barcode Text field, click the ellipsis (…). The Text Caption Editor 

dialog box appears.

4 In the Text Caption Editor dialog box, type: “ABCDEFG123” and click OK.

5 In the 2D Barcode Style field, select Data Matrix, QR Code, or Micro QR Code.

6 Set Barcode Inverted to Yes if marking a dark material.

7 Click the Marking tab and set Velocity to 80 in./sec., Power to 60%, and Resolution to 300.

Note: Setting the Resolution value too high may lead to cell growth errors if filled cells begin to en-

croach on the space allocated for unfilled cells.

8 Position a sheet of anodized aluminum under the lens, then mark the code.

Tip: When marking heat-sensitive materials, set the 2D code’s, 2D Barcode Circle Radius property to a 

value in the range of 80–90%. This reduces the raster or vector cell size by the specified percentage 

to eliminate print growth reading errors.

Key marking parameters
The Key marking parameters section includes subsections:

 Velocity

 Power

 Resolution

 Delays

Once a decision is made to use either a stroke or vector outline font or to use either a bitmap or vector 

graphic, the three most important object properties are: (1) Velocity, (2) Power, and (3) Resolution. 

These three parameters plus object delays on the Marking tab are the primary factors that determine the 

speed and quality of the mark.
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Velocity
Marking velocity (X-Y optical scanner speed) determines how fast each microvector is marked. Setting 

optical scanner velocity too high affects mark quality as delay settings become much more critical when 

velocity increases. Velocity also affects power since a faster moving beam has less heat effect on the mate-

rial. The Velocity property is adjustable in a range of 0.01 to 400 inches/sec. (0.25–10,160 mm/sec.).

Power
Laser output power must be optimized for the material being processed and for the type of mark required. 

Power (duty cycle percentage) is adjustable between 0% and 100% of the laser’s actual power output. 

Typically, a duty cycle of 70% to 80% equals the laser’s specified output power in watts. Applying too much 

power may engrave too deeply or char the material unacceptably. In some cases, making multiple Mark 

Passes at a lower power level provides better results. 

Tip: When marking certain plastics, such as PEEK, PVC, brown Bakelite and dark phenolic, contrasting 

marks are often achieved using very low power settings (1 to 2 watts).

Resolution
In WinMark Pro v6, the Resolution property is available for bitmap objects like imported bitmap graph-

ics, 2D codes, and filled polyline objects. All other objects are marked at a default step resolution of 200 

microvectors per inch. When marking filled vector outline text, use the Filled Font Resolution property 

(on the Format tab) and use Barcode Resolution (also on the Format tab) for 1D barcode objects.

Practical resolution values range from 50 for spot-style 2D codes to 200 for linear 1D bar codes up to 

1000 for high-resolution graphics or filled text. Apparent resolution is also a function of the spot size of 

the focusing lens. The nominal spot size for an 80 mm lens is 116 microns (0.005") while a 370 mm lens 

produces a 540-micron (0.021") spot. This large difference in spot size must be taken into account when 

determining the smallest character height or 2D cell that can be marked. To obtain the best legibility 

when marking text objects, character (Text Height) values should be a minimum of seven to ten times the 

focused spot size. 

Delays
It is sometimes possible for the marking head’s optical scanner hardware to lag slightly behind software 

commands while marking. To compensate, WinMark Pro provides object-specific delays. Object delays 

for specific objects are controlled by selecting related objects in an open drawing file and then setting 

appropriate delays on the Marking tab. See Chapter 16, Object properties, for further information on delay 

properties.



Basic Operation  

Chapter 9 – Marking basics

54

WinMark Pro v6.3 User Guide

Optimization
The Optimization section includes subsections:

 Vector objects

 Raster objects

Mark file optimization involves determining acceptable trade-offs in WinMark Pro’s Velocity, Power, and 

Resolution settings for a given drawing. These settings along with object delays, which affect cycle time 

and mark quality, are best determined by careful experimentation.

Vector objects
When marking vector-type objects such as stroke fonts or imported vector graphics, the fastest mark pos-

sible is sometimes not legible enough to be practical. An acceptable high-speed mark is determined by 

each individual application and customer. The example below suggests one approach you might take to 

optimize vector marks for speed:

1 Open the Stroke demo.mkh file created earlier. 

2 Click on the text object to select it.

3 Click the Marking tab and increase Velocity from 60 to 120 in./sec., increase Off Vector Velocity 

from 200 to 400 in./sec. and increase Power from 60% to 90%.

4 Position a sheet of anodized aluminum under the lens, ensure personnel are wearing safety glasses, 

and then fire a mark.

5 Compare mark quality and cycle time to the initial stroke font mark.

If mark quality is unacceptable after increasing Velocity, try modifying object delays first because delays 

have less effect on marking speed. For example, if the first vector is too short, change the Pline Start Delay 

property from 0 µsec to a negative value like –500 µsec. If mark quality still suffers after optimizing object 

delays, try decreasing both Velocity and Resolution. Remember to change only one parameter at a time 

while comparing results. 

Open the Vector demo.mkh graphic file, make similar changes and compare those results to the original 

marks.

Raster objects
When marking raster-type objects such as filled TrueType formatted fonts or imported bitmap graphics, the 

level of quality acceptable for a mark is again a subjective issue. The highest quality mark possible is often 

not fast enough from a production standpoint. As with speed, creating a quality raster mark involves trade-

offs in Velocity, Power, Resolution, and delay settings and again is best determined by experimentation. 

The following example suggests one approach you might take to optimize raster marks for best quality:

1 Open the Filled TrueType demo.mkh file created earlier. 
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2 Select the text object.

3 Click the Marking tab and decrease Power to 35%. Keep Velocity set to 100 in./second.

4 Click the Format tab and increase both Filled Font Resolution and Text Curve Detail to 1000.

5 Position a sheet of anodized aluminum under the lens, then make the mark.

6 Compare mark quality and cycle time to the initial filled TrueType text mark.

If mark time is too slow, try reducing Filled Font Resolution and Text Curve Detail together or try increas-

ing Velocity and/or reducing Power. Experiment with changing only one parameter at a time while com-

paring results. Open the Bitmap demo.mkh file and make similar changes to Velocity, Power, and Resolu-

tion. Compare those mark results to the original bitmap marks.
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10 Marking parts
The Marking parts chapter includes sections:

 The mark session

 Piece marking

 Batch marking

The mark session
Throughout this manual, the term “mark session” is used. In WinMark terms, a mark session begins after 

pressing F1 on the keyboard, or clicking Start-F1 in the Synrad WinMark dialog box or Launcher window 

and ends when the Mark Count property is satisfied (the number of parts marked equals the specified Mark 

Count value). In automated systems when Mark Count is set to zero (0) and marking proceeds continu-

ously as directed by “start mark” signal inputs, the mark session does not end. When using ActiveMark™ 

control, Mark Count is typically set to 1 so that the mark session begins when WinMark’s MarkDrawing 

method is called and ends after the mark is complete so that control is returned to the calling program. 

You can halt a mark session at any time by pressing ESC on the keyboard, however this actually terminates 

or aborts the mark session; it does not end the session. This distinction is important to understand because 

On After Mark Session events defined on the Automation tab occur only when a mark session ends, not 

when the session is aborted. If your automated system requires a specific I/O state to occur when a mark 

session is aborted, you can define an output state using the On Abort Session property. Figure 10-1 illus-

trates the mark session flowchart.

Figure 10-1  Mark session flowchart
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Piece marking
In manufacturing processes that produce parts one at a time, piece marking is the most appropriate method 

of marking. The following procedure steps you through a sample parts marking session. This procedure may 

not meet your particular needs, but you can modify it as required by specifying different parameters.

To setup a single-piece marking operation, perform the following steps:

1 Use the Drawing Editor to create a file with text, artwork, or imported graphic images.

2 With the appropriate object or objects selected, set marking Velocity, Power, and Resolution (where 

applicable) on the Marking tab.

3 Position the cursor over a blank area of the Drawing Canvas and click the left mouse button or select 

Drawing in the Object List to deselect all objects.

4 In the Property List, click the Marking tab, and then click Mark Count. Click the arrow and set the 

Mark Count property to 1.

Note: In automated piece marking applications, set Mark Count to zero (0) and set input/output auto-

mation as described in Chapter 11, Automation basics, or in our Laser Marking FAQ (available on 

the WinMark web site).

Danger

serious 

personal 

injury

Before performing the marking tutorials in this chapter, ensure that 

all personnel in the area are wearing protective eyewear. Read and 

follow all laser safety and fume extraction precautions described in 

your laser and marking head Operator’s Manuals.

CO
2
 lasers emit invisible infrared laser radiation at the 10.6 µm CO

2
 

wavelength band. Since direct or diffuse laser radiation can inflict 

severe corneal injuries, always wear eye protection when in the same 

area as an exposed laser beam. Do not allow the beam to contact a 

person. CO
2
 lasers emit an invisible beam that is capable of seriously 

burning human tissue.

Always be aware of the beam’s path and always use a beam block 

while testing.

5 Place the part to be marked under the focusing lens at the point of focus.

6 On the Toolbar, click the Mark button (Figure 10-2).

Figure 10-2  Mark button on the Toolbar
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7 When the Synrad WinMark dialog box appears (Figure 10-3), click Start-F1.

Figure 10-3  Synrad WinMark dialog box

Batch marking
If your manufacturing process produces parts in batches, trays of parts for example, batch marking is the 

most appropriate method for marking them. The following procedure steps you through a sample batch 

marking session. You will create an image to be marked then use WinMark’s Array properties to duplicate 

the object and create an array that matches the group of parts to be marked. This procedure may not meet 

your particular needs, but you can modify it as required by specifying different parameters.

To setup a batch marking operation, perform the following steps:

Note: Although the entire batch or tray of parts does not need to fit within the mark field, the desired 

mark area on all parts within the batch must fit within the marking field of the selected focusing 

lens.

1 Use the Drawing Editor to create a file with text, artwork, or imported graphic images.

2 With the appropriate object or objects selected, set marking Velocity, Power, and Resolution (where 

applicable) on the Marking tab.

3 In the Property List, click the Format tab, and then click Array Columns (Figure 10-4).

4 Click the arrow to increase the number of columns.

The number of columns created should match the number of columns of parts in the batch.
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Figure 10-4  Setting number of Array Columns

5 In the Property List, click Array Rows (Figure 10-5), and then click the arrow to increase the num-

ber of rows.

The number of rows created should match the number of rows of parts in the batch.

Figure 10-5  Setting number of Array Rows

6 From the Objects menu, click Center on Field to center the array in the marking field.

7 On the Format tab, adjust Column Spacing, Row Spacing, and Array Angle as required to position 

the arrayed image over the batch of parts.

8 Click a blank area of the Drawing Canvas or select Drawing in the Object List to deselect all objects.

9 In the Property List, click the Marking tab, and then click Mark Count. Click the arrow and set the 

Mark Count property to 1.

Note: In automated batch marking applications, set Mark Count to zero (0) and set input/output auto-

mation as described in Chapter 11, Automation basics, or our Laser Marking FAQ.
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10 Place the array of parts to be marked under the focusing lens at the point of focus.

11 On the Toolbar, click the Mark button (Figure 10-6).

Danger

serious 

personal 

injury

Before performing the marking tutorials in this chapter, ensure that 

all personnel in the area are wearing protective eyewear. Read and 

follow all laser safety and fume extraction precautions described in 

your laser and marking head Operator’s Manuals.

CO
2
 lasers emit invisible infrared laser radiation at the 10.6 µm CO

2
 

wavelength band. Since direct or diffuse laser radiation can inflict 

severe corneal injuries, always wear eye protection when in the same 

area as an exposed laser beam. Do not allow the beam to contact a 

person. CO
2
 lasers emit an invisible beam that is capable of seriously 

burning human tissue.

Always be aware of the beam’s path and always use a beam block 

while testing.

Figure 10-6  Mark button on Toolbar

12 When the Synrad WinMark dialog box appears (Figure 10-7), click Start-F1.

Figure 10-7  Synrad WinMark dialog box
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11 Automation basics
The Automation basics chapter includes sections:

 System configuration

 Input/output configuration

 Fast Acting Safety Interlock (FASI) feature

 Developing a basic event sequence

 Automated serialization

System configuration
The System configuration section includes subsections:

 Multiple marking heads

 Additional peripheral cards

Multiple marking heads
WinMark Pro v6 can control multiple FH Flyer marking heads or Fenix Flyer Laser Markers through mul-

tiple instances of WinMark Pro. Each instance of WinMark communicates to the assigned head through 

its individual Ethernet or USB interface. Actual throughput speed may be slowed for all heads in this type 

of configuration because each additional instance of WinMark Pro is competing for system resources.

Additional peripheral cards
Microsoft® Windows® PCI device management means there are no restrictions to adding peripheral cards 

for networking, motion control, etc. to the marking computer. It should be noted however, that running 

background applications while marking may reduce overall cycle times since WinMark Pro is competing 

with other open applications for processor time.

Input/output configuration 
The System configuration section includes subsections:

 I/O connections

 Voltage levels

I/O connections
Input/output (I/O) connections are available on the Flyer/Fenix Flyer head for routing control signals 

from/to parts handling equipment. In WinMark Pro v6, input bits IN0–IN7 and output bits OUT1–OUT7 

correspond to the same eight inputs and outputs on Flyer marking heads and Fenix Flyer Laser Markers.
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Inputs

There are several important differences between FH Flyer/Fenix Flyer and legacy FH Index/Tracker and 

Fenix input connections that must be considered. See the Technical Reference chapter in your marking 

head’s Operators Manual for detailed input circuit diagrams, pin designations, and signal specifications 

including voltage levels. Below are brief summaries of available inputs. 

FH Flyer/Fenix Flyer

FH Flyer marking heads and Fenix Flyer Laser Markers provide eight optoisolated inputs, IN0–

IN7. Three of these inputs, IN0–IN2, have isolated returns and the other five inputs, IN3–

IN7, share a common return to allow either high-side switching of all five inputs or low-side 

switching of all five inputs.

FH Index/Tracker and Fenix

All four FH Index/Tracker and Fenix inputs, IN0–IN3, have isolated return lines and can sink 

or source current independently of one another. Two more inputs (IN4 and IN5) are avail-

able on the primary Fiber Link Controller Card. Additional inputs can be obtained by adding 

another PCI-bus FLCC to the computer. By installing a uniquely addressed FLCC, six more 

inputs (IN0–IN5) become available. 

Note: Inputs on primary (or secondary) FLCCs are available only though WinMark Pro’s 

Event Builder automation.

Outputs

See the Technical Reference chapter in your marking head’s Operators Manual for detailed output circuit 

diagrams, pin designations, and signal specifications including voltage levels. Below are brief summaries of 

available outputs.

FH Flyer/Fenix Flyer

FH Flyer marking heads and Fenix Flyer Laser Markers provide eight optoisolated outputs, 

OUT0–OUT7. On these heads, two outputs, OUT0 and OUT1, have isolated returns while 

the remaining six outputs, OUT2–OUT7, share a common return line so that all six outputs 

can function as either high-side or low-side switches.
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FH Index/Tracker and Fenix

All four FH Index/Tracker and Fenix outputs, OUT4–OUT7, have isolated grounds providing 

either sinking or sourcing current. Two more outputs (OUT1 and OUT3) are available on the 

primary Fiber Link Controller Card. Additional outputs can be obtained by adding another 

PCI-bus FLCC to the computer. By installing a uniquely addressed FLCC, five more outputs 

(OUT1, OUT3–OUT6) become available.

Note: Outputs on primary (or secondary) FLCCs are available only though WinMark Pro’s 

Event Builder automation.

Voltage levels

FH Flyer/Fenix Flyer

Input/output voltage levels for FH Series Flyer and Fenix Flyer heads is between 5 V–24 VDC. Note that 

this voltage level is different from previous SYNRAD marking heads. These heads also incorporate an 

internal +15 VDC, 400 mA supply for powering input, output, and tracking components.

FH Series Index/Tracker, Fenix 

All FH Index/Tracker marking heads and Fenix Laser Markers require I/O voltage levels in the range of 15 

V–40 VDC for signals connected to the head. 

Fast Acting Safety Interlock (FASI) feature
Many marking applications require a safety action to occur for each part that is marked. An example of 

this kind of action is a machine that lowers a shield over a part prior to marking, and then raises the shield 

to advance the part as soon as the mark is complete. SYNRAD lasers are equipped with a Remote Interlock 

feature that disables laser firing—typically when a switch on an access door or safety enclosure is opened. 

However in marking applications where a safety interlock is frequently cycled, the Remote Interlock cre-

ates an unacceptable delay. This delay occurs because after the interlock is closed, the laser’s Keyswitch or 

remote keyswitch function must be cycled, which then invokes a built-in five-second delay prior to lasing. 

To address this issue, all FH Series marking heads and Fenix markers provide an optional Fast Acting 

Safety Interlock (FASI) function. When enabled, the FASI function prevents the laser from firing unless a 

high level signal is present on input IN3. The marking head responds to this rising signal transition in less 

than 1 ms. To enable the FASI feature, refer to the Technical Reference chapter in your marking head’s 

Operators Manual for details. 

After your marking head is configured for FASI operation, you should modify each mark file as described 

below. Adding this modification in addition to the normal ‘start mark’ automation prevents WinMark 

Pro from beginning lasing until both the ‘start mark’ signal, typically input IN0, and FASI input IN3 are 

active.
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1 Configure WinMark’s Wait Digital Before Piece command (on the Drawing’s Automation tab) to wait 

for a “Set” state on input IN3 before marking begins. This synchronizes marking operation with the 

FASI safety feature. Normally, input IN0 will all ready have been “Set” in order to wait for the ‘start 

mark’ signal. See Figure 11-1.

Figure 11-1  Start Mark/FASI automation setup

Note: When the FASI function is enabled, even manual firing of the laser using the Test Mark button 

requires an active input signal on IN3.

Developing a basic event sequence
The Developing a basic event sequence section includes subsections:

 Event 0

 Event 1

 Event 2

 Event 3

 Event 4

Automated marking and parts handling control is typically controlled by a programmable logic control-

ler (PLC), programmable automation controller (PAC), or a computer and control program capable of 

sending and receiving digital signals. The Flyer/Fenix Flyer head is directed by WinMark Pro, or a custom 

Microsoft VB or C++ application using WinMark Pro’s ActiveMark™ (ActiveX®) control, to send outputs 

and read inputs as commanded by predefined Event Builder or Automation tab events. The parts handling 

or control system fully controls the automation sequence by setting or clearing marking head (or FLCC) 

input bits; WinMark Pro (or the marking head) responds by setting or clearing output bits.

The state diagram shown in Figure 11-2 below illustrates one method of defining the sequence of events 

necessary to coordinate parts handling and marking. Each event is numbered for cross-reference to the fol-

lowing steps. Refer back to Chapter 10 (Figure 10-1, Mark Session Flowchart) or WinMark Pro’s Automation 

Flowchart (Help/Automation Flowchart…) to review the automation sequence.
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Note: The following example assumes that an input signal from parts handling equipment is connected 

to input IN0, and that an output signal to parts handling equipment is connected to output 

OUT4. Although applications for WinMark Pro vary widely in complexity, the following example 

describes a typical automated marking operation using WaitDigital and SetDigital functions on 

WinMark’s Automation tab. 

WaitDigital commands force WinMark Pro to wait indefinitely for the designated input logic 

state to occur. After the expected state is read on the I/O port, WinMark moves on to the next 

automation stage or event.

SetDigital commands tell WinMark Pro to write the designated output logic state to the I/O port. 

After doing so, WinMark moves on to the next automation stage or event.

Figure 11-2  Sample state diagram

Event 0 – Once a mark session is started (when the Start-F1 button in the Launcher window is pressed), 

WinMark Pro begins executing the automation sequence. WinMark sets output OUT4 high, 

signaling parts handling equipment that WinMark is ready to begin marking.

Event 1 – WinMark Pro waits indefinitely until parts handling equipment sets input IN0, the ‘start mark’ 

signal, high. This action indicates that a part is in position and is ready to be marked.

Event 2 – As soon as WinMark Pro recognizes the ‘start mark’ signal from Event 1, WinMark clears out-

put OUT4 low to inform parts handling equipment that lasing is in progress. 

CLEAR 

SET 
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to PLC
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Input IN0

from PLC
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Event 3 – At any time after OUT4 goes low, parts handling equipment may clear input IN0 low as 

indicated by the gray area in the state diagram. When lasing is complete, WinMark Pro verifies 

that the ‘start mark’ signal is disabled. This prevents another mark from lasing immediately if 

the ‘start mark’ signal persists for any reason. 

Event 4 – As soon as lasing is complete, WinMark Pro sets output OUT4 high, signaling parts handling 

equipment to move another part into position.

Important Note: In order for the automation sequence to loop more than once, the Drawing’s Mark 

Count property must be greater than 1, or be set to 0, which forces the mark session 

to continue until halted by the user.

Event 0

1 Select Drawing from the Object List.

2 Select the Automation tab on the Property List.

3 Select Set Digital Before Piece and click the down arrow.

4 Click on OUT4, click the down arrow, and then select Set from the drop-down list (Figure 11-3).

Selecting Set assigns a logic 1 value to output OUT4. This output signals parts handling equipment 

that WinMark is ready for a part to be moved into position under the marking head.

Figure 11-3  Setting “Set Digital Before Piece”
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Event 1

1 Select Wait Digital Before Piece.

2 Click IN0, then select Set from the drop-down list (Figure 11-4).

Selecting Set assigns a logic 1 value as the required logic state on input IN0. In this example, parts 

handling equipment sets IN0 high once a new part is in position to be marked. This input serves as 

the ‘start mark’ signal, commanding WinMark Pro to begin marking.

Figure 11-4  Setting “Wait Digital Before Piece”

Event 2

1 Select Set Digital Before Mark.

2 Click OUT4 then select Clear from the drop-down list (Figure 11-5).

Selecting Clear assigns a logic 0 value to output OUT4. The digital output set here signals parts 

handling equipment that WinMark Pro is marking.

Important Note: WinMark Pro begins marking immediately after the Set Digital Before Mark auto-

mation step is executed.

Figure 11-5  Clearing “Set Digital Before Mark”
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Event 3

1 Select Wait Digital After Piece.

2 Click IN0 then select Clear from the drop-down list (Figure 11-6).

Selecting Clear assigns a logic 0 value as the required input state on input IN0. In this example, parts 

handling equipment clears IN0 to ensure that the “start mark” signal is disabled before a new part is 

staged. To speed throughput, parts handling equipment can clear this bit any time after Event 2 oc-

curs so that the Wait Digital After Piece test is true immediately after marking is complete.

Figure 11-6  Clearing “Wait Digital After Piece”

Event 4

1 Select Set Digital After Mark.

2 Click OUT4 then select Set from the drop-down list (Figure 11-7).

Selecting Set assigns a logic 1 value to output OUT4. The logic high value set here is an output 

signaling parts handling equipment that WinMark Pro has completed the mark and is ready to start 

the next mark when commanded.

Figure 11-7  Setting “Set Digital After Mark”
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Automated serialization
The Automated serialization section includes subsections:

 Serial number setup

 Marking setup

 Automation setup

 Begin automated marking

In addition to “communicating” or hand-shaking with parts handling equipment, WinMark Pro can also 

control serialization of part numbers and date or shift coding of products. The sections below describe one 

method of automating part serialization.

Serial number setup

1 Select the Text Tool and click to set an insertion point.

2 When the Text Caption Editor dialog box opens, type “0000” and then click OK.

The number of characters entered should equal the maximum number of digits you plan to serialize. 

In our example, a maximum of 9999 parts are serialized before the counter resets back to 0000. 

Note: WinMark Pro does not suppress leading zeros when marking. For example, if there are four place-

holder digits, item number one is marked as 0001.

Tip: In addition to serializing alphanumeric or hexadecimal text, WinMark Pro can also serialize 1D and 

2D bar code data.

3 With the text object still highlighted, select the Automation tab from the Property List and click Auto 

Text Type.

4 Click the down arrow and choose Serial Number Text from the drop-down list.

5 Next, select Save Last Serial and set to Yes.

 This ensures that the last serial number marked is saved after a mark session. The next mark session 

begins by retrieving the last saved number and incrementing it before marking the next piece.

6 Select Save Serial Name. The default location name for storing the last serial number is “Slot-0”, 

which is located in the computer’s System Registry. Although you cannot change the storage loca-

tion, you can edit the location name to something more meaningful. By doing this, multiple mark 

files can have their own individual serial number strings.
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Note: When your mark file is loaded into the Flyer/Fenix Flyer Filestore for stand-alone operation, the 

location name you provide for the Save Serial Name property (“Slot-0”, for example) is created 

in an area of Flyer’s battery-backed RAM memory.

7 Select Current Saved Value. If the value displayed is not zero, zero it out (0000 in our example) to 

initialize the serial number counter. Figure 11-8 shows how the screen should look after this step.

Figure 11-8  Serialization setup

Marking setup

1 Make sure the text you entered is still selected. Click the Format tab and go down the list, setting 

type characteristics as desired.

2 Click the Marking tab and set desired mark characteristics including Power and Velocity.

3 In the Object List, click Drawing (or click outside the text object on the Drawing Canvas) and then 

click the Making tab.

4 Set Mark Count to zero (0).

Figure 11-9 shows how the Drawing’s Marking tab should look after this step. Once started, marking 

will continue until the ESC key is pressed. Automation signals from the control computer or PLC 

will determine when the laser fires. These signals will be configured in the next section.

Figure 11-9  Marking setup
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Automation setup

1 With the Drawing object still selected, click the Automation tab.

2 Select Set Digital Before Piece and click the down arrow.

3 Click on OUT4, click the down arrow and then select Set from the drop-down list.

 Set output OUT4 to signal parts handling equipment that the laser is off and is ready for a new part.

4 Select Wait Digital Before Piece, click IN0 and then select Set from the drop-down list.

 Input IN0 is used as the ‘start mark’ signal from the PLC or automation controller. WinMark Pro’s 

automation sequence will halt until the required logic state is matched. In this example, the PLC 

sets IN0 high when all conditions for safely lasing the mark are met.

5 Select Set Digital Before Mark, click OUT4, and then select Clear.

 WinMark Pro clears this output prior to firing the laser. This bit notifies the PLC that the laser is on.

6 Select Wait Digital After Piece and clear IN0.

 This input from the PLC ensures that IN0 is low (the ‘start mark’ signal is disabled) before continu-

ing the automation loop.

7 Select Set Digital After Mark. Click OUT4 and select Set.

 Setting this output informs the PLC that marking is complete and to stage another new part. Figure 

11-10 shows how the Automation tab should look after this step is complete.

Important Note: When a logic state is specified for an input bit (or a combination of input bits) on 

the Automation tab, WinMark Pro will not execute the next step in the Automation 

List until an input state matching the specified state is read on the marking head 

input bus. In the Event Builder, the next event defined after a MatchDigitalState 

or WaitDigitalState command is not executed until either a matching input state is 

read on the input bus or the specified timeout period is exceeded.

Figure 11-10  Automation setup
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Danger

serious 

personal 

injury

Before performing the marking tutorials in this chapter, ensure that 

all personnel in the area are wearing protective eyewear. Read and 

follow all laser safety and fume extraction precautions described in 

your laser and marking head Operator’s Manuals.

CO
2
 lasers emit invisible infrared laser radiation at the 10.6 µm CO

2
 

wavelength band. Since direct or diffuse laser radiation can inflict 

severe corneal injuries, always wear eye protection when in the same 

area as an exposed laser beam. Do not allow the beam to contact a 

person. CO
2
 lasers emit an invisible beam that is capable of seriously 

burning human tissue.

Always be aware of the beam’s path and always use a beam block 

while testing.

Note: WinMark Pro’s automation loop runs in the sequence shown on the Automation tab. Refer back 

to Figure 10-1, Mark session flowchart, or to WinMark Pro under Help/Automation Flowchart... for 

diagrams showing how WinMark Pro steps through the automation sequence.

Begin automated marking

Click the Mark button and then click Start-F1 when the Synrad WinMark dialog box (Launcher window) 

appears. Figure 11-11 shows the Launcher window after one iteration through the automation sequence.

Figure 11-11  Launcher window
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Note: In WinMark control mode, a Hardlock must be installed on your computer’s USB or printer port 

and the appropriate automation signals must be present on marking head inputs before the laser 

will fire.

Important Note: When WinMark Pro v6 is operated in demo mode, (no marking head is connected 

or powered up), the Mark button is disabled. If Mark… or Quick Mark is chosen 

from the File menu and the Start-F1 button is clicked, a dialog box appears to inform 

you that a marking head is not connected.
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12 ActiveMark 
automation

The ActiveMark automation chapter includes sections:

 ActiveMark technology

 ActiveMark basics

 Sample VB or C++ projects

ActiveMark technology
WinMark Pro’s ActiveMark™ technology transforms Windows® ActiveX® automation into a powerful user-

customizable laser marking interface. After generating a mark file or template in WinMark Pro, you can 

create a custom ActiveX application or user-interface using Microsoft® Visual C# ®, Visual C++® or Visual 

Basic® development tools. This custom program uses WinMark Pro’s built-in ActiveX control methods to 

regulate every aspect of the marking process including object placement or manipulation and communica-

tion with parts handling automation.

ActiveMark basics
For a complete list of WinMark Pro v6 ActiveMark (ActiveX) methods, properties, and events, see our 

WinMark Pro v6 ActiveX Control white paper on the WinMark Pro web site at: http://www.winmark.

com/products/winmark_activexsamples.html. The web site also contains several VB and C++ projects 

with sample code.

Important Note: Not all WinMark Pro v6 .NET ActiveX Events will work when compiled using 

Visual Basic 6.0 or below. To run a VB executable file containing Events, re-com-

pile your source code using Microsoft Visual Studio 2003 or above. Refer to the 

Microsoft web site for details.

Note:  When developing your automated control system using ActiveX control methods, do not place 

input automation into the mark file. Instead, perform any input automation functions within the 

ActiveX control program. By doing this, your control program remains in charge of pre-mark 

and post-mark automation and WinMark’s MarkDrawing control method only maintains control 

of the operating system long enough to control laser on/off commands during the actual mark-

ing process. Performing input automation within the mark file may prevent the ActiveX control 

program from regaining control of system resources if the specified input state does not occur.

Note:  When creating mark files for an ActiveX environment, always set the Mark Count property to 

“1”. This ensures that only a single mark is made each time the MarkDrawing method is called.

http://www.winmark.com/products/winmark_activexsamples.html
http://www.winmark.com/products/winmark_activexsamples.html
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Loading the WinMark Pro ActiveMark 
control

MS Visual Basic

The tutorial below describes how to add WinMark Pro’s ActiveMark (ActiveX) control to a Visual Basic 

project.

To add WinMark ActiveMark control to a Visual Basic project, perform the following steps:

1 After installing WinMark Pro, open WinMark and select the correct focusing lens and then close 

the WinMark application. This ensures that WinMark Pro and its associated ActiveX components 

are properly initialized and registered with the Windows operating system.

2 Open your Visual Basic project or create a new project.

3 In Visual Basic under the Project menu, find and select the Components menu item.

4 When the Components dialog box opens, click the Controls tab. If the Selected Items Only check box 

is checked, deselect it so that all registered controls are displayed.

5 Scroll through the list until you find the Synrad WinMark v6 ActiveX control item and then place a 

check mark to the left of the Synrad WinMark control.

 If the Synrad WinMark control is not shown in the Components list, then the OCX has not been 

registered by the operating system. In this case, click the Browse button and use the Add ActiveX 

Control dialog box to locate and Open the SynMhAtx.ocx file in the Program Files/WinMark folder.

6 Click OK. A Toolbox window with the Synrad WinMark ActiveX control (laser starburst icon) 

should appear as shown in Figure 12-1. 

Figure 12-1  WinMark Pro’s ActiveX control in VB Toolbox

7 Click the control and draw a preview window on the form.

Important Note: When the WinMark Pro v6 ActiveX control is drawn directly on a Visual Basic 

form, an instantiation error will occur in design mode unless you close the form 

before running your VB code.
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MS Visual C++

The tutorial below describes how to add WinMark Pro’s ActiveMark (ActiveX) control to the sample 

Visual C++ Container project. This same procedure is used to add the WinMark ActiveX control to any 

Visual C++ project or to update the ActiveX control after upgrading to a newer version of WinMark Pro.

To add WinMark ActiveMark control to a Visual C++ project, perform the following steps:

1 Make sure that you have installed WinMark Pro. After installation, open WinMark Pro to check 

that the correct lens is selected and then close WinMark Pro.

 This step ensures that WinMark Pro and its associated ActiveX components are properly initialized 

and registered with the Windows operating system.

2 Open the Container program (located in the C:\Program Files\WinMark\Samples\VisualCPlusSa-

mple folder) or create a new Visual C++ project.

3 In Visual C++ under Project/Add to Project, find and select the Components and Controls… menu 

item.

4 From the Components and Controls Gallery dialog box, select Registered ActiveX Controls.

5 Select the Synrad WinMark PRO Control and then click Insert (see Figure 12-2).

Figure 12-2  Inserting WinMark Pro’s ActiveX control
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6 When the Microsoft Visual C++ dialog box opens, click OK to “Insert this component”.

7 When the Confirm Classes dialog box appears (Figure 12-3), click OK.

The text on the right-hand side of the Confirm Classes dialog tells you the control class has already 

been generated. When installing a new version of WinMark Pro, this is how the correct linkage to 

the control is updated. If this is the first time you are accessing the ActiveX control, the text note 

would indicate you are adding a control class.

Figure 12-3  Confirm Classes dialog box

8 Click the Close button.

The WinMark Pro ActiveX control (SynMhAtx.ocx) has been added, or updated, in the open Visual 

C++ project. The application must be built, or rebuilt, in order to include the new control. Both the 

SynMhAtx.cpp and SynMhAtx.h files are machine-generated IDispatch wrapper classes created by 

MS Visual C++ and added to the project space. These files define the class that allows the Container 

project to access the methods, properties, and events in the SYNRAD ActiveX control.

See the C:\Program Files\WinMark\Samples\VisualCPlusSample folder for documentation and 

sample code illustrating two different methods of implementing the SynMhAtx control.

Sample VB and C++ projects
See the WinMark Pro web site at http://www.winmark.com/products/winmark_activexsamples.html or the 

WinMark Pro CD for both Visual Basic and Visual C++ sample code and mark files. These files include 

actual source code instead of an executable (.exe) file; therefore, your development computer must contain 

a version of Visual Basic or Visual C++.

Important Note: We strongly recommend that all ActiveX control methods use inches as the unit of 

measure. Program your application or user interface to calculate the conversion to 

inches from other units of measure. Unpredictable object placement may result if 

the Show Units Type property in the mark file is set to millimeters or centimeters.

http://www.winmark.com/products/winmark_activexsamples.html
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Commands & 

Properties

Use information in this section as a reference to WinMark Pro’s powerful command and 

automation controls.

This section contains the following chapters:

■	 Chapter 13 – WinMark Pro menu commands 

explains the commands available from WinMark Pro’s menu bar.

■	 Chapter 14 – Application Settings 

lists all properties on the Application Settings tab (under Tools/General Settings…) 

and explains how they control application, Drawing, object, and head-specific pa-

rameters.

■	 Chapter 15 – Drawing properties 

describes Drawing properties and explains how they control global drawing param-

eters such as tracking, input/output, and communication.

■	 Chapter 16 – Object properties 

describes object properties and explains how they control object display, automa-

tion, and marking.

■	 Chapter 17 – Event Builder commands 

describes how these predefined commands provide automation functions during the  

marking process.

■	 Chapter 18 – ActiveMark technology 

describes WinMark Pro’s implementation of ActiveX control.

■	 Chapter 19 – Flyer Modbus protocol 

references Flyer’s implementation of Modbus® I/P control for Flyer/Fenix Flyer 

heads.

■	 Chapter 20 – Troubleshooting 

describes software-related troubleshooting issues for marking hardware and software.

Note: For specific hardware troubleshooting, please refer to your laser or your marking head Op-

erator’s Manual.

WinMark Pro v6.3 User Guide

Commands & Properties 
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13 WinMark Pro menu 
commands

The WinMark Pro menu commands chapter includes sections:

 File

 Edit

 Objects

 View

 Tools

 Devices

 Window

 Help

WinMark Pro® displays active commands on the menu bar’s drop-down lists with dark type. Commands 

that appear dimmed are not available until a valid object selection is made.

File 
File commands (Figure 13-1) allow you to perform common file operations such as opening, saving, and 

printing as well as specific functions like importing graphics files or starting the laser marking process. 

Figure 13-1  File menu

New

Open a new, untitled drawing window. You can also create a new drawing by clicking the New shortcut 

button ( ) on the Toolbar.
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Open…

Open the Open dialog box to navigate through your computer system to find and open existing .mkh mark 

files. You can also open an existing file by clicking the Open shortcut button ( ) on the Toolbar.

Save

Save changes to the current file. When saving a new drawing, the Save As dialog prompts you to enter a 

filename. You can also save a drawing by clicking the Save shortcut button ( ) on the Toolbar.

Save As…

Display the Save As dialog, which prompts you to save the current drawing with a new filename or path.

Save File to Head

When a Flyer/Fenix Flyer head is connected in stand-alone mode and the Drawing Canvas contains a new 

or modified mark file, click Save File to Head to open the Save Flyer Files dialog and download the current 

file to the Flyer Filestore.

Important Note: When the Flyer Filestore contains a file with the same name as the file you are sav-

ing, the existing file in the Filestore is overwritten without warning.

Print All Properties… 

Print object property values for all objects contained in the active drawing. Use the Print dialog box to 

specify a printer or printer options.

Print Drawing… 

Print the active drawing. Use the Print dialog box to specify a printer or printer options. You can also print 

by clicking the Print Drawing shortcut button ( ) on the Toolbar.

Tip: Go to Tools/General Settings… , and on the Application Settings tab, set Show Grid to No before 

printing. This eliminates grid lines for a better view of objects in the mark file.

Import… 

Import a graphics file for placement in the current drawing. Click Import… to open the Open dialog to 

find and open graphics files by filename or file extension.

WinMark Pro’s Import… command relies on the File Import Filters to parse the selected file and convert 

the data into an importable graphic. This method is the most reliable way of opening graphics files for 

marking. In order to employ this approach, it is sometimes necessary to save your graphics files in an older 
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format (version number) so that the filters can correctly import the data. For example, when creating 

AutoCAD® files for WinMark Pro, Save As or Export the drawing in an AutoCAD 2010 format. 

In order to import vector files from more recent programs like Adobe® Illustrator® CS5, WinMark Pro v6 

provides Copy/Paste and Drag/Drop functionality. This feature allows you to Copy or Drag a graphic from 

your open drawing program and Paste or Drop it onto the Drawing Canvas. Because graphics files often con-

tain multiple data formats internally, the Choose Import Type dialog box opens (Figure 13-2) when more 

than one acceptable format is available. In general, choose Vector Image for best marking results. In some 

cases, importing your graphics file through the File Import Filters may produce better results than using the 

Copy/Paste or Drag/Drop feature.

Figure 13-2  Choose Import Type dialog box

Note: File Import Filters are automatically loaded when installing WinMark Pro v6.

Tip: In addition to marking monochrome (1-bit) bitmap images, WinMark Pro v6 supports the impor-

tation and marking of grayscale (8-bit/256 level) bitmap images. See the Bitmap format properties 

chapter later in this section for further information on marking monochrome and grayscale images.

File import notes

 When deciding on an import file type, best results are often achieved by importing graphics files saved 

in .DWG, .DXF, or .EMF formats.

 AutoCAD .DWG files contain “units” information that allows WinMark to scale the drawing cor-

rectly when the Vector Import Scale property is ‘One-to-one’. Not all .DXF files include “units” 

information so WinMark Pro defaults to inches as the unit of measure. If the original drawing is scaled 

in unit other than inches, the imported drawing will not be scaled correctly and must be resized on the 

Drawing Canvas.
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 Imported bitmap images are resized according to the Resolution setting specified on the Tools/General 

Settings…/Object Defaults tab. WinMark Pro does not resample bitmap images but rather resizes them 

to preserve the image’s total pixel count. For example, the overall dimensions of a 96 DPI image im-

ported into WinMark at 300 DPI are automatically resized to 32% of their original height and width.

	Because laser marking (with the exception of the 8-bit Grayscale Color Reduction Method) is a 

monochrome—black & white or on/off process—color or continuous-tone bitmaps are converted to 

1-bit images when imported. In previous versions of WinMark Pro, the 1-bit color reduction process 

(Bayer Dithering, Error Diffusion, Halftone, or Threshold) was the first step in the image transformation 

process; however, in WinMark Pro v6, color reduction is now applied to imported bitmap images as 

the last step in order to provide better raster print quality. After changing bitmap Resolution and/or 

resizing the image, use the Color Reduction Method property (on the Format tab) to change the color 

reduction algorithm as required. Although WinMark Pro now displays a more accurate view of actual 

mark quality, test marking is still recommended to determine powers and speeds that produce the best 

mark within the dynamic range of the material you are marking.

	Use the Grayscale Color Reduction Method to mark 8-bit grayscale images. Unlike Bayer Dithering, 

Error Diffusion, Halftone, or Threshold reduction methods where color bitmaps are converted to 1-bit 

images, Grayscale reduction provides 8-bit, 256 level grayscale marking of color or continuous-tone 

images. 

	Imported vector files are deconstructed into an entity comprised of individual objects including lines, 

arcs, circles, and text. If the file imports as a “Group”, then Ungroup-ing the “Group” object expands 

the entity into a “Polyline Set” (containing polylines and arcs) and individual “Circle” and “Text” 

objects. If the imported file imports as a “Polyline Set”, Explode-ing the “Polyline Set” object expands 

the entity into its constituent polyline objects. In this case, elliptical or circular objects are converted 

to polyline objects comprised of a series of short microvectors or true mathematical arcs depending on 

the setting of the Import Arcs as Polylines property.

	Polyline objects are optimized and grouped into a “Polyline Set” to eliminate redundant off-vector 

moves by the galvanometers so that cycle times are reduced. After importation, you can Explode 

these Polyline Sets to edit or modify individual polylines as desired and then Unexplode them into a 

newly optimized “Polyline Set”. Note that all polylines in the set are marked with the same properties, 

the properties of the first polyline or Polyline Set.

	Metafile formats (.CDR, .EPS, .EMF, .WMF, etc.) support both raster and vector objects in the same 

file. Although you can Explode and Ungroup vector components of a metafile into Polyline Sets, raster 

(bitmap) objects in the metafile remain whole and are not reduced to their individual components.

	When importing vector-based graphics files, WinMark Pro imports text and filled objects in addition 

to lines, arcs, and circles. Vector files are imported as grouped objects that can be Ungroup-ed to allow 

editing of individual polyline or text objects. Any filled objects in the import graphic are imported as 

unfilled polylines that can be individually selected (after Ungroup-ing) and filled as required. When 

importing vector files containing text composed of TrueType or OpenType formatted fonts not in-

stalled on the marking computer or fonts not recognized by WinMark Pro, you will need to export the 

file from your drawing program with text objects converted to outlines or paths in order to successfully 

import them into WinMark Pro.

	WinMark Pro v6 now imports hatch fills in .DWG and .DXF files. To mark a solid fill, use AutoCAD 

to set the hatch spacing to the spot size (or a multiple of the spot size) of the focusing lens. When us-

ing other drawing programs, create individual crosshatch lines within the program, but do not fill the 

object using a crosshatch or other pre-defined pattern because WinMark’s import filters will strip out 

these fills during importation.
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	If text objects in your AutoCAD file must be filled, use AutoCAD’s TrueType text tool to create the 

text then import into WinMark Pro and use WinMark’s Text Filled property to create the text fill.

Table 13-1 lists current file formats and program versions supported by WinMark Pro’s File Import Filters.

Table 13-1  Supported file formats

Extension File Format Extension File Format

.AI – Adobe Illustrator Format (v4.0–v7.0)

.BMP – Windows Bitmap

.CDR – CorelDRAW! Drawing File Format (v3.0–v8.0)

.CGM – Computer Graphics Metafile 

.CH3 – Harvard Graphics 3.0 Chart File Format (DOS)

.CMX – Corel ClipArt Format (v5–v7) 

.CTM – Clear Text CGM 

.DIB – MS Windows Device Independent Bitmap

.DRW – Micrografx Designer 3.1 

.DSF – Micrografx Designer 6.0 (Win95)

.DWF – AutoDesk Drawing Web Format

.DWG – AutoCAD 2010 Native Drawing Format

.DXF – AutoCAD 2010 Interchange Drawing Format 

.EMF – Enhanced Windows Metafile (Win32) 

.EPS – Encapsulated PostScript File

.FMV – FrameMaker Vector and Raster Format 

.FPX – Kodak FlashPix File (v1.0)

.GDF – IBM Graphics Data Format (GDDM)

.GEM – Digital Research Graphics Environment  

    Manager Metafile

.GIF – Graphics Interchange Format – Internet (LZW)

.GP4 – Group 4 CALS Format

.HGL – HP Graphics Language (Level 2.0) 

.HPG – HP Graphics Language (Level 2.0) 

.IGS – IGES Drawing Format (v5.1)

.IMG – GEM Raster Format

.JPG – JPEG File Format

.MET – OS/2 PM Metafile (v3.0)

.NAP – NAPLPS Standard ANSI Profile

.PCD – Kodak Photo-CD Format

.PCT– Macintosh PICT Format (v2.0)

.PCX – Zsoft PC Paintbrush Bitmap

.PDF – Adobe Portable Document Format (v3.0 – LZW)

.PDI – NAPLPS IBM PC VideoTex

.PIC – Lotus 123 Picture Format

.PIF – IBM Picture Interchange Format

.PLT – HP Graphics Language

.PNG – PNG Internet Format (non-LZW)

.PRE – Lotus Freelance for Windows

.PS – PS Language Format* (*ImageStream Level 2  

          Native PS Interpretation) (LZW)

.PSD – Adobe PhotoShop Document (through v4.0)

.RND – AutoShade Rendering File Format

.SH3 – Harvard Graphics 3.0 Show

 .SVG – Scalable Vector Graphics (XML File Format)

.SY3 – Harvard Graphics 3.0 Symbol File

.TIF – Tagged Image File Format (v6)

.VSD – Visio File Format

.WMF – Microsoft Windows Metafile (Win16)

.WPG – WordPerfect Graphic File
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Tip: Although there is not a “built-in” method for exporting a WinMark drawing into a CAD format, it 

can be done using a vector drawing program such as Adobe® Illustrator® or CorelDRAW®. The steps 

below describe how to convert a WinMark Pro .mkh file into a PostScript® (.PS) file or AutoCAD® 

Drawing Interchange (.DXF) Format for archival or Quality Assurance reasons.

1 In Windows, add a new local virtual printer using the Add Printer wizard.

2 When prompted for a printer port, choose “FILE: (Print to File)”.

3 Select a printer and then choose a virtual printer driver (if you have an HP printer selection, 

the “HP DesignJet 3500CP PS3” driver works well).

4 Finish the rest of the steps in the Add Printer wizard.

5 In WinMark Pro, under Tools/General Settings… , set Show Grid and Show Origin properties 

to No (to prevent grid lines from being exported along with drawing objects).

6 Under the File menu, click Print Drawing… .

7 For printer type, select the printer you just created.

8 Enter an output file name with a .PS extension. WinMark creates the file and places it in the 

WinMark folder (C:\Program Files\WinMark).

9 In Adobe Illustrator or CorelDRAW, open the PostScript (.PS) file.

10 Use the Direct Selection tool to select and delete the Drawing Canvas object, leaving just the 

mark object(s).

11 Export the drawing in the file format of your choice—a .DXF format for example. Illustrator’s 

export dialog asks you to choose a .BMP or .JPG format (both are bitmap formats for display 

purposes only; however, the resulting .DXF file is composed of vector objects. Note that ex-

ported circles or irregular objects are individual connected points, not mathematical arcs).

Mark…

Initiate and preview marking of the current drawing through the Synrad WinMark Launcher dialog. The 

dialog box provides piece count and total elapsed time in addition to a mark log that displays real-time 

marking status. You can also click the Mark button ( ) on the Toolbar to initiate mark-

ing.

Note: When entering FH Flyer’s stand-alone marking mode (when Standalone Marking is Yes), the 

Mark button on the Toolbar changes color from red to blue to indicate the change in operational 

state. If the head is already in a stand-alone mark session, the blue Mark button blinks on-off.

Quick Mark 

Initiates immediate laser marking without prompting the user. Pressing the F1 function key also begins 

Quick Mark marking of the current drawing. 
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All personnel in the marking area must be prepared and equipped as directed in the Laser Safety section for 

immediate laser output through the marking head.

Tip: When you chose Quick Mark from the File menu or press F1, the drawing is marked immediately 

and the Synrad WinMark Launcher window closes on completion of the mark. Use the Mark button 

on the Toolbar to open the Launcher window and keep it open in cases where you want to view Mark 

Log or cycle time information, or when multiple marks are performed. You must press F1 or click the 

Start-F1 button to begin marking after the Synrad WinMark window is opened with the Mark but-

ton.

“recent files” 

Display the four most recently opened files. Select a filename to open as the current drawing.

Exit

Close the WinMark Pro application. A dialog box prompts you to save any unsaved changes. Click the 

Cancel button to cancel the exit request.

Edit 
Edit commands (Figure 13-3) perform common functions such as copying, pasting, and selecting.

Figure 13-3  Edit menu

Undo

Undo the last action. The number of undo levels is determined by WinMark Pro’s Undo Depth property 

(Tools/General Settings…/Application Settings tab). Your computer’s memory will limit the maximum number 

of undo levels actually available.

Redo 

Redo the previously undone action.
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Cut 

Cut the selection and save to the Windows Clipboard. Only the last selection cut or copied to the Clip-

board is available for use. You can also cut a selection by clicking the Cut shortcut button ( ) on the 

Toolbar.

Copy 

Copy the selection to the Windows Clipboard. Only the last selection cut or copied to the Clipboard is 

available for use. You can also copy a selection by clicking the Copy shortcut button ( ) on the Toolbar.

Paste 

Paste the current Windows Clipboard contents into the drawing. You can also paste a selection by clicking 

the Paste shortcut button ( ) on the Toolbar.

Delete 

Delete the selection without saving to the Windows Clipboard.

Duplicate 

Duplicate the selection and place into the drawing.

Tip: An object inserted into a drawing using Paste or Duplicate retains all properties of the original 

object, however you can edit those properties individually as required.

Select All

Select all objects in the currently active drawing.
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Objects
Objects commands (Figure 13-4) perform common functions such as grouping, aligning, and transforming.

Figure 13-4   Objects menu

Group 

Group selected objects into a single object. When objects are Grouped, WinMark Pro displays the group’s 

default object properties although their previously defined individual mark properties are retained. 

Depending on the setting of Use Group Properties, all objects in a group are marked using their default 

group properties or are marked using their previously defined individual mark properties. 

Tip: To mark a group using individual mark properties, first set Use Group Properties to No (from the 

Tools/General Settings…/Object Defaults tab) and then Group the desired objects.

Tip: Grouping is useful in cases where one set of objects is marked based on a specific digital or serial port 

input and another set of objects is marked based on another set of input conditions. For example, 

define a single MatchDigitalState event for a group instead of defining multiple MatchDigitalState 

commands for individual objects.

Tip: From the Edit menu, click Select All to select all objects in the drawing for grouping. If you want 

to select some, but not all objects for grouping, hold the CTRL key down while clicking on objects 

required in the selection set. 
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Ungroup 

Separate a grouped object into its individual component objects. Ungrouped objects display all their previ-

ous user-defined properties. 

When an imported graphic file opens as a “Group”, you can Ungroup the object into its constituent parts.

Explode 

When a Polyline Set exists, use Explode to break the set down into its constituent polylines for editing. 

When an imported graphic file opens as a “Polyline Set”, you can Explode the object into its constituent 

parts.

Unexplode 

Converts selected polylines into a Polyline Set and optimizes polyline mark paths to obtain the fastest pos-

sible mark. 

Note: All polylines in a Polyline Set are marked using the object properties of the first polyline or Polyline 

Set included in the selection set. Individual polyline properties are discarded and are only recover-

able using the Undo command. To mark individual polylines using different mark parameters, you 

must Explode the Polyline Set.

Note: Object images may temporarily disappear from the screen display after performing an Explode or 

Unexplode operation. Click the Drawing Canvas to refresh the view.

Align… 

Align two or more selected objects either horizontally or vertically using the Align Objects dialog box  

(Figure 13-5). You can also open the Align Objects dialog box by clicking the Align shortcut button ( ) 

on the Toolbar.

Horizontal alignments are made from the selected objects’ left, right, or horizontal centerlines while verti-

cal alignments are made from the selected objects’ top, bottom, or vertical centerlines.

Figure 13-5  Align Objects dialog box
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Center on Field 

Center the selection set on the 0, 0 origin point of the Drawing Canvas. You can also center a selection by 

clicking the Center shortcut button ( ) on the Toolbar.

Transformations… 

Resize, scale, rotate, or precisely move the selection set using the Object Transformations dialog box (Figure 

13-6). X-Y position and height/width resizing values are accurate to four decimal places (0.0001"). You can 

also transform a selection by clicking the Transform shortcut button ( ) on the Toolbar. For ease of use, 

there are also Rotate +45 ( ) and Rotate –45 ( ) shortcut buttons located on the Toolbar. Note that 1D 

and 2D barcodes rotate only in 90-degree increments.

Figure 13-6  Transformations dialog box

Note: For TrueType and OpenType formatted text objects, the Text Height set on the Format tab will 

not match the Object Height shown in the Object Transformations dialog box. The value given as 

the Object Transformations Object Height is the sum of the uppercase cap height plus the space 

provided above and below for ascenders and descenders while, for TrueType/OpenType format-

ted fonts, the Format tab’s Text Height value corresponds to the uppercase cap height of the font. 

Stroke font heights are variable (depending on the designer) and do not strictly conform to this 

description.

Tip: To obtain accurate text height, use only uppercase letters and do the following: In the Object Trans-

formations dialog box, check Maintain Aspect Ratio, set the Current Height value to the desired size, 

and then press the TAB key to scale text. Click Apply and then click OK.
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Mirror 

Flip, or mirror, objects in the current selection set either horizontally or vertically. You can also mirror 

selected objects by clicking the Mirror X ( ) or Mirror Y ( ) shortcut buttons on the Toolbar.

Set Marking Order… 

Select the order in which objects on the Drawing Canvas are marked. The Configure Marking Order dialog 

box displays a list of all objects in the current drawing so that you can move objects up or down in the 

marking order. By default, WinMark Pro marks objects in the order in which they were created or im-

ported.

Tip: When marking sensitive materials, changing the mark order of objects helps limit the heat input 

into any one area of the material at one time.

Use Object For Defaults… 

Use all properties of the currently selected object as the default for any new objects created in this or 

future drawings. Before overwriting existing property values, a dialog box asks you to confirm this action.

View
View commands (Figure 13-7) perform common functions such as zooming in or out of the drawing or 

showing/hiding window elements.

Figure 13-7  View menu

Zoom Extents 

Maximize the display to encompass all objects on, or off, the Drawing Canvas. You can also “zoom all” by 

clicking the Zoom Extents shortcut button ( ) on the Toolbar.
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Zoom Page 

Display the entire Drawing Canvas. You can also click the Zoom Page shortcut button ( ) on the Toolbar 

to maximize your view of the canvas.

Zoom In 

Zoom in towards the center of the current view by a factor of two. You can also zoom in by clicking the 

Zoom In shortcut button ( ) on the Toolbar.

Zoom Out 

Zoom out from the center of the current view by a factor of two. You can also zoom out by clicking the 

Zoom Out shortcut button ( ) on the Toolbar.

Main Bar (Toolbar)

Toggle the check mark to show/hide the Main Bar (the Toolbar).

Draw Tools 

Customize views of the Toolbar, Tool Box, and Stand-alone Toolbar using the Toolbars dialog (Figure 13-8). 

Figure 13-8  Toolbars dialog box

Status Bar 

Toggle the check mark to show/hide the Status Bar.

Properties 

Toggle the check mark to show/hide the Object List, Property List and Help Window.

Flyer Files 

Toggle the check mark to show/hide the Flyer Filestore window when connected to an FH Flyer/Fenix Flyer 

head. 
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Work Book 

Toggle the check mark to show/hide Work Book tabs. Each tab contains a separate open drawing.

Tools
Tools commands (Figure 13-9) perform functions that customize global settings and defaults or control 

startup options.

Figure 13-9  Tools menu

General Settings… 

Located under General Settings… are four groups of parameters that define WinMark Pro’s default Ap-

plication, Drawing, Object, and “Device” properties. The “Device” tab (the “Flyer” tab when Flyer is con-

nected) is new to WinMark Pro v6 and contains head-specific properties for each installed head.

See Chapter 14, Application Settings, for complete descriptions of properties on Application Settings, Drawing 

Defaults, Object Defaults, and “Device” tabs.

Note: More than one “Device” tab may exist depending on the number of marking heads connected to 

the computer. When the term ““Device” (Flyer) tab” is used in this manual, it refers to a “Device” 

tab showing Flyer-specific properties.

Startup Options… 

Set startup option commands (Figure 13-10) to control WinMark or WinMark Launcher. You can 

command the Operating System to load WinMark Launcher automatically on computer startup, force 

WinMark Pro or WinMark Launcher to open a specific drawing when they open, or setup the Launcher 

application to start marking immediately after opening.

Figure 13-10  Startup Options dialog box
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Custom Test Mark… 

With Flyer marking heads and Fenix Flyer Laser Markers, you can load a WinMark Pro .mkh file into 

non-volatile memory, replacing the factory test mark pattern. Like the standard test mark, this custom file 

is marked each time the Test Mark pushbutton is pressed. However, unlike the standard test pattern, the 

custom test mark feature allows you to create a custom mark file with specific object properties and then 

perform Index marking without a computer connected to the marking head. See your Flyer or Fenix Flyer 

Operator’s Manual for details on configuring a custom test mark.

Note: The Custom Test Mark… selection is only active when WinMark Pro senses it is actively com-

municating with an FH Flyer marking head or Fenix Flyer Laser Marker, otherwise the menu item 

is disabled (dimmed).

Virtual Laser Marking… 

Place a high-resolution scanned image of the part to be marked underneath mark objects on the current 

drawing. Use this feature to precisely align mark objects to your part.

Get Flyer Head Logs

Download and view log files for historical purposes or when troubleshooting. Choose from among the 

Main Log (Main Messages.log), Last Bootup Log, Web Access Log, Web Error Log, Mark Log, and Head 

Configuration Log. By default, log files are downloaded and saved to the WinMark directory with the 

extension “.log”. After the log file is saved, it automatically opens and displays in Windows Notepad.

Set Flyer Time

Click this property to display the Set Date and Time dialog box (Figure 13-11). You can synchronize Flyer’s 

internal clock to your PC’s clock or adjust it manually. You can also configure Flyer’s clock for your local 

Coordinated Universal Time (UTC) zone.

Figure 13-11  Set Date and Time dialog box
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Flyer IP Address Range

As part of Flyer’s Ethernet security options, the range of IP addresses that connect to the Flyer/Fenix Flyer 

head can be restricted. If there are no restrictions (if the address range is zero), Flyer will connect to any IP 

address. By adding a range of allowable IP addresses (up to ten ranges), Flyer is restricted to connecting to 

devices within the allowable range and will refuse all other connections.

To set-up Ethernet security, refer to Figure 13-12 and perform the following steps:

Figure 13-12  Flyer IP Address Ranges dialog box

1 In the Tools menu, click Flyer IP Address Range.

2 Enter your user password. The default factory password is “pass” (without the quotes).

3 After the Flyer IP Address Ranges dialog opens, enter a range of authorized IP addresses.

The beginning IP address should be “less than” the ending IP address. For example, 190.160.90.100 

is considered less than 190.160.100.100. To allow access by only a single IP address, set the begin-

ning IP address equal to the ending IP address. Clear a range of addresses by entering 0.0.0.0 for both 

beginning and ending addresses.

4 To enable the Ethernet security feature, click the “On” button in the IP Address Security section. 

5 To safeguard your facility, we recommended changing the Ethernet Security Password from the factory 

default. To do so, enter a new case-sensitive password.

6 Click OK when done with changes.
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Devices
New to WinMark Pro v6 is the Devices menu (See Figure 13-13). This menu lists all possible marking 

heads that WinMark v6 can connect to. A check mark next to the list of communication methods or head 

types indicates the currently selected head. 

Note: The “Devices” menu is disabled when WinMark is opened in demo mode.

Figure 13-13  Devices menu

Flyer Ethernet

A check mark indicates that WinMark is communicating with a Flyer/Fenix Flyer head through the Ether-

net port. 

When an Ethernet-enabled Flyer head is connected after WinMark is open, go to Flyer Ethernet and select 

the highlighted head. If more than one Ethernet-enabled head exists, you can choose which one WinMark 

communicates with. Although a single instance of WinMark can communicate with only a single head, 

you can switch between multiple Ethernet-connected Flyer heads within a single WinMark instance. 

Important Note: The ability to switching between multiple Ethernet-enabled heads is intended for 

use only while upgrading, testing, or troubleshooting. SYNRAD does not recom-

mend designing a marking system where a single instance of WinMark switches from 

one Ethernet-enabled head to another every mark. This rapid switching methodolo-

gy is likely to disrupt Ethernet connect/disconnect protocols. In multi-head applica-

tions, we highly recommend opening a separate instance of WinMark Pro for each 

Flyer/Fenix Flyer head.

Flyer USB

A check mark indicates that WinMark is communicating with a Flyer/Fenix Flyer head through a USB 

port connection. 

When a Flyer head is connected through the USB port after WinMark is open, go to Flyer USB and select 

the highlighted head. If more than one USB-enabled head exists, you can choose which one WinMark 

communicates with. Although a single instance of WinMark can communicate with only a single head, 

you can switch between multiple USB-connected Flyer heads. 

Important Note: The ability to switching between multiple USB-enabled heads is intended for use 

only while upgrading, testing, or troubleshooting. SYNRAD does not recommend 

designing a marking system where a single instance of WinMark switches from one 

USB-enabled head to another every mark. This rapid switching methodology is 

likely to disrupt USB connect/disconnect protocols. In multi-head applications, we 

highly recommend opening a separate instance of WinMark Pro for each Flyer/Fenix 

Flyer head.
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FH/Fenix

A check mark indicates that WinMark is communicating with a FH Index/Tracker marking head or Fenix 

Laser Marker through a PCI-bus Fiber Link Controller Card (FLCC). When a head is connected through 

an FLCC after WinMark is open, go to FH/Fenix and select the highlighted head. 

Important Note: We highly recommend using WinMark Pro version 4.6 with FH Series Index or 

Tracker marking heads and Fenix Laser Markers. WinMark Pro v6 is not designed 

or intended for use with pre-Flyer heads and has not been fully tested to operate FH 

Series Index/Tracker heads. Although WinMark Pro v6 may appear to work with 

these heads, SYNRAD cannot guarantee that they will work error-free in all circum-

stances.

Connect to Ethernet Flyer

If your Flyer/Fenix Flyer head is already configured for Ethernet operation, but has not connected, click 

Connect to Flyer Ethernet and, when the Select Ethernet IP Address dialog opens, type in the head’s assigned 

Ethernet IP address.

Window
Window commands (Figure 13-14) allow you to perform functions such as switching between or re-arrang-

ing multiple drawing windows.

Figure 13-14  Window menu

Cascade 

Overlap all open drawing windows.

Tile 

Arrange all open drawing windows side-by-side.

“current active file” 

Select any open drawing in the list as the currently active drawing.

Tip: You can also toggle the Work Book selection on the View menu to show/hide Work Book tabs. Click 

a tab to quickly display each currently open drawing.
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Help
Help commands (Figure 13-15) display program and resource information.

Figure 13-15  Help menu

About Synrad WinMark… 

Display software version, copyright, and support information or check hardware/firmware status (Head 

Info) as shown in Figure 13-16. When a Flyer marking head or Fenix Flyer Laser Marker connection is ac-

tive, the dialog box (Figure 13-17) also displays temperature status and uptime (the time elapsed since the 

last boot-up sequence) information.

Figure 13-16  About Synrad WinMark dialog box (no head connected)

Figure 13-17  About Synrad WinMark dialog box (Flyer head connected)
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Head Info button

When a Flyer or Fenix Flyer head is actively connected, click the Head Info button to view the 

“Device” (Flyer) tab (see Figure 14-5) showing head specific setup information such as firm-

ware versions, Ethernet addressing, FASI and clearing mark status, tracking, and stand-alone 

configuration parameters.

Temperature status

When a Flyer head is connected, the About Synrad WinMark dialog (as shown back in Figure 

13-17) displays internal air temperature near power amplifier and CPU components along with 

a color-coded Status indicator. If the Status indicator, normally green, turns yellow (indicating 

power amplifier air temperatures at or above 65 °C), then you should consider adding an exter-

nal cooling fan (FH Flyer marking heads only). If the Status indicator turns red (when ambient 

air temperature surrounding the CPU reaches 65 °C), control circuitry in the Flyer head will 

halt marking. If this happens, marking is disabled until the head is cooled and ambient CPU 

air temperature drops below 60 °C.

Note: Real-time air temperature measurements at power amplifier and CPU locations inside 

Flyer have been correlated with optical scanner air temperatures after extensive test-

ing. A measured air temperature of 65 °C at the CPU indicates that air temperatures 

surrounding the optical scanners are approaching their maximum operating tempera-

ture limit of 50 °C.

Upgrade Flyer Firmware 

FH Flyer and Fenix Flyer flash memory contains the operating code—firmware—that controls the marking 

head. As improvements are made to the code, these firmware updates are posted to the WinMark Pro web 

site (www.winmark.com/products/winmark_firmware.html).

To upgrade the firmware in your Flyer/Fenix Flyer head, perform the following steps:

1 Power up the Flyer head and then open WinMark Pro v6.

2 From the Help menu, select Upgrade Flyer Firmware.

3 In the Open dialog, navigate to the location of the latest firmware update (Update_x-xx.fhz) file. By 

default, a copy is placed in the C:\Program Files\WinMark folder during the WinMark installation.

4 Select the appropriate .FHZ firmware file and then click Open.

5 A dialog box displays upgrade progress. After the new firmware is installed, the Flyer/Fenix Flyer 

head automatically reboots. 

6 The dialog box disappears when the head is updated and ready to perform marking operations.

Note: If WinMark does not reconnect to the marking head after it reboots, an error dialog will appear. 

Click Cancel, then close and re-open WinMark Pro to reset the communications link. 

www.winmark.com/products/winmark_firmware.html
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Synrad WinMark ActiveX Control Help 

Open an online Help window describing how to use WinMark Pro’s ActiveMark™ (ActiveX®) control. 

The Help window includes an overview of using the control and a complete list of control methods and 

properties for developing an ActiveX Flyer application.

Automation Flowchart… 

View a flowchart (Figure 13-18) indicating the sequence of events when using WinMark Pro automation 

features.

Figure 13-18  Automation flowchart

Synrad WinMark on the Web 

Automatically link to the WinMark web site (http://www.winmark.com/) through your browser. The 

WinMark Pro web site contains a wealth of information including About WinMark Pro, Downloads 

(WinMark Pro, Flyer firmware, sample mark files, and ActiveX sample files for VB, VC++, and VC# ap-

plications), Laser Marking FAQs, User Guides and Operation Manuals, Application Notes, and product 

information about SYNRAD Marking Heads.

Synrad WinMark FAQ 

Link directly to SYNRAD’s online Laser Marking FAQ at http://www.winmark.com/Support/FAQs.html. 

This list of Frequently Asked Questions covers marking head and software topics in categories such as 

Software/Firmware, General Troubleshooting, WinMark Pro Automation, Serialization, Tracking Opera-

tion, and ActiveX.

http://www.winmark.com/
http://www.winmark.com/Support/FAQs.html
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14 Application Settings
The Application Settings chapter includes sections:

 Application Settings tab

 Drawing Defaults tab

 Object Defaults tab

 “Device” (Flyer) tab

Under Tools/General Settings… , the General Settings dialog box displays four tabs containing parameters 

that define WinMark Pro’s default Application, Drawing, Object, and “Device” properties. The “Device” 

(Flyer) tab is new to WinMark Pro v6 and contains head-specific properties for each type of installed 

marking head. Each section below lists and describes the groups of properties available on each tab. Prop-

erties on the “Device” (Flyer) tab will vary depending on the type of marking head that is currently selected 

on the Devices menu.

Application Settings tab
The Application Settings tab lists properties that control global settings of the WinMark Pro application (see 

Figure 14-1).

Important Note: Properties on the Application Settings tab are not saved with the .mkh mark file. 

Instead, they are global application properties defined for a particular WinMark Pro 

installation on a specific marking computer.

Figure 14-1   Application Settings tab
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Password

Define a case-sensitive password to prevent unauthorized modification of .mkh mark files from WinMark 

Pro’s Drawing Editor. When a password is specified, the Enter Password dialog box appears each time the 

WinMark Pro Drawing Editor is opened.

Default Mark File Directory

Specify a user-defined directory for opening/saving .mkh mark files. WinMark Pro defaults to the C:\Pro-

gram Files\WinMark folder if this property is not defined. 

Show Units Type

Select inches, millimeters, or centimeters as the display unit for all measurements.

Note: WinMark Pro’s ActiveMark™ control uses inches as the unit of measure. When running a custom 

application program or user-interface based on our ActiveMark (ActiveX) control methods, you 

must set Show Units Type to inches and then program your application to calculate the conver-

sion from other units of measure. Unpredictable object placement or operation may result if the 

Show Units Type property is set to millimeters or centimeters.

Show Common Props

Display all properties or only common properties when multiple objects are selected on the Drawing Can-

vas.

Show Grid

Toggle display of Drawing Canvas grid lines on (Yes) or off (No).

Show Origin

Toggle display of Drawing Canvas X-Y Origin Lines on (Yes) or off (No).

Grid Offset X

Offset the drawing grid in the X direction by a specified amount. This property changes only the grid dis-

play, it does not affect mark placement relative to the Drawing Canvas.

Grid Offset Y

Offset the drawing grid in the Y direction by a specified amount. This property changes only the grid dis-

play, it does not affect mark placement relative to the Drawing Canvas.

Grid Spacing

Change spacing between drawing grid lines to speed object layout while maintaining consistent spacing 

between elements.
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Snap To Grid

Select Yes to constrain object placement, translation, or scaling to grid line intersections.

Nudge Spacing

Specify the distance (to 0.0001" accuracy) that selected objects are moved using the keyboard’s arrow keys. 

If Snap to Grid is Yes, the distance moved is equal to the Grid Spacing value.

Show Top Ruler

Toggle display of the upper drawing ruler on (Yes) or off (No).

Show Left Ruler

Toggle display of the left drawing ruler on (Yes) or off (No).

Undo Depth

Set the number of undo levels. Available computer memory will affect the actual number of undo levels.

Banner View Size

When the Banner Marking property is enabled, adjust the Drawing Canvas viewport to display the extents 

of the banner mark.

Application Language

Choose one of the following languages as the default language for WinMark Pro—English, Dutch, French, 

German, Italian, Spanish, Japanese, or Chinese. After changing the Application Language, you must close 

and then re-open WinMark before the new language is displayed.

To use Japanese or Chinese languages with Windows XP or 2000, you must first load the correct Chinese 

or Japanese codepage and set it as the default from Regional Settings in the Windows Control Panel. 

Drawing Defaults tab 
Create default Drawing properties for all new drawings you open (Figure 14-2). These properties only affect 

the actual marking output; Drawing Canvas and Launcher screen displays do not change.
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Figure 14-2  Drawing Defaults tab

Field Offset X

Enter the amount of drawing offset required in the X-direction when marking.

Field Offset Y

Enter the amount of drawing offset required in the Y-direction when marking.

Field Rotation

Enter the amount of drawing rotation required around the transformation origin when marking. Field 

Rotation is accurate to two decimal places (0.01 degrees).

Note: In WinMark Pro versions 6.3.0.7328 and above, when the Drawing’s Field Rotation is set to other 

than 0.00 degrees, the Mark Preview window now displays the actual mark rotation referenced to 

the fixed Drawing Canvas display.

Field Transform Org X

Specify the transformation X-origin required when offsetting, rotating, or scaling a drawing for marking. 

The default X origin point is 0.0000 inches.

Field Transform Org Y

Specify the transformation Y-origin required when offsetting, rotating, or scaling a drawing for marking. 

The default Y origin point is 0.0000 inches.
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Field Scale X

Specify the percentage of X-axis scaling around the transformation origin.

Field Scale Y

Specify the percentage of Y-axis scaling around the transformation origin.

Note: If Field Scale X and Field Scale Y properties are set to different values, the non-proportional field 

scaling will cause mark distortion.

Note: In WinMark Pro versions 6.3.0.7328 and above, Field Scale X and Field Scale Y values can be 

fine-tuned to accuracies of 0.01%.

Invert X Axis

Invert marking output along the X- (horizontal) axis.

Invert Y Axis

Invert marking output along the Y- (vertical) axis.

Object Defaults tab 
Customize default object properties (Figure 14-3) for new objects you create in a new (or current) drawing.

Figure 14-3  Object Defaults tab
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Use Group Properties

Choose Yes to mark grouped entities using properties currently defined on the Object Defaults tab. Select 

No to mark grouped entities with their individual properties defined prior to grouping. 

Note: In order to mark group entities using individual properties, set Use Group Properties to No and 

then perform the Group operation.

Mark Object

Select Yes to mark the current selection set. Choose No to disable marking of selected objects.

Tip: Mark Object, a Boolean object property, is often used with MatchDigitalState automation so that 

a True (1) input condition causes the specified object or group to mark. Objects/groups are not 

marked if the corresponding input condition is False (0).

Tip: It is often useful to place marking instructions or reminders on the Drawing Canvas for equipment 

operators. Simply enter the desired text, then size and position the text object. With only the 

instructional text selected, set Mark Object to No. Although visible, this text object will not mark 

and will not affect cycle times. 

Important Note: The Mark Object property is specifically excluded from the list of properties that are 

bundled when objects are Grouped. When non-marking objects (Mark Object prop-

erty is No) are Grouped, with marking objects (Mark Object is Yes), the Use Group 

Properties property is set to Yes, and the Mark Object property for the group is set 

to Yes, the Mark Object value of individual objects in the group still takes prece-

dence over the group’s Mark Object setting. Grouped non-marking objects will not 

be marked. To mark all objects in a group, you must set the Mark Object property of 

individual objects to Yes before performing a Group operation.

Mark Passes

Specify the number of passes required to mark selected objects. 

Tip: Use the Mark Passes property to mark heat-sensitive materials. In many cases, multiple low-power 

passes can process parts that would otherwise be damaged by a single, higher power pass.
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Mark Pass Delay

When Mark Passes is greater than 1, specify a delay (in milliseconds) between subsequent passes. 

Wobble On 

Select Yes to mark thicker polyline strokes by “wobbling” the laser beam. Lines are essentially thickened by 

marking shorter lines at right angles to the intended line segment. Line width is determined by the value 

specified for Wobble Thickness and line “resolution” is determined by Wobble Step Size. 

Wobble Thickness

Specify the “Wobble” width (line thickness) for selected polyline objects.

Wobble Step Size

Enter a specific distance between “Wobble” steps. This value serves as the “resolution” of the line width—

smaller steps equal higher resolution.

Wobble Style

WinMark v6 adds support for several different wobble ‘styles’. Standard indicates that each wobble line is 

marked unidirectionally from the same side of the polyline. Bidirectional forces WinMark to mark wobble 

lines alternating from side to side and is the quickest of the three wobble styles. The Sawtooth style pro-

vides additional “fill’ by marking a diagonal line from the bottom of one wobble line to the top of the next 

wobble line.

Note: Although the mark is created as specified, there is no visible change to ‘wobbled’ polyline objects 

on the Drawing Canvas.

Velocity

Specify a “laser on” optical scanner velocity for marking the selected object.

Power

Enter the duty cycle percentage of laser power required to mark the selected object. In WinMark Pro v6, 

you can change Power in 0.1% steps.

Tip: Typically, a value of 70–80% equals the laser’s specified output power rating.

Resolution 

Enter a marking resolution for the selected object. Units of measure are in microvectors per inch, which is 
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roughly analogous to the more common dots per inch (DPI) terminology.

When using WinMark Pro v6 with FH Flyer or Fenix Flyer heads, the Resolution property no longer 

applies except to filled Polyline, Text, Bitmap, and 2D Barcode objects (Barcode objects have a Barcode 

Resolution property). All other objects mark at the maximum resolution possible. 

Note: In WinMark Pro v6, imported bitmap images are resized according to the Resolution setting 

specified on the Tools/General Settings…/Object Defaults tab. Previously, WinMark Pro increased or 

decreased bitmap image size corresponding to a fixed bitmap resolution of 600 DPI. WinMark Pro 

does not resample bitmap images but rather resizes them to preserve the image’s total pixel count. 

For example, the overall dimensions of a 96 DPI image imported into WinMark at 300 DPI are 

automatically resized to 32% of the original height and width.

Tip: In order to import a bitmap image at full scale, WinMark’s Resolution setting must match the file’s 

resolution. For example, to import a file saved at 225 DPI, first ensure that the Resolution property 

on the Tools/General Settings…/Object Defaults tab is set to 225 and then import the file. 

Raster Scan Direction

Specify Horizontal or Vertical raster-scanning for filled objects. 

Tip: When marking raster-scanned images such as imported graphics, filled TrueType/OpenType format-

ted text, or barcodes; one scan direction typically marks much faster than the other depending on 

the object’s orientation. Optimize mark cycle time by ensuring that Bi-Directional Raster is Yes and 

then test mark each filled object using first Horizontal and then Vertical Raster Scan Direction.

Pline Start Delay 

Use Pline Start Delay to minimize hot spots at the beginning of a polyline or the beginning of a series of 

polylines. See Chapter 16, Object properties, for a detailed description and illustration of Pline Start Delay 

functionality. 

Pline End Delay 

Pline End Delay maintains beam output at the end of a series of polylines to ensure that the current 

polyline is completed before moving to the next polyline vector. See Chapter 16, Object properties, for a 

detailed description and illustration of Pline End Delay functionality.
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Interseg Delay 

Interseg Delay sets a delay when marking connected polylines where the end point of the current polyline 

is the start point of the next polyline in the object. See Chapter 16, Object properties, for a detailed descrip-

tion and illustration of Interseg Delay functionality.

Off Vector Delay 

Off Vector Delay sets a proportional delay during all laser off-vector moves to eliminate “tails” when 

moving between non-connected polylines. See Chapter 16, Object properties, for a detailed description and 

illustration of Off Vector Delay functionality.

Bi-Directional Raster

Choose Yes to enable bi-directional scanning, which reduces cycle time when marking a raster image. If set 

to No, laser marking of bitmap or filled images is done in only one raster direction.

Note: To achieve the best image quality when Bitmap Scan Type is set to Continuous (or when marking 

Grayscale images), Bi-Directional Raster is automatically disabled; marking occurs in only one 

direction although you can still specify a Raster Scan Direction. 

Font Type

Select either a TrueType®, an OpenType®, or a stroke font for text. Use stroke fonts to mark text quickly at 

high throughput speeds. Use TrueType or Open Type formatted fonts to match a logo, maintain a corpo-

rate identity, or create a certain “look”.

True-Type Font

Select a TrueType formatted font for marking text. You can laser mark any TrueType font installed in C:\

WINDOWS\Fonts folder. WinMark Pro’s TrueType Font property supports TrueType (.TTF) fonts as well 

as the OpenType® (.TTF) fonts found on newer Windows operating systems.

Stroke Font

Select one of WinMark Pro’s twelve built-in stroke (.SYF) fonts. Available fonts include Bold, European, 

Gothic, LiteCom, Little, Sans Serif, Script, Simple, Trip, Tscr (Trip Script), Complex, and Simplex.

Open Type Font

New to WinMark Pro v6 is support for OpenType® (.OTF) fonts and Adobe® PostScript® (.PFB) fonts. To 

access these fonts, create shortcuts and copy these shortcuts to the C:\WINDOWS\Fonts folder.

Text Height

Enter a character height for stroke or TrueType-style text. 

Note: For TrueType-style fonts (TrueType, OpenType, and PostScript), Text Height is the approximate 

height of uppercase letters such as “M” or “W”, although this height varies slightly depending 
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upon the metrics of the chosen typeface. In general, the Text Height for stroke fonts allows room 

for lowercase descenders. This means that uppercase stroke text will display and mark smaller 

than the value specified by Text Height. 

Figure 14-4 (on the next page) compares both stroke and TrueType text strings. The Drawing’s 

Grid Spacing is set to 0.25 inches and Text Height for both fonts is set to 1.0 inches. The Simple 

stroke text example shows that the 1.0-inch Text Height includes descenders for letters such as 

‘g’, ‘j’, and ‘y’. The Times New Roman TrueType example shows that uppercase letters are less 

than one inch high while descenders exceed the one-inch boundary. The TrueType font’s Current 

Height value in the Object Transformations dialog box indicates the actual overall text height is 

1.21 inches.

Figure 14-4  Stroke/TrueType height comparison

Tip: To obtain accurate text height, use only uppercase letters and do the following: In the Object Trans-

formations dialog box, check Maintain Aspect Ratio, set the Current Height value to the desired size, 

and then press the TAB key to scale text. Click Apply and then click OK. 

Text Bold

Toggle Yes to bold selected TrueType-style text.

Text Italics

Toggle Yes to italicize selected TrueType-style text.
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Text Filled

Toggle Yes to fill the selected TrueType-style text. Choosing Yes fills text characters using a raster scanning 

method. Choosing No simply marks text characters as vector outlines.

Text Underline

Toggle Yes to underline selected TrueType-style text.

Text Justification

Select Left, Right, or Center justification for multiline text objects.

Text Curve Detail

Specify a curve resolution for TrueType-style fonts. Higher Text Curve Detail values create smoother 

curves especially when marking large font sizes.

Vector Import Scale

Select a method for scaling vector graphic files during importation. Choose from 1:1; X Axis, which scales 

the graphic to the X (horizontal) Drawing Canvas extents; Y Axis, which scales the graphic to the Y (verti-

cal) Drawing Canvas extents; or Best Fit, which scales the graphic to best fit the optimal mark area for the 

selected focusing lens.

Vector Import Scale Value

WinMark Pro’s default unit of measure for imported vector files is inches. Changing the Vector Import 

Scale Value from its default setting of 1.0 allows you to import vector files that are drawn in units other 

than inches. For example, to import a file drawn at 1:1 scaling in millimeters, enter a Vector Import Scale 

Value of 1/25.4, which rounds off to 0.3937008. This conversion factor is used by the File Import Filters to 

properly scale the drawing on WinMark’s Drawing Canvas.

Optimize Vector Import

For imported vector graphics, choose Yes to reorder (optimize) individual vectors to obtain the fastest cycle 

time. Choosing No forces WinMark to mark imported vectors in the order in which they were originally 

drawn and saved by the graphics program.

Import Arcs as Polylines

For imported vector graphics, Choose Yes to import circular arcs as polyline objects. In this case each 

polyline object marks as a continuous closed path. Choose No to import circular arcs as ellipse objects—

real WinMark Pro circle (arc) objects—with editable Arc Start and Arc End points. 

Text Width

Enter an average width (horizontal scale) for text characters. Enter zero (0) to return to the font’s default 

width.
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Line Spacing

Enter line spacing (leading) between lines of multiline text. Enter zero (0) to return to the font’s default 

line spacing.

Extra Char Spacing

Enter additional spacing (tracking) between text characters. Enter zero (0) to return to the font’s default 

character spacing.

Barcode Style

Select a 1D bar code from WinMark Pro’s library of over twenty common bar code types or subsets. See 

Bar code format properties in Chapter 16 for a complete list of supported bar code formats

Barcode Quiet Zone Size

For inverted 1D barcodes, set the amount of marked quiet zone area around the code so that it reads prop-

erly.

Barcode Height

Set a specific bar code height.

Barcode Thin Width

Define a line width for thin bars in the bar code. 

Tip: When setting Barcode Thin Width, do not enter a value smaller than the spot size of the selected 

focusing lens. Doing so results in thin bars that are wider than expected and encroach on the 

“white” space between bars. In some cases, this lack of sufficient white space makes the bar code 

unreadable. 

Barcode Checksum

Toggle Yes to include a Barcode Checksum in the bar code if applicable for the Barcode Style selected. 

Although the checksum is appended to the bar code itself, it is not included to the human-readable text 

string (when Barcode Show Text is Yes).

Barcode Show Text

Toggle Yes to include human-readable text in the bar code. The text string marked is a filled (raster-

scanned) TrueType formatted font. 
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Tip: Human-readable bar code text always uses filled TrueType formatted fonts. To reduce cycle times, 

set Barcode Show Text to No then create and position a new text object. Specify a stroke font for 

this new text object and then use the From Another Object and Assign From properties (on the 

Automation tab) to link the text object’s Text Caption property to the bar code’s Barcode Number 

value.

Barcode Text Position

If Barcode Show Text is Yes, select one of six locations for the placement of human-readable text around 

the bar code.

Barcode Text Font

Select any TrueType formatted font installed in your C:\WINDOWS\Fonts folder as the human-readable 

text type marked as part of the bar code.

Barcode Text Size

Enter a text size for the human-readable text included with the bar code.

Barcode Thick to Thin Ratio

Select a sizing ratio between thick and thin bars/spaces in the bar code. Preset ratios include 2:1, 2.5:1, and 

3:1. Specifying a larger ratio increases the width of thick bars and thick spaces in the bar code.

PDF 417 X/Y Ratio

Enter a value (ranging from 1 to 10) for the ratio of the PDF 417 barcode cell height to width. The default 

is 4.

PDF 417 Security Level

Enter a value (ranging from 0 to 8) for the PDF 417 barcode security level with 0 as the lowest level. The 

default is 0. Higher levels of security create larger codes.

PDF 417 Truncated

When set to Yes, the right-hand side of the code is removed, or truncated. Although this creates a smaller 

physical code, it is more susceptible to damage.

MicroPDF Reader Init

When a MicroPDF code is created, this property indicates whether a reader initialization symbol is created 

within the code.
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MicroPDF Mode

The MicroPDF Mode property indicates which MicroPDF size enumeration mode is used. Mode values 

range from 0 to 32 with 0 being the smallest code size. Higher mode values allow a larger number of encod-

able data characters and a higher graphical data density. 

MicroPDF Code 128 Emulation

This property causes the barcode scanner to read the code is if it was a Code 128 barcode. Property value 

functions are listed below:

0 = No emulation

1 = Linked C1; Linked UCC/EAN-128 emulation (Transmit ]C1 char)

2 = Unlinked C1; UCC/EAN-128 emulation (Transmit ]C1 char)

3 = C0; Default encoding mode

4 = C2; Code 128 emulation (transmit ]C2 char)

MicroPDF Disable Macro Character

Determines whether macro character substitution is enabled or disabled. The default setting, No, allows 

macro characters.

2D Barcode Fixed Cell Size

When No, overall code size is fixed and individual cells are sized to fit. When Yes, overall code size is deter-

mined by the number of cells and the specified 2D Barcode Cell Size property.

2D Barcode Cell Size

Specify the size of individual cells within the 2D code.

2D Barcode Inverted

When marking dark materials, invert marked/unmarked cells so that white cells are marked while black 

cells are not.

2D Barcode Quiet Zone

Select Yes (default), to mark a quiet zone around inverted 2D codes. This allows cells along the outer edges 

to be properly read by the barcode scanner.

2D Barcode Bitmap

When Yes, 2D codes are marked using a raster scanning technique. Choosing No causes WinMark Pro 

to mark each filled cell as an unfilled circle or square. This procedure works best for small 2D codes and 

greatly reduces cycle times.
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2D Barcode Circle Radius

Reduce the percentage of fill below 100% to reduce cell size and eliminate print growth errors. In 

WinMark Pro v6, this property works on both raster-marked 2D codes (2D Barcode Bitmap property is 

Yes), and on vector-marked 2D codes (2D Barcode Bitmap property is No).

2D Barcode Rounding Percentage

When the 2D Barcode Bitmap property is Yes and cells are marked as vector circles, you can specify a 

rounding percentage. For example, a value of 100% creates circles, 0% causes WinMark to mark square 

cells, and a value of 50% creates rounded rectangles with a corner radius of 1/4 the cell size.

2D Barcode Style

Choose from among Data Matrix (ECC200), QR Code, and Micro QR Code formats.

2D Barcode Shape

When 2D Barcode Style is Data Matrix, choose a square or rectangular code shape.

Error Correction Mode

When 2D Barcode Style is QR Code or Micro QR Code, select one of four error correction levels to ensure 

that code data is readable if the mark is damaged.

Data Input Mode

When 2D Barcode Style is QR Code or Micro QR Code, select Automatic or Manual data input. See the 

Format tab section in Chapter 16, Object properties, for details.

Bitmap Scan Type  

Choose Normal to mark bitmaps as a sequence of microvectors with corresponding Pline delays inserted 

between each segment. Select Continuous to mark at a constant mirror speed and laser power while cycling 

the laser on or off in accordance with bitmap data. When a Grayscale Color Reduction Method is used, 

Bitmap Scan Type is always Continuous.

Note: To enhance image quality, Bi-Directional Raster is automatically disabled when Bitmap Scan 

Type is Continuous or when the Color Reduction Method is Grayscale.

Interseg Break Angle 

Specifies a break angle between two connected polylines. No Interseg Delay is used if the angle between 

two marked polylines is less than the specified break angle. If the polyline angle exceeds the Interseg 

Break Angle, then the Interseg Delay is executed. See Chapter 16, Object properties, for a detailed descrip-

tion and illustration of Interseg Break Angle functionality.
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Off Vector Velocity

Set a non-marking galvanometer velocity when traveling between polyline endpoints. 

Tip: Increasing Off Vector Velocity to several times the marking Velocity typically decreases cycle time 

without affecting mark quality.

Off Vector Resolution

Set a non-marking galvanometer resolution when traveling between polyline endpoints. Off Vector Reso-

lution is not applicable to Flyer/Fenix Flyer; it is valid only for FH Index and Tracker heads.

Spot Marking Style

When set to Yes, the mark path is lased using individual spots instead of a continuous line. Spot spacing is 

proportional to the Resolution setting. Spot Marking Style is primarily used for drilling holes in materials 

or when marking glass to prevent or control micro-fracturing.

Spot Mark Duration

Set the lasing duration for the Spot Marking Style in 1/10 of a millisecond (100 microsecond) intervals.

Lens Spot Size

When using the Spot Tool, the Lens Spot Size property determines the size of the spot displayed on the 

Drawing Canvas. Set Lens Spot Size to Yes to view spots at the actual diameter created by the selected 

focusing lens. For example, when a 200 mm focusing lens is specified, a new spot object will display at a 

diameter of 0.011" (290 µm) instead of the default display size of 0.07" (1.78 mm).
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Device (Flyer) tab (Flyer/Fenix Flyer heads)

The Device (Flyer) tab section includes subsections:

 Interface properties

 Set-up properties

 Tracking properties

 Maintenance properties

 Stand-alone properties

 I/O properties

The “Device” (Flyer) tab (or “Flyer” tab) lists head-specific properties for the currently detected FH Flyer 

marking head or Fenix Flyer Laser Marker.

Interface properties
Interface properties on the Flyer tab (Figure 14-5) include head-specific version information as well as 

communication parameters.

Figure 14-5  “Device” (Flyer) tab – Interface properties

Object Name

Enter a reference name for the device. This name is primarily used when referring to the head in an 

ActiveX application. The factory default name is “Flyerxxxxx”; where xxxxx are the last five digits of the 

head’s unique serial number. The Object Name will always appear as the title of the “Flyer” tab.



WinMark Pro v6.3 User Guide

119Commands & Properties  

Chapter 14 – Application Settings

Current Head File

This property displays the path and filename of the file currently loaded into Flyer/Fenix Flyer RAM.

Interface Type

This read-only property indicates the interface method used to communicate with the currently active 

marking head. In “demo” mode, the Interface Type is None.

Serial Number

This read-only property provides the nine-digit serial number of the currently active Flyer or Fenix Flyer 

head. 

Marking Head Firmware Version

This read-only property displays the current firmware version detected in the Flyer head. 

Flyer U-Boot Version

This read-only property displays the current version of Flyer U-Boot code.

Flyer Kernel Version

This read-only property displays the current version of the Flyer kernel.

Ethernet MAC Address

This read-only property displays Flyer’s factory-set Ethernet MAC (Media Access Control) address.

Use DHCP

When set to Yes, Flyer will contact the network’s DHCP (Dynamic Host Configuration Protocol) Server 

for IP Address, IP Netmask, IP Gateway, and DNS Server IP addresses. By default, Use DHCP is set to No. 

Note: We do not recommend using DHCP. Under the DHCP scheme, Flyer’s IP address and DNS name 

will change each time the head is turned off for a time period that exceeds the DHCP lease.

Ethernet IP Address or Host Name

Enter an IP Address for the Flyer/Fenix Flyer head in the form “xxx.xxx.xxx.xxx”. Click the ellipsis to 

open the pre-formatted Select Ethernet IP Address dialog and enter an Ethernet IP address.

IP Netmask

Enter an IP Netmask address for the associated Ethernet IP Address or Host Name property when Use 

DHCP is set to No. Click the ellipsis to open the pre-formatted Select Ethernet IP Address dialog and enter 

an IP netmask address.
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IP Gateway

Enter a IP Gateway address for the gateway used when the Ethernet IP Address or Host Name address 

resides outside your internal native Ethernet network. Click the ellipsis to open the pre-formatted Select 

Ethernet IP Address dialog and enter an IP gateway address.

DNS Server IP Address

A DNS Server resolves domain names or hostnames into IP addresses. If required in your application, 

enter a DNS Server IP Address. There are two property slots allowed for DNS server addresses. Click the 

ellipsis to open the pre-formatted Select Ethernet IP Address dialog and enter a DNS Server address.

Share Name

When using a network for mark file or font storage, enter the name of the share folder located on the 

specified server. For example, if the path to the folder is “H:\Mark Files\Flyer Share”, enter “Flyer Share” 

(without the quotes) as the Share Name.

Share Server

Enter the IP address of the desired network server or computer where the share folder is located.

Share Domain

Enter a name for the domain to use to connect to a given server or share.

Share Username

Enter a legitimate user name from the list of users with access to the network share folder.

Share Password

Enter the user’s password to gain access to the desired network share.

Share ReadOnly

Set the Share ReadOnly property to No to prevent Flyer from writing data to the network share. When 

set to Yes, Flyer is allowed to write to the share.

Network Share Available

This read-only property indicates that Flyer has successfully mounted the network share using the specified 

share properties.
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Set-up properties 
Flyer set-up properties (Figure 14-6) include focusing lens properties and miscellaneous configuration func-

tions.

Figure 14-6  “Device” (Flyer) tab – Set-up properties

Lens

Select a lens corresponding to the currently installed focusing lens on your Flyer head. Click Lens and 

then click the down arrow to view a drop-down list showing available lenses. When using an FH Flyer 

marking head or Fenix Flyer Laser Marker, select a lens from the FH/Flyer lens group. Choosing a focusing 

lens automatically sets Field Width and Field Height parameters for WinMark Pro’s Drawing Canvas and 

determines the lens correction data set used by the marking head.

In previous WinMark Pro versions, the property values for Field Width and Field Height indicated the 

maximum field extents for a given lens; however, they could be altered by the user. In cases where mark 

objects were inadvertently placed beyond the original field boundary or if field dimensions were changed 

non-proportionally, then incomplete or non-proportional marks would result. For this reason, these prop-

erties are now fixed as read-only properties in WinMark Pro v6.

When opening legacy files with modified field dimensions, WinMark Pro v6 will import mark objects as 

dimensioned and place them at the locations specified in the original drawing, even if they extend beyond 

the actual mark field.

Important Note: In WinMark Pro v6, field sizes automatically update when you choose a new lens 

setting. In previous versions of WinMark, you were required open a New drawing 

after selecting a different lens.
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Tip: If you accidentally create a mark file using the wrong lens specification for your application, sim-

ply select the correct Lens (Tools/General Settings… /“Device”), click Apply and then click OK. 

WinMark Pro v6 automatically generates the correctly scaled Drawing Canvas and any pre-existing 

objects remain at the X-Y coordinates where they were originally placed!

Table 14-1 lists FH Flyer/Fenix Flyer focusing lenses, nominal and maximum field sizes for each lens, typi-

cal working distance, focused spot size and depth of field dimensions. FH Flyer and Fenix Flyer use the 

same focusing lenses as previous FH Index/Tracker marking heads and Fenix Laser Markers.

Table 14-1  Flyer/Fenix Flyer lens specifications

Lens Focal Nominal Field Max. Field Working Distance1 Spot Size Depth of 

Length H×W, mm H×W, mm typical, mm (1/e2), µm Field, mm 

370 mm 198 × 198 241.0 × 297.0  350 ±5 540 ± 10

200 mm 110 × 110 134.0 × 165  190 ±3 290 ± 2.5

125 mm 74 × 74 85.7 × 105.6  128 ±2 180 ± 1.5

125HP2 66 × 66 80.4 × 99.0  125 ±2 180 ± 1.5

 80 mm 27 × 27 33.5 × 41.2  74 ±1 116 ± 0.4

1 The typical working distance is marked on each lens mount. Consult your marking head’s final test report for the actual working 

distance.

2 High-power 125 mm lens for use with lasers 40 W and higher.

New to WinMark v6 is the No Lens property. The No Lens selection is for specialized scientific applications 

where there is no lens mounted on the head. When you choose No Lens and then click Apply, a Working 

Distance property appears. Enter the working distance—in this special case, measured from the bottom 

of the Flyer/Fenix Flyer head to the work surface. Based on Working Distance and galvanometer geom-

etry, new Field Width/Field Height values are calculated for the Drawing Canvas. The No Lens selection 

provides the ability to scan an unfocused beam to the extents of the galvanometer’s mechanical limits for a 

given Working Distance.

Working Distance

Available only when the selected lens is No Lens. In this special case only, enter a Working Distance mea-

sured from the bottom of the Flyer/Fenix Flyer head to the work surface.

Field Width

A read-only property showing the maximum field width of the currently selected focusing lens. 
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Field Height

A read-only property showing the maximum field height of the currently selected focusing lens.

Note: The values for Optimal Field Width and Optimal Field Height properties below indicate the 

optimal field area for marking with a given lens. In previous WinMark Pro versions, these values 

could be changed. In WinMark Pro v6, these values are now fixed as read-only values.

Optimal Field Width

A read-only property showing the nominal field width of the currently specified focusing lens.

Optimal Field Height

A read-only property showing the nominal field height of the currently specified focusing lens.

Bitmap Raster Delay

This head-specific delay is used when marking grayscale images or when Bitmap Scan Type is set to 

Continuous. This delay compensates for the time required for the galvanometer mirrors to reach the com-

manded coordinates for each raster line. Adjust this value as required to eliminate any minute offset of the 

image from its intended mark coordinates.

Keyboard Locked

Lockout the Test Mark membrane pushbutton function on FH Flyer marking heads and Fenix Flyer Laser 

Markers. 

Important Note: On Fenix Flyer markers, only the Test Mark button is locked; the Emergency Off 

pushbutton is never locked out.

FASI Enable

This read-only property displays the status of Flyer’s Fast Acting Safety Interlock (FASI) setting. In Flyer 

heads, the FASI feature is set via an internal DIP switch in the head. When FASI is enabled, the laser 

will not fire unless an active high signal (5 V–24 VDC) is present on input IN3. See the FH Flyer Marking 

Head Operator’s Manual for setup details. Fenix Flyer customers should contact SYNRAD Technical Sup-

port for instructions on enabling the FASI function.

Laser Output is PWM

This read-only property displays the status of Flyer’s PWM/Gate setting. In Flyer heads, the PWM/Gate 

feature is set via an internal DIP switch in the head; for proper marking operation, “PWM” is the correct 

setting. In “Gate” mode, laser output is simply switched on or off at 100% duty cycle (100% power output); 

there is no output power control.
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Switch IO Output 7

On FH Flyer marking heads and Fenix Flyer Laser Markers, you can configure output OUT7 in one of two 

ways—as a normal output controlled by WinMark Pro or as an over-temperature warning. When Switch 

IO Output 7 is No, output OUT7 functions as a normal output and is Set or Cleared by WinMark Pro’s 

SetDigital commands. 

When Switch IO Output 7 is Yes, output OUT7 cannot be activated by SetDigital commands; instead, it 

serves as an over-temperature warning output and activates when the air temperature near Flyer’s power 

amplifiers or CPU rises to 65 °C or above to indicate that additional cooling is required. See your FH Flyer 

Marking Head Operator’s Manual or Fenix Flyer CO
2
 Laser Marker Operator’s Manual for setup details.

Power Adjustment

This global head property increases or decreases the mark file’s Power setting by a fixed percentage to 

compensate for minor output power variations from one laser to another. This property allows the use of 

a single set of mark files by a number of individual Flyer/Fenix Flyer markers without having to create and 

maintain multiple mark files for each laser marker. The default value is 100%. 

Tracking properties
Eleven tracking properties (Figure 14-7) are available when an FH Flyer or Fenix Flyer is the current 

“device”. In WinMark Pro v6, these Flyer tracking properties are stored in the Flyer head because tracking 

properties are likely to vary for each individual installation due to small variances in line speeds and en-

coder setup. See the FH Flyer Marking Head Operator’s Manual or Fenix Flyer CO
2
 Laser Marker Operator’s 

Manual for complete information on configuring a successful tracking application. 

Figure 14-7  “Device” (Flyer) tab – Tracking properties
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Motion Vector

Set the direction of part movement through the marking field. When looking at WinMark’s Drawing Can-

vas, 0° is part movement towards the right, 90° is movement towards the bottom, 180° is towards the left, 

and 270° is part movement towards the top of the Drawing Canvas. 

When Track Marking Object is set to Yes, a motion arrow appears to the left of the Drawing Canvas show-

ing the direction of the currently entered Motion Vector.

Banner Tracking Angle Adjustment

Fine-tune any angular misalignment of the Flyer/Fenix Flyer head to part movement. The angle adjust-

ment is accurate to 0.0001 degrees, but can only provide ±0.15° of adjustment. Any further adjustment 

must be made by physically moving the marking head or parts handling equipment. See WinMark Pro 

Application Note #8, WinMark Pro’s Banner Tracking Functionality (on the WinMark web site at http://

www.winmark.com/products/winmark_ApplicationsNotes.html), for details on banner tracking setup and 

optimization.

Sensor Distance

Use Sensor Distance (the distance, at the moment of part sense, from the centerline of the Marking Win-

dow to the leading edge of the desired mark location on the part) to change the location of the mark on 

the part in the axis of part motion. In WinMark Pro v6, Sensor Distance units correspond to the selected 

Show Units Type—Inches, Millimeters or Centimeters.

Tip:  Position the physical location of the part sensor so that the sensor does not trigger while the Flyer 

head is marking a part. “Line speed too fast – missed start” errors may occur if the ‘start mark’ input 

is triggered while Flyer is marking in tracking mode.

Rising Edge Part Sense

Set to Yes to trigger marking on the rising edge of the part sensor’s output signal. Select No to trigger mark-

ing on the sensor signal’s falling edge. 

Use Quadrature Encoder

Choose Yes to specify a quadrature encoder input where ‘A’ and ‘B’ phases generate direction and part 

movement information. If No, the expected input is a part movement signal from a unidirectional encoder. 

A unidirectional encoder is appropriate in applications where the product transport does not reverse direc-

tion during marking.

Encoder Resolution

Set the number of encoder pulses counted per millimeter of distance traveled by the product conveyor. 

Measurement units are fixed as pulses/mm even when WinMark is configured to display measurement units 

in Inches or Centimeters.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_ApplicationsNotes.html
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Invert Encoder Direction

Toggle Yes/No to invert phasing of a quadrature encoder’s bi-directional output signal so that the actual 

direction of part movement through the mark field is correctly sensed as “forward”. This property allows 

you to invert phasing of the encoder’s ‘A’ and ‘B’ outputs without physically changing field wiring.

Encoderless Tracking

When set to No, XY position data is generated based on input signals from an external position encoder. 

This provides the most accurate mark results because Flyer compensates for any slight deviation in line 

speed.

If products travel through the marking area at a constant velocity and no encoder is installed, select Yes. 

This causes Flyer to generate XY data at a fixed rate determined by the Product Line Speed property.

Important Note: Use Encoderless Tracking only in applications where line speed is tightly regulated. 

Any variation in product speed may result in poor quality marks.

Product Line Speed

When the Encoderless Tracking property is Yes, enter a Product Line Speed value (in the selected units 

of measure) that is equal to conveyor or part velocity. Adjust Product Line Speed as required to fine-tune 

tracking to actual part motion.

Internal Part Trigger

Set to No if an external part sensor is connected to your system. If sensor installation is not feasible (for 

example, in a continuous web process), choose Yes. This causes Flyer to generate internal triggers at the 

distance interval specified by the Part Pitch property.

Note: When Internal Part Trigger is set to Yes, Flyer still accepts external triggers. This feature allows 

you to send an initial external trigger to synchronize mark placement to a specific area on the 

web. After the first externally triggered mark, subsequent marks are lased as the Internal Part Trig-

ger property initiates marking at the Part Pitch interval or when the external trigger (IN0) goes 

active.

Allow External Part Trigger

When Internal Part Trigger is Yes, choose Yes to allow Flyer to accept external part trigger signals on input 

IN0. (for example, an initial external trigger can synchronize marking to a specific location on a continu-

ous web with subsequent marks determined by the Part Pitch value). Choose No to ignore any signals on 

input IN0.

Part Pitch 

When Internal Part Trigger is Yes, enter a Part Pitch in the selected units of measure. Part Pitch (or Mark 

Pitch) determines where the mark is placed on the part and is defined as the distance, in the axis of part 

motion, from the leading edge of the mark on one part to the leading edge of the mark on the following 

part.
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Maintenance properties
Flyer maintenance properties (Figure 14-8) allow you to enable and configure the clearing mark function.

Figure 14-8  “Device” (Flyer) tab – Maintenance, stand-alone, and I/O properties

The clearing mark was developed to help a small segment of customers whose mark consists of long dura-

tions of high frequency, small angle movements. This non-lasing clearing move is designed to redistribute 

lubricant along the galvanometer’s bearing raceway and to reposition ball bearings around the race to pro-

mote a continuous and evenly worn bearing race. For more information about the how the clearing mark 

feature can increase the service lifetime of FH Flyer marking heads and Fenix Flyer Laser Markers, refer to 

SYNRAD Technical Bulletin # 07 or see the FH Flyer Marking Head Operator’s Manual or Fenix Flyer CO
2
 

Laser Marker Operator’s Manual for details.

Clearing Mark On Begin Mark Session

When set to Yes, the Clearing Mark On Begin Mark Session initiates a clearing mark at the start of each 

mark session. The default setting is No. 

Clearing Mark Interval

If Clearing Mark On Begin Mark Session is set to No, then select a Clearing Mark Interval. This enables 

a clearing mark after the specified number of marks has occurred, even across multiple mark sessions. For 

those customers who require a clearing mark, SYNRAD recommends an interval of once every 10,000 

marks. The default is Never.
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Stand-alone properties
Stand-alone properties (shown back in Figure 14-8) configure the Flyer head to function independently of 

a Windows computer. In stand-alone mode, Flyer operates autonomously—communicating to automation 

equipment using discrete I/O signals—with no connection to the WinMark Pro computer. Refer to the 

FH Flyer Marking Head Operator’s Manual or Fenix Flyer CO
2
 Laser Marker Operator’s Manual for complete 

information on stand-alone setup and operation.

Standalone Marking

Set to No (the default setting) when you wish to control Flyer from the WinMark Pro computer—during 

mark file development, for example. When set to Yes, Flyer operates autonomously using mark files stored 

in its Filestore or on a network share.

Ethernet to Serial Converter IP Address

When using an Ethernet-to-serial converter to send serial port data to a Flyer/Fenix Flyer head operating 

in Stand-alone mode, enter the IP address of your converter. When configuring your converter, the con-

verter’s port address must be set to 7963.

External Communications Server

The SYNRAD external Ethernet communications server (SynComm), available on FH Flyer marking 

heads and Fenix Flyer Laser Markers running firmware version 2.59 or above over a network using the 

Modbus® protocol, allows users to access various marking head functions via Flyer’s Ethernet port using one 

of four different protocols: (1) Modbus/IP protocol for interaction with PLCs or other MODBUS network 

devices; (2) Modbus-Asynchronous protocol, a SYNRAD-modified Modbus protocol for peer-to-peer com-

munications; (3) SmartFH protocol, provided as legacy support for customers who have upgraded existing 

FH Smart systems to FH Flyer and wish to continue using custom programs written specifically for FH 

Smart marking heads over Ethernet; and (4) SmartFH-Client protocol, to allow a SmartFH application to 

communicate with Flyer through a serial-to-Ethernet converter. 

Note: To enable the Flyer web page’s Mark, Abort, and Status button functionality, set the External 

Communications Server property to Modbus or Modbus-Async and then set Standalone Marking 

to Yes.

For complete details about using the external Ethernet communications server using the Modbus protocol, 

see WinMark Application Note # 05, as well as sample Visual Basic and Visual C++ code on the WinMark 

web site at: http://www.winmark.com/products/winmark_activexsamples.html.

Modbus User Function

Specify a user function code when operating on a Modbus network. Valid codes are within the range of 

65–72 and 100–110 decimal; the WinMark default value is 67. A Modbus user-defined function code al-

lows you to perform many of the operations necessary for marking head control over a Modbus network.

http://www.winmark.com/products/winmark_activexsamples.html
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SmartFH Client IP Address

In applications where a Flyer/Fenix Flyer unit is replacing an FH Smart marking head communicating 

to control equipment via an RS-232 link, use this property to set the IP address of the customer-supplied 

Ethernet to RS-232 converter.

Use Control File

When set to Yes, Flyer operates in subset of stand-alone mode based on configuration data from a pre-

defined Master Control File. See the Stand-alone Operation chapter in your FH Flyer Marking Head 

Operator’s Manual or Fenix Flyer CO
2
 Laser Marker Operator’s Manual for details.

Standalone Mark Log Level

When operating in stand-alone mode, choose a mark log level. Based on the Standalone Mark Log Level 

chosen, Flyer sends one of five types of information back to WinMark Pro (when connected to the Flyer 

head). From the least amount of logging to the most, the options are: Errors Only, Light, Normal (default), 

Verbose, and Everything. 

Mark On Startup

When operating in stand-alone mode and Mark On Startup is set to Yes, Flyer automatically loads the 

specified Startup Drawing on boot-up and begins the mark session immediately.

Startup Drawing

Flyer loads the specified drawing when operating in stand-alone mode and Mark On Startup is set to Yes. 

The Startup Drawing may reside in Flyer’s Filestore or on a network share.

I/O properties
I/O properties (shown back in Figure 14-8) allow you to configure the Flyer/Fenix Flyer head to interface 

in specific ways with automation equipment.

Enable Abort Input (Input 7)

On FH Flyer marking heads and Fenix Flyer Laser Markers, you can configure input IN7 in one of two 

ways—as a normal input read by WinMark Pro or as an ‘abort marking’ input. When Enable Abort (Input 

7) is Yes, an input signal on input IN7 will halt the current mark session and execute any defined On Abort 

Session events. If set to No, input IN7 functions as a normal automation input.

Enable Marking Head Ready Output (Output 6)

When set to Yes, Flyer/Fenix Flyer output OUT6 is activated when the head is booted up. This action 

signals automation equipment that the head is operational and ready to accept commands.
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15 Drawing properties
The Drawing properties chapter includes sections:

 Tracking tab

 Automation tab

 Marking tab

 All tab

All objects created or imported onto the Drawing Canvas have sets of properties associated with them. 

These properties allow you to define how each specific object is displayed or marked. In addition to objects 

you place on the Drawing Canvas, the Drawing object itself (the .mkh marking file) contains properties 

that allow you to apply global changes for tracking, marking output, or communication with automated 

parts handling equipment. Click on Drawing in the Object List or click the Drawing Canvas itself to select 

the Drawing object.

Drawing properties are classified by category in the Property List and include Automation, Marking, and All 

tabs. Click on the All tab to display all properties for the Drawing object.

Tracking tab
The Tracking tab no longer exists in WinMark v6. Because tracking properties are head-specific, tracking 

properties are now located on the “Device” (Flyer) tab (from the Tools menu under General Settings…). 

These properties are always available whether tracking is enabled or disabled. 

To enable tracking, or banner marking, set the Track Marking Object property (located on the Drawing’s 

Marking tab) to Yes.

Automation tab
Automation events for the Drawing (Figure 15-1) occur at various stages during the marking process as 

illustrated in the Automation Flowchart (refer back to Figure 13-19, Automation flowchart). Certain events 

execute predefined Event Builder commands that perform various automation functions while other events 

exert input/output (I/O) control through marking head I/O bits. These events establish interface proto-

cols between WinMark Pro and your parts handling equipment and are specific to each individual draw-

ing. Refer back to Chapter 10, Marking parts, for a detailed flowchart illustrating the marking automation 

sequence.
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Figure 15-1  Automation tab Drawing properties

On Before Mark Session

Define events you wish to trigger only once prior to the start of part marking in the current mark session. 

Click the ellipsis (…) to open the Event Builder dialog box and view a list of definable events. See Chapter 

17, Event Builder commands, for descriptions of available commands.

Set Digital Before Piece

Set a specific digital output state on any or all output bits prior to each piece being marked. For example, 

your parts handling equipment may require that a specific output bit be set or cleared to indicate the laser 

is off before staging a new part. See Chapter 11, Automation basics, for descriptions of available outputs.

Wait Digital Before Piece

Wait indefinitely for a specific digital input state on any or all input bits before program execution contin-

ues. For example, your parts handling equipment may set or clear a specific input bit to indicate a new part 

is properly positioned. See Chapter 11, Automation basics, for descriptions of available inputs.

Note: Typically, input IN0 and the Wait Digital Before Piece event are used to provide ‘start mark’ sig-

nals to WinMark Pro. When IN0 is specified as Set, WinMark waits until the specified input state 

is met—Set equals a logic high (1) state; Clear equals a logic low (0) state. WinMark continues 

executing the automation loop only after the specified input state is logically True.

Tip: When using the Fast Acting Safety Interlock (FASI) feature, configure inputs IN0 and IN3 as Set. 

This forces WinMark to wait for both the ’start mark’ signal (IN0) and the FASI enable signal 

(IN3) to be active before marking. Waiting for IN3 when FASI is enabled prevents unmarked parts 

from sequencing through the system.
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Warning

serious 

personal 

injury

When the Wait Digital Before Piece Automation event is used to 

provide a ‘start mark’ signal, then Wait Digital After Piece must be 

used to verify that the ‘start mark’ signal has changed state. Failure to 

do so may cause unintended laser firing as WinMark Pro loops back 

through to the start of the automation sequence.

On Before Mark Piece 

Define events you wish to trigger once before each piece is marked. Click the ellipsis (…) to open the 

Event Builder dialog box and view a list of definable events. See Chapter 17, Event Builder commands, for 

descriptions of available commands.

Set Digital Before Mark

Set a specific digital output state on any or all output bits immediately before each piece is marked. For 

example, your parts handling equipment may require that a specific output bit be set or cleared to indicate 

the laser is on and marking. See Chapter 11, Automation basics, for descriptions of available outputs.

Important Note: WinMark Pro fires the laser immediately after the Set Digital Before Mark com-

mand is executed.

Wait Digital After Piece

Wait indefinitely for a specific digital input state on any or all input bits before program execution contin-

ues. For example, your parts handling equipment may set or clear a specific input bit to indicate a new part 

is being positioned. See Chapter 11, Automation basics, for descriptions of available inputs.

Note: Typically, input IN0 and the Wait Digital After Piece event are used to provide the ‘end mark’ 

signal to WinMark Pro. When IN0 is specified as Clear, WinMark waits until the specified input 

state is met—Set equals a logic high (1) state; Clear equals a logic low (0) state. WinMark contin-

ues executing the automation loop only after the specified input state is logically True.

Tip: To minimize throughput delays, use Set Digital Before Mark to send a “laser on” signal to your 

automation controller. A signal at this step means that WinMark Pro has processed the ‘start mark’ 

signal. Your controller can then set the desired ‘end mark’ input state to ensure that there is no 

delay at the Wait Digital After Piece step after marking is complete.

On After Mark Piece 

Define events you wish to trigger once after each piece is marked. Click the ellipsis (…) to open the Event 

Builder dialog box and view a list of definable events. See Chapter 17, Event Builder commands, for descrip-

tions of available commands.
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Set Digital After Mark

Set a specific digital output state on any or all output bits immediately after each piece is marked. For 

example, your parts handling equipment may require that a specific output bit be set or cleared to indicate 

the laser is off before staging a new part into position. See Chapter 11, Automation basics, for descriptions 

of available outputs.

On After Mark Session

Define events you wish to trigger only once after all marking in the current session is complete. Click the 

ellipsis (…) to open the Event Builder dialog box and view a list of definable events. See Chapter 17, Event 

Builder commands, for descriptions of available commands.

Note: A mark session ends when the number of parts marked equals the Mark Count value. In automat-

ed systems where Mark Count is zero (0) and marking proceeds continuously as directed by ‘start 

mark’ inputs, the mark session does not end, so On After Mark Session events are not executed.

On Abort Session

Define events you wish to trigger only once if the mark session is aborted or halted by the user (by press-

ing the ESC key, for example). Click the ellipsis (…) to open the Event Builder dialog box and view a list of 

definable events. See Chapter 17, Event Builder commands, for descriptions of available commands.

Marking tab
Marking properties for the Drawing (Figure 15-2) perform global drawing transformations such as position-

ing or scaling your drawing on the part. Drawing transformations only affect actual marking output; the 

Drawing Canvas display does not change. 

Figure 15-2  Marking tab Drawing properties 

Track Marking Object

Select Yes to mark moving parts “on-the-fly” with the Tracker feature or to enable Banner Marking. 

Choose No to mark stationary objects in Index (static) mode.
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Banner Marking

When Track Marking Object is enabled (Yes), select Yes to track and mark objects that extend beyond the 

normal extents of the Drawing Canvas. See the WinMark Pro web site at http://www.winmark.com/prod-

ucts/winmark_ApplicationsNotes.html and download Application Note #8, WinMark Pro’s Banner Track-

ing Functionality, that describes how to configure a Flyer/Fenix Flyer marking system for banner tracking.

Banner Window Interval

When Banner Marking is Yes, enter a length for the repeating banner tracking window. Ideally, the Ban-

ner Window Interval value should be no more than 50% to 75% of the focusing lens’ maximum mark size.

Field Offset X

Enter the amount of offset required in the X-direction when marking. The drawing is offset from the trans-

formation origin point specified by the Field Transform Org X and Field Transform Org Y properties.

Field Offset Y

Enter the amount of offset required in the Y-direction when marking. The drawing is offset from the trans-

formation origin point specified by the Field Transform Org X and Field Transform Org Y properties.

Field Rotation

Enter the amount of drawing rotation required around the transformation origin when marking. Field 

Rotation is accurate to two decimal places (0.01°). The drawing is rotated from the transformation origin 

point specified by the Field Transform Org X and Field Transform Org Y properties.

Note: In WinMark Pro versions 6.3.0.7328 and above, when the Drawing’s Field Rotation is set to other 

than 0.00 degrees, the Mark Preview window now displays the actual mark rotation referenced to 

the fixed Drawing Canvas display.

Field Transform Org X

Specify the transformation X-origin required when offsetting, rotating, or scaling a drawing. The default X 

origin point is 0.0000 inches.

Field Transform Org Y

Specify the transformation Y-origin required when offsetting, rotating or scaling a drawing. The default Y 

origin point is 0.0000 inches.

Field Scale X

Specify the percentage of X-axis field scaling around the transformation origin.

Field Scale Y

Specify the percentage of Y-axis scaling around the transformation origin.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_ApplicationsNotes.html
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Note: If Field Scale X and Field Scale Y are set to different values, the non-proportional field scaling 

will cause mark distortion.

Note: In WinMark Pro versions 6.3.0.7328 and above, Field Scale X and Field Scale Y values can be 

fine-tuned to accuracies of 0.01%.

Ask Mark Count

If set to Yes, the Piece Count dialog box appears before marking begins. This dialog prompts the operator to 

enter the total number of marks required during the current mark session.

Mark Count

Specify the number of marks required during the mark session. If zero (0) is entered, marking continues 

under the control of event automation indefinitely until halted by pressing the ESC key. 

Important Note: When Mark Count is set to zero (0), you must configure WinMark Pro’s automation 

and I/O features to wait for ‘start mark’ and ‘end mark’ signals from parts handling 

equipment so that marking continues only when an indication is received that 

another piece is in position and is ready to mark.

No Cross

Select Yes to prevent the beam from crossing a previously marked polyline. Use this feature to minimize 

hot spots on low threshold materials like plastics in situations where polylines intersect or cross each other.

No Cross Gap

If No Cross is set to Yes, enter a No Cross Gap dimension. No Cross Gap specifies the total non-mark-

ing gap across the intersected polyline. 

Invert X Axis

Invert marking output along the horizontal axis.

Invert Y Axis

Invert marking output along the vertical axis.

All tab
All applicable drawing properties from Automation and Marking tabs are included on this single tab.
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16 Object properties
The Object properties chapter includes sections:

 Special tab

 Automation tab

 Marking tab

 Format tab

 All tab

All objects created or imported on the Drawing Canvas have sets of properties associated with them. These 

properties allow you to define how each specific object is displayed and marked. Select an object on the 

Drawing Canvas or highlight an object name in the Object List to review or modify its properties. Object 

properties are classified by category in the Property List and include Special, Automation, Marking, Format, 

and All tabs.

Special tab
Special object properties (Figure 16-1) apply to objects contained within the drawing.

Figure 16-1 Special tab Object properties 

Object Name

Enter a specific descriptive name for each object created or imported onto the Drawing Canvas. 
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Automation tab
Automation object properties (Figure 16-2) apply only to text, 1D, and 2D bar code objects contained 

within the drawing. These properties automate the serialization or coding of parts.

Figure 16-2 Automation tab Object properties 

Auto Text Type

Select the automated text input source from among None, Serial Number Text, Date Code Text, Disk File 

Text (Sequential or Fixed), Serial Port Text, User Entry Text, From Another Object, or UID/Composite. Your 

choice of automated input determines which associated properties appear on the Automation tab. 

Note: Some automated text and barcode captions are updated on the Drawing Canvas when the object 

is selected or deselected. Dates, times, and From Another Object sources are updated. Serial num-

bers are updated if Save Last Serial is Yes. Serial port and disk file text is not updated until the 

source is read during the mark sequence.

None

No automation is performed on the text object. The Text Caption is marked as displayed in the Text 

Caption Editor dialog box.

Serial Number Text

Serialize numerals, alphabetic characters, or alphanumeric strings entered as the Text Caption. 

When Serial Number Text is selected, the following serialization sub-properties appear on the Au-

tomation tab: Serial Number Delta, Serial Number Mask, Serial Piece Step, Hexadecimal Count, 

Ask Starting Serial, Save Last Serial, Save Serial Name, Current Saved Value, and Clearing 

Interval. 

Serial Number Delta

Choose a value with which to increment (positive values) or decrement (negative values) the 

serial number string before, or after, each mark.
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Note: Only alphanumeric characters are serialized. Non-alphanumeric characters (“@”, “*”, 

etc.) remain as entered in the string.

Serial Number Mask

Specify which alphanumeric characters in the serial number string should be Serialized (the 

default setting) or Fixed. From the drop-down list, select a placeholder position and then 

choose Serialize or Fixed.

Tip: Non-alphanumeric characters are ignored by the serialization protocol so that characters such as 

dashes (–), colons (:), etc need not be Fixed by Serial Number Mask.

Serial Piece Step

Specify how many pieces (parts) to mark before the serial number is incremented or decre-

mented.

Hexadecimal Count

Choose Yes to increment/decrement serial numbers using the hexadecimal (base 16) number 

system. Choose No to count in decimal (base 10).

Ask Starting Serial

When set to Yes, a dialog box opens at the beginning of each mark session prompting the 

operator to enter a starting serial number.

Save Last Serial

Restore the last serial number marked when the next mark session begins.

Save Serial Name

When Save Last Serial is Yes, use Save Serial Name to create a unique name for storing the 

Save Last Serial number. The actual number is stored in the computer’s System Registry and so 

is not accessible by programs other than WinMark Pro. The default name is “Slot-0”.

Important Note: If more than one mark file exists for serializing parts, each file must 

specify a different Save Serial Name to prevent serial values from being 

overwritten.

Note: In Flyer’s stand-alone control mode (when mark files are saved in the Filestore), the 

Save Serial Name property stores the Save Last Serial number in Flyer’s non-vola-

tile memory.
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Current Saved Value

Contains the current Save Last Serial number value. When creating a mark file, the initial 

value entered should contain as many placeholder zeros as the maximum number you wish to 

serialize before rolling back over to zero. For example, if only one zero is entered for Current 

Saved Value, then mark one =1, mark two = 2...... mark nine = 9, mark ten = 0, and mark 

eleven = 1.

Important Note: When serializing text and Save Last Serial is set to Yes, the character 

string entered for Current Saved Value, not Text Caption, is used for 

marking. 

Clearing Interval

The Clearing Interval property allows you to select a time, to the minute, when the current 

serial number is reset to zero. The serial number can be reset None (never), Hourly, Daily, 

Weekly, Bi-Weekly, Monthly, Quarterly, Bi-Annually, or Yearly.

When Clearing Interval is set to other than None, the following Clearing Interval sub-proper-

ties appear on the Automation tab: Clearing Month, Clearing Day of Month, Clearing Day of 

Week, Clearing Hour, and Clearing Minute. Not all sub-properties are available for all Clear-

ing Interval categories.

Clearing Month

Enter the month (January–December) in which to reset the current serial number.

Clearing Day of Month

Enter the day of the month (1–28) in which to reset the current serial number.

Clearing Day of Week

Enter the day of the week (Sunday–Saturday) in which to reset the current serial num-

ber.

Clearing Hour

Enter the hour (0–23) in which to reset the current serial number.

Clearing Minute

Enter the minute (0–59) in which to reset the current serial number.

Date Code Text

Mark standard or customized date and time formats. When Date Code Text is selected, the fol-

lowing date code sub-properties appear on the Automation tab: Assign Date Format, Time Offset: 

Days, Time Offset: Hours, and Time Offset: Minutes.
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Assign Date Format

Click the ellipsis (…) to select or define specific date code formats. From the Date Format 

Customization dialog box, select from among American Standard, European Standard, Week-Year, 

or Julian formats or click the Add Format button to create an unlimited number of custom date 

formats. When coding by shift, the Define Shifts button allows you to customize shift start and 

shift end hours as well as shift codes.

Note: In WinMark Pro v6, custom date formats are saved in the mark file as well as in the 

development computer’s System Registry. This prevents an “undefined” format error 

from occurring when files with Custom Date Formats are loaded on different comput-

ers or on a Flyer head operating in stand-alone mode.

To create a custom date format:

1 In the Date Format Customization dialog box (Figure 16-3) click the Add Format button.

Figure 16-3  Date Format Customization dialog box 

2 If desired, type a descriptive name in the Format Name box.

3 Browse the Available Format Commands box for available date or time formats.

4 Double-click the desired format commands or click in the Format Definition String box 

and type in commands to create a custom format string.

5 When done, click the Close button.
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Tip: The percentage sign (%) is used by WinMark Pro to indicate a pre-defined date format command. To 

add a percentage sign to your date format, type %%.

Tip: The Example Date box shows how the Format Definition String will look when marked. You can add 

spaces, dashes, or other fixed alphanumeric characters within the string by typing characters be-

tween definitions in the Format Definition String box.

Time Offset: Days

Specify a positive or negative offset from the current day (–9999 to 9999); for example, when 

printing expiration dates.

Time Offset: Hours

Specify a positive or negative offset from the current hour (–23 to 23); for example, when 

printing expiration dates or fine-tuning shift code changes.

Time Offset: Minutes

Specify a positive or negative offset from the current minute (–59 to 59); for example, when 

printing expiration dates or fine-tuning shift code changes.

Disk File Text (Seq)

Automatically opens and reads a multi-line disk file (saved in a .TXT format). Beginning with the 

first line of text, each loop through the mark session causes WinMark to assign the next (sequential) 

line of text in the file as the text object’s Text Caption. When Disk File Text (Sequential) is selected, 

the following disk file sub-properties appear on the Automation tab: Text Source Filename and Auto 

Text File Wrap.

Important Note: Because WinMark Pro reads the entire file when it is initially opened, you 

cannot update the file during the current mark session.

Note: When using Disk File Text (Seq) input, each text string must end with a Carriage Return 

(CR) character to indicate ‘end of data’.
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Tip: About Flyer/Fenix Flyer’s Circular File feature when Auto Text Type is Disk File Text (Seq) or Disk 

File Text (Fixed):

FH Flyer marking heads and Fenix Flyer Laser Markers have the ability to sequentially read up to 

ten specially named data (.TXT) files when AutoText Type is either Disk File Text (Seq) or Disk 

File Text (Fixed). This feature provides the ability to update network data files using a third-party 

software process while WinMark is marking another data file.

To setup this Circular File feature, simply create one to ten data files using the format: 

“filename.0.txt”, “filename.1.txt”, …, up through “filename.9.txt” (without quote marks); where 

filename can be any name, but must be the same name for all ten files. Enter the name of the first 

file in the list for Disk File Text’s Text Source Filename property. After reading all lines of data in 

“filename.0.txt”, Flyer will open “filename.1.txt” and continue marking. If Flyer does not see the 

next logical index in the series, it loops back to “filename.0.txt” and continues marking. Note that 

while WinMark has a file open for marking, you can use a separate third-party process to update 

closed files without interfering in the mark process.

Text Source Filename

Specify a path and filename pointing to the location of the text source file to read. 

The format of the text source path depends on whether the file will be accessed by WinMark 

Pro, or a custom ActiveX application, (Windows OS) or by a Flyer head operating in Stand-

alone mode (Linux OS). For Windows operations, pathnames must be written using a 

backslash (\) character; for example, C:\MarkFileFolder\TextFile.txt. For Linux operations, 

pathnames must be written using a forward slash (/) character; for example, /network/MarkFile-

Folder/TextFile.txt.

Auto Text File Wrap

If set to Yes, WinMark Pro reads each item in a sequential disk file and after the last item is 

read, wraps back around to the beginning item. Use Mark Count (on the Marking tab) to 

specify the number of iterations through the file. Because one line of text is read on each pass, 

each line in the disk file must end with a Carriage Return (CR) to provide the ‘end of data’ 

delimiter.

Serial Port Text

(For Flyer/Fenix Flyer heads operating in WinMark control mode) Automatically open, read, and 

mark a text string from your computer’s serial communications port. Each time the specified commu-

nications port is read, serial port data is assigned to the text object’s Text Caption. When Serial Port 

Text is selected, the following serial port sub-properties appear on the Automation tab: Text From 

Com Port, Com Port Timeout, and Close Comport After Read.
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Note: When using Serial Port Text input, the text string must end with a Carriage Return (CR) 

character to specify ‘end of data’. For multi-line text strings, use a Line Feed (LF) character 

to force a line wrap and then end the last line with a Carriage Return.

Text From Com Port

Specify which communications port on your computer contains the incoming serial text string. 

Click the Text From Com Port property and then click the down arrow to see a list of avail-

able com ports detected on your computer. 

Click the ellipsis (…) to open the Serial Port Settings dialog. This dialog allows you to view and 

modify WinMark’s serial port settings (Figure 16-4) as required by your serial communications 

network. WinMark Pro v6 supports serial baud rates between 2400–115200 baud.

Figure 16-4  Serial Port Settings dialog box

Com Port Timeout

Set the communications port timeout period in milliseconds. The mark will fail if information 

is not available at the port within the specified time. A timeout value of –1 forces WinMark 

Pro to wait indefinitely until a message is received or the ESC key cancels the mark session.

Close Comport After Read

The recommended (default) setting is No, which means the computer’s com port is opened 

during the initial com port read and remains open throughout the mark session. Choosing Yes 

forces the com port to close after each read operation in cases where subsequent serial data 

must be ignored. The com port is then reopened when the next serial port read is commanded.

User Entry Text

Prompt the operator to manually enter a text string for each piece in a mark session. When User 

Entry Text is selected, the following user entry sub-property appears on the Automation tab: Text 

User Prompt.
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Text User Prompt

Create a customized dialog box prompting the operator to enter the required mark data.

Disk File Text (Fixed)

Open, read, and mark a text string from a predefined disk file. Each time the file is read, the text 

string in the file is assigned as the text object’s Text Caption. When Disk File Text (Fixed) is selected, 

the following disk file property appears on the Automation tab: Text Source Filename.

Note: When using Disk File Text (Fixed) input, the text string must end with a Carriage Return 

(CR) character to specify ‘end of data’.

Text Source Filename

Specify a path and filename pointing to the location of the text source to read.

The format of the text source path depends on whether the file will be accessed by WinMark 

Pro, or a custom ActiveX application, (Windows OS) or by a Flyer head operating in Stand-

alone mode (Linux OS). For Windows operations, pathnames must be written using a 

backslash (\) character; for example, C:\MarkFileFolder\TextFile.txt. For Linux operations, 

pathnames must be written using a forward slash (/) character; for example, /network/MarkFile-

Folder/TextFile.txt.

Tip: Although only one line of text is read from the file, the specified text file can be updated between 

marks by external processes.

From Another Object

Assign a text caption for the currently selected Text, Barcode, or 2D Barcode object from another 

Text, Barcode, or 2D Barcode object. Use From Another Object to ensure that variable text data 

shared between two objects remains synchronized throughout a mark session. When From Another 

Object is selected, the following object reference sub-property appears on the Automation tab: As-

sign From.

Note: When an object’s Auto Text Type is set to From Another Object, the Execute Auto Text 

When property is disabled; mark data is always assigned from the reference object before 

each mark.

Note: WinMark Pro will not link to reference objects in an array when the referenced object’s 

Auto Text Within Array property is Yes. This occurs because each element in the array of 

reference objects is serialized and marked independently before the selected object or array 

of objects is marked. If these conditions are present, WinMark Pro will prevent the mark 

session from opening and display an error dialog.
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Assign From

Assign or copy Text Caption data from the referenced Text, Barcode, or 2D Barcode object. Use 

the Assign From property to link variable data between two or more text-based entities.

Tip: If the referenced object’s Execute Auto Test When Before Mark/After Mark property is changed, 

WinMark Pro automatically changes the mark order of selected and referenced objects as required 

to ensure that Text Caption data remains synchronized. These automatic changes to mark order 

are recorded in the Text Caption Mark Log at the beginning of a mark session. Where mark order is 

important, as in some tracking applications, select the reference object and choose the appropriate 

Execute Auto Test When Before Mark/After Mark property value to force the desired mark order.

UID/Composite

Create a Unique Identification (UID) 2D code, composite 2D code, or composite text string. For 

UID codes, choose a pre-defined UID format or add a new format to fit your specific requirement. 

Use UID/Composite to create a composite 2D code or text string; for example, an object that com-

bines both an auto-updating date code string and an auto-serializing serial number string in a single 

2D code or text object. When UID/Composite is selected, the following object reference sub-proper-

ty appears on the Automation tab: Assign UID/Composite.

Assign UID/Composite

Assign 2D code data from a pre-defined UID format definition or create a custom UID or 

composite format string to mark. See WinMark Pro Application Note #6, WinMark Pro’s UID/

Composite Code Functionality, (at http://www.winmark.com/products/winmark_Applications-

Notes.html) for details and a short tutorial on creating UID or composite 2D codes. 

Auto Text Within Array

Enable the desired automation action within any array elements that exist. Choose Yes to mark each array 

element with a different value. Choose No to mark all array elements with the same initial value.

Auto Text Without Marking

The default setting, No, prevents non-marking autotext objects (text, barcodes, and 2D codes) from updat-

ing or serializing during a mark session (maintaining consistency with prior WinMark Pro program logic 

and legacy mark files).

When non-marking autotext objects are linked to UID/Composite codes, this property automatically de-

faults to Yes, so these non-marking “placeholder” data strings can pass updated caption data to the marked 

object.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_ApplicationsNotes.html
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Tip: To use the linked object to your UID/Composite code as marked, human-readable text, position the 

text object(s) as required, set Auto Text Without Marking to No and then set Mark Object (on the 

Marking tab) to Yes.

Execute Auto Text When

Set the desired automation action to occur either before or after the piece is marked. For example, if your 

starting serial number value is “000” and Execute Auto Text When is Before Mark, serialization occurs 

before the mark and the first value marked is “001”.

Note: When an object’s Auto Text Type is set to Date Code Text, the Execute Auto Text When property 

is disabled; date code data is always read from the computer’s clock immediately before each mark.

Note: When the selected object’s Auto Text Type property is set to: From Another Object, the Execute 

Auto Text When property is hidden and is replaced by the Assign From property. This occurs 

because the selected object derives its variable Text Caption data from the referenced object. 

Marking tab
Marking object properties (Figure 16-5) apply to objects contained within the drawing and specify how a 

particular object will be laser marked. Most properties are common to all objects however; some properties 

apply only to specific types of objects, like text objects or bar code objects. 

Figure 16-5  Marking tab Object properties 

Mark Object

Choose Yes to mark the current selection set. When No is selected, marking of selected objects is dis-

abled. Although marking properties are hidden when marking is disabled, property values are retained by 

WinMark Pro.
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Tip: The Boolean Mark Object property is often used in conjunction with MatchDigitalState Event 

Builder automation so that a True input condition causes the specified object or group to mark. Ob-

jects/groups are not marked (Mark Object set to No) if the corresponding input condition is False.

Tip: It is often useful to have marking instructions or reminders placed on the Drawing Canvas in view 

of the machine operator. Simply enter the desired instructional text, then size and position the text 

object. With only the text object selected, set Mark Object to No. Although visible, this text object 

will not mark and its presence on the Drawing Canvas does not affect mark cycle times.

Mark Passes

Specify the number of passes required to mark the selected object. On heat-sensitive materials, like plastics 

or glass, several low-power passes may be preferable to a single high-power pass.

Mark Pass Delay

When Mark Passes is greater than one, enter a delay, in milliseconds, between each pass.

Wobble properties

Wobble properties allow you to mark thick lines or strokes by “wobbling” the laser beam back and forth. 

Wobble lines are essentially thickened by marking shorter lines at right angles to the intended line seg-

ment. Line width is determined by the value specified for Wobble Thickness and line “resolution” is de-

termined by Wobble Step Size. Although wobble provides the ability to create wide vector strokes, there 

is a significant increase in cycle time. Wobble is available for polyline, circle, stroke text, and imported 

vector objects.

Note: WinMark Pro imports some vector graphic files as a “Polyline Set” that must be exploded 

(Objects/Explode) into individual polylines before being “wobbled”.

Wobble On

Choose Yes to mark thick line strokes by “wobbling” the laser beam. 

Wobble Thickness

Specify the “wobble” width of line segments.

Wobble Step Size

Enter a specific distance between “wobble” steps. 
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Tip: The minimum Wobble Step Size should be greater than or equal to the spot size of the focused 

beam. In most cases, entering a Wobble Step Size smaller than the lens’ spot size increases cycle 

time without producing a visible difference in mark quality.

Wobble Style

Choose one of three wobble styles. Standard indicates that each wobble line is marked unidirection-

ally from the same side of the polyline. Bidirectional forces WinMark to mark wobble lines alternating 

from side to side and is the quickest of the three wobble styles. The Sawtooth style provides addition-

al “fill’ by marking a diagonal line from the bottom of one wobble line to the top of the next wobble 

line.

Note: Although the mark is created as specified, there is no visible change to ‘wobbled’ polyline 

objects on the Drawing Canvas.

Velocity

Specify a galvanometer velocity when marking the selected object. When choosing Velocity values near 

the upper or lower limits, delay property values may require adjustment to prevent hot spots or “tailing”. 

WinMark Pro limits Velocity values to a maximum of 300 inches per second (7620 mm/s).

Note: WinMark Pro allows a maximum marking Velocity of 300 inches per second (IPS); however, for 

Flyer/Fenix Flyer applications using the 80 mm focusing lens, Flyer limits actual optical scanner 

speed to a maximum value of 195 IPS (4953 mm/s) due to the 80 mm lens’ small field size and 

angle of deflection.

Power

Enter a percentage of laser power required to mark the selected object. In WinMark Pro v6, you can 

change Power in 0.1% steps.

Tip: Typically, a value of 70–75% equals the laser’s specified output power rating.

Min Power Threshold (Grayscale bitmap objects only)

For grayscale bitmaps, set a minimum power level. This value corresponds to the level of white in the gray-

scale image (when Bitmap Inverted is No). For example, if Min Power Threshold is 20.5% and Power is 

65%, then 256 levels of gray are marked with white pixels marked using 20.5% of laser power and black 

pixels marked using 65% of laser power. In WinMark Pro v6, you can change Min Power Threshold in 

0.1% steps.
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PWM Frequency

Set a Pulse Width Modulation (PWM) frequency for each individual mark object in the drawing. FH Flyer 

marking heads and Fenix Flyer Laser Markers support PWM frequencies ranging from 1 to 50 kHz. Higher 

frequencies provide smoother lines while lower frequencies provide greater depth of modulation (greater 

optical output for a given Power—duty cycle percentage).

Resolution 

Enter a marking resolution for the selected object. Units of measure are in microvectors per inch, which is 

roughly analogous to the more common dots per inch (DPI) terminology.

Important Note: In WinMark v6, Polyline Set and unfilled Text, Polyline, and Circle objects no longer 

have a Resolution property (unless Spot Marking Style is Yes). Flyer/Fenix Flyer 

heads mark these objects at the highest resolution possible for a given lens. 

Note: Imported bitmap images are now resized according to the Resolution setting specified on the 

Tools/General Settings…/Object Defaults tab. Previously, WinMark Pro increased or decreased 

bitmap image size corresponding to a fixed bitmap resolution of 600 DPI. WinMark Pro does not 

resample bitmap images, but rather resizes them to preserve the image’s total pixel count. For 

example, the overall dimensions of a 96 DPI image imported into WinMark at 300 DPI are auto-

matically resized to 32% of the original height and width.

Tip: In order to import a bitmap image at full scale, WinMark’s Resolution setting must match the file’s 

resolution. For example, to import a file saved at 225 DPI, first check that the Resolution property 

on the Tools/General Settings…/Object Defaults tab is set to 225. 

Delay properties

Because optical scanners require a finite amount of time to overcome mirror inertia and then move the 

mirror into position, optical scanner movement tends to lag slightly behind WinMark’s software com-

mands. Delay properties help “fine tune” the marking of each object in your drawing file. 

Because Flyer’s optical scanners exhibit a quicker response time than previous FH Series marking heads, 

you may need to adjust delay settings and Off Vector Velocity values in your existing mark files. If delay 

related marking problems occur when using WinMark Pro v6, adjust marking delays by performing the 

following steps:

1 Select an object or group of related objects on the Drawing Canvas.

2 In the Property List, click the Marking tab.

3 Scroll down to the delay section shown in Figure 16-6.
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Figure 16-6  Delay settings

4 Write down your current delay settings for the problem objects.

5 Compare your delay settings with WinMark’s default parameters for Flyer heads shown in Table 16-1:

Table 16-1  Default delay values

Delay Flyer Default FH Index/Tracker Default

Pline Start Delay      0 µs  100 µs

Pline End Delay  200 µs  450 µs

Interseg Delay    75 µs  350 µs

Off Vector Delay  250 µs  300 µs

6 Review Pline Start Delay, Pline End Delay, Interseg Delay, and Off Vector Delay descriptions on 

the following pages.

7 Make adjustments to the appropriate delays, ensuring that only one delay is adjusted at a time in 

order to avoid confusion and obtain the best trade-off between marking quality and marking speed.

Pline Start Delay 

Use Pline Start Delay to minimize hot spots at the beginning of a polyline or the beginning of a 

series of polylines. See Figure 16-7 for illustrations of Pline Start Delay effects. Increase the delay to 

reduce dwell (hot spots) at the beginning of each polyline. If too large a delay is set, the beginning 

of a polyline may be shortened or shapes may not close properly. Pline Start Delay affects only the 

beginning of non-connected polylines. 
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Important Note: To compensate for Flyer’s faster galvanometers, WinMark provides the ability 

to enter negative Pline Start Delay values. If polylines are shortened or shapes 

not closed when Pline Start Delay is at its default (0 µs) delay value, enter a 

negative value. For example, when marking alumina ceramic at high speeds, 

begin testing with a Pline Start Delay value of –1000.

Correct Use of

Pline Start Delay

Pline Start Delay

Too Long

Pline Start Delay

Too Short
or

Correct Use of

Pline End Delay
orPline End Delay

Too Long

Pline End Delay

Too Short

Figure 16-7  Pline Start Delay settings 

Pline End Delay 

Pline End Delay maintains “beam on” time at the end of a series of polylines to ensure that the cur-

rent polyline is completed before moving to the next polyline vector. See Figure 16-8 for illustrations 

of Pline End Delay effects. Too much delay will create dwell, or hot spots, at the end of polylines; 

too little delay may cause short or incomplete polylines to be marked.

Figure 16-8  Pline End Delay settings 
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Interseg Delay 

Interseg Delay sets a delay between marking connected polylines where the end point of the current 

polyline is the start point of the next polyline in the object. Interseg Delay increases the “sharpness” 

of points where polylines connect. See Figure 16-9 for illustrations of Interseg Delay effects. Too 

much delay creates dwell, or hot spots, at the end of polylines; too little delay causes corners to be 

rounded.

Correct Use of

Interseg Delay
or Interseg Delay

Too Short

Interseg Delay

Too Long

Figure 16-9  Interseg Delay settings 

Off Vector Delay 

Off Vector Delay sets a proportional delay during all laser off-vector moves to eliminate “tails” when 

moving between non-connected polylines. See Figure 16-10 for illustrations of Off Vector Delay 

effects. Too much delay will create a good mark, but marking throughput (cycle time) may be unac-

ceptably slowed; too little delay may cause “tails”, or leading marks, at the beginning of polylines.

Correct Use of

Off Vector Delay
or Off Vector Delay

Too Short

Off Vector Delay

Too Long (Causes

Long Cycle Times)

Figure 16-10  Off Vector Delay settings 
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Bi-Directional Raster (not available for unfilled arc or polyline objects)

Set Bi-Directional Raster to Yes to reduce cycle time when marking a filled (raster) image. If set to No, 

laser marking of bitmap or filled images is done in only one scan direction.

Note: When Bitmap Scan Type is set to Continuous (or when marking grayscale images), Bi-Directional 

Raster is disabled; marking occurs in only one direction although you can still specify a Raster 

Scan Direction. 

Interseg Break Angle

Specifies a break angle between two connected polylines. No Interseg Delay is applied when the angle be-

tween two marked polylines is less than the specified angle. If the angle exceeds the Interseg Break Angle, 

then the Interseg Delay value is used. Figure 16-11 shows the results of marking two different angles using 

the default Interseg Break Angle of 30 degrees.

Angles are less than the specified 

Interseg Break Angle. No Interseg 

Delay is used.

Angles are greater than the specified 

Interseg Break Angle. Interseg Delay is 

used to prevent hot spots or rounded corners.

90° angles

25° angles

Figure 16-11  Interseg Break Angle settings 

Off Vector Velocity 

Set a non-marking velocity for galvanometers to travel between polyline endpoints.

Note: WinMark Pro allows a maximum marking Off Vector Velocity of 600 inches per second (IPS); 

however, because of lens field size and deflection angles, the Flyer head limits actual optical scan-

ner speed to the following values: 80 mm lens – 195 IPS; 125 mm lens – 300 IPS; 200 mm lens – 

480 IPS; 370 mm lens –600 IPS. Increasing Off Vector Velocity beyond these values may result in 

degraded mark quality.

Off Vector Resolution (not applicable with Flyer/Fenix Flyer heads)

Enter a non-marking resolution for the selected object. Units of measure are in microvectors per inch, 

which is roughly analogous to the more common dots per inch (DPI) terminology.

Important Note: Off Vector Resolution is fixed for FH Flyer and Fenix Flyer markers; these heads use 

the highest resolution possible for a given lens. 
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Spot Marking Style

When set to Yes, the mark is made using individual spots instead of a continuous line. Spot spacing is 

proportional to the Resolution setting. 

Tip: The Spot Marking Style property is primarily used when marking glass to prevent fracturing or 

when marking very small vector-style 2D codes. 

 

To mark ‘spot-style’ (one laser spot per cell) 2D codes with Flyer/Fenix Flyer heads using WinMark 

Pro v6, select the 2D code and, on the Format tab, set 2D Barcode Bitmap to No, 2D Barcode 

Circle Radius to 0%, and then on the Marking tab, set Spot Marking Style to Yes.

Spot Mark Duration

When Spot Marking Style is Yes, adjust the lasing duration in 1/10 of a millisecond (100 microsecond) 

intervals.

Lens Spot Size (Spot objects only)

When using the Spot Tool, the Lens Spot Size property determines the size of the spot displayed on the 

Drawing Canvas. Set Lens Spot Size to Yes to view spots at the actual diameter created by the selected 

focusing lens. For example, when a 200 mm focusing lens is specified, a new spot object will display at a 

diameter of 0.011" (290 µm) instead of the default display size of 0.07" (1.78 mm).
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Format tab
The Format tab section includes subsections:

 Object format properties

 Array format properties

 Text format properties

 Polyline format properties

 Arc format properties

 Bar Code format properties

 2D Code format properties

 Spot format properties

 Bitmap format properties

Format properties (Figure 16-12) apply to objects contained within the drawing. These properties set ob-

ject positions and allow formatting of text and bar code characteristics. Most properties are common to all 

objects however; some properties apply only to specific types of objects.

Figure 16-12  Format tab Object properties 
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Object format properties
Object properties allow you to define reference points for object position and specify a scan direction for 

filled or bitmap objects.

Object Left Pos

Set the left (X-coordinate) position for the selected object’s bounding outline.

Object Top Pos

Set the top (Y-coordinate) position for the selected object’s bounding outline.

Fixed To Position

Define a fixed reference point for positioning a text, bar code, or 2D code object when overall size is 

increased or decreased due to manual re-sizing, additional characters, etc. One of nine bounding outline 

handles is used as an anchor while the other bounding outline points are free to move as re-sizing occurs. 

Tip: When serializing text strings containing lower case letters, the text string may shift up when lower 

case letters with descenders (g, j, p, q, s, y) are marked. This occurs because the Fixed To Position 

property defaults to Center. Set the text Fixed To Position property to Top Left, Top Middle, or Top 

Right for best results.

Use Group Properties

This property appears when a grouped object is selected. Choose Yes to mark grouped entities using proper-

ties currently defined on the Tools/General Settings…/Object Defaults tab. Select No to mark grouped enti-

ties with their individual properties defined prior to grouping. 

Note: In order to mark group entities using individual properties, set Use Group Properties to No and 

then perform the Group operation.

Raster Scan Direction

Specify horizontal or vertical raster scanning for filled text, polyline, or bitmap objects.

Tip: When marking raster-scanned images such as imported graphics, filled TrueType-style text, or 

barcodes, one scan direction typically marks much faster than the other depending on the object’s 

orientation. Optimize mark cycle time by ensuring that Bi-Directional Raster is Yes and then test 

mark each filled object using first a horizontal and then a vertical Raster Scan Direction.
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Figure 16-13  Format tab Array properties 

Array Columns

Enter the number of element columns in the array.

Array Rows

Enter the number of element rows in the array.

Mark Array

Choose Yes to mark the array. If No, only the original object, not the array, will mark.

Show Array

Select Yes to display the selected array or No to display only a single array element.

Column Spacing 

Enter the desired spacing between element columns in the array.

Row Spacing

Enter the desired spacing between element rows in the array.

Array Angle

Enter a baseline angle for rotating the array.

Array format properties
Array properties (Figure 16-13) allow you to batch mark a group of parts. Select an object or objects to be 

marked as an array element then create an array by specifying rows, columns, and spacing. The batch of 

parts to be marked must all fit within the marking field of the selected focusing lens.
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Text format properties
Text properties (Figure 16-14) apply to text objects within the drawing. These properties provide typo-

graphical control over specific text characteristics.

Figure 16-14  Format tab Text properties 

Text Caption

Enter a caption for the currently selected text object. If the text string displayed in the Property List 

is highlighted, typing will replace any current text. To edit, click once in the highlighted field to 

establish an insertion point or click the ellipsis (…) to enter multiline text using the Text Caption 

Editor dialog box.

Note: If Auto Text Type is set to other than None, the Text Caption property is hidden and the 

existing text string serves only as a placeholder for the specified auto text. For example, 

when serializing text, the character string entered as the Current Saved Value, not Text 

Caption, is used for marking.

Tip: WinMark Pro v6 allows you to open the Text Caption Editor dialog by simply double-clicking the 

text object on the Drawing Canvas.
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Tip: Unique Identification (UID) control codes.

To enter UID hexadecimal control codes into a text string using the Text Caption Editor dialog, type 

“\xXX” (without the quote marks); where XX is a 2-digit hexadecimal value. For example, a Group 

Separator (G/
S
) symbol is entered as \x1D.

Note: Some automated text and barcode captions are updated on the display when the object is 

selected or deselected. Dates, times, and From Another Object sources are updated in this 

manner; serial numbers are updated if Save Last Serial is Yes. Serial port and disk file text is 

not updated until the source is read during the mark sequence.

Font Type

Select a TrueType-style font (TrueType, OpenType, or PostScript) or a stroke font for text. Use 

stroke fonts for quick marks at high throughput speeds. Use TrueType-style fonts to match a logo, 

maintain a corporate identity, or create a certain “look”.

Note: When a TrueType-style font is selected, the following typographical sub-properties appear 

on the Format tab: Text Bold, Text Italics, Text Filled, Invert Text, Raster Fill Border, Filled 

Font Resolution, Text Outline Filled, Text Outline Power, and Text Curve Detail.

Tip: Both stroke and TrueType-style fonts are marked as vector objects although TrueType-style fonts 

tend to have more complex path outlines. TrueType-style fonts are marked using a raster-scanning 

technique when they are filled.

TrueType Font

Select a TrueType® font for marking text. Any TrueType (.TTF) font installed in Window’s Fonts 

folder is available to WinMark Pro. 

OpenType Font

New to WinMark Pro v6 is support for OpenType® and PostScript® fonts. 

Select an OpenType or PostScript font for marking text. Any OpenType (.OTF) font installed in 

Window’s Fonts folder is available to WinMark Pro. PostScript (.PFB) fonts are available when a 

shortcut to the font is placed in the Window’s Fonts folder. 

Important Note: When operated in stand-alone mode, Flyer/Fenix Flyer heads do not support 

OpenType (.OTF) or PostScript (.PFB) fonts.
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Stroke Font

Select one of WinMark Pro’s twelve built-in stroke fonts (.SYF). Fonts available include Bold, Eu-

ropean, Gothic, LiteCom, Little, Sans Serif, Script, Simple, Trip, Tscr (Trip Script), Complex, and 

Simplex.

Tip: Complex and Simplex stroke fonts are proportional, or monospaced, fonts meaning that a lowercase 

“i” takes up as much letterspace as an uppercase “W”. All other stroke fonts and most TrueType-

style fonts are non-proportional. A proportional font is useful in situations where alphanumeric text 

is being serialized and any possible combination of letters or numbers must remain within a specific 

boundary.

Text Height

Enter a base character height for text. Text Height is approximately the height of uppercase letters 

such as “M”, “W”, etc., although this height varies slightly depending upon the metrics of the chosen 

typeface. In general, Text Height for stroke fonts is padded to allow room for lower case descenders. 

This means that stroke text with only uppercase letters will display and mark slightly smaller than 

the value specified by Text Height. 

Tip: Have you always specified point sizes when working with type? There are 72 points per inch so 

multiply your desired point size by 0.01389 to obtain a decimal value, in inches, for Text Height. For 

example, WinMark Pro’s default Text Height is 0.25 inches, which corresponds to 19-point type.

Tip: To obtain an accurate Text Height for your mark, use only uppercase letters and do the following: In 

the Object Transformations dialog box, check Maintain Aspect Ratio, set the Current Height value to 

the desired size, and then press the TAB key to scale text. Click Apply and then click OK.

Text Bold

Toggle Yes to bold selected TrueType-style text.

Important Note: In Flyer’s stand-alone mode, you cannot use WinMark’s Text Bold property 

when your mark file uses ‘bold” TrueType-style text. Instead, you must copy 

the font’s bold typeface to the Flyer Filestore.
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Text Italics

Toggle Yes to italicize selected TrueType formatted text.

Important Note: In Flyer’s stand-alone mode, you cannot use WinMark’s Text Italics property 

when your mark file uses “italic” TrueType-style text. Instead, you must copy 

the font’s italic typeface to the Flyer Filestore.

Text Filled

Toggle Yes to fill selected TrueType-style text. Choosing Yes causes text characters to be filled 

by the raster scanning method. Choosing No simply marks text characters as vector outlines.

Note: When Text Filled is Yes, the following fill sub-properties appear on the Format tab: 

Invert Text, Raster Fill Border, Filled Font Resolution, Text Outline Filled, and Text 

Outline Power.

Note: When marking filled text, the value of the PWM Frequency property must greater 

than the product of the Resolution times Velocity (PWM Frequency > Resolution 

× Velocity), when Power is less than 100%. When PWM Frequency is too low, scan 

lines are broken (not marked) during the “off” portion of the PWM duty cycle. 

Tip: When raster-filling objects, use a lower Power setting than with vector objects to prevent overburn-

ing or distortion of the part substrate.

Invert Text

Set to Yes to mark the border around TrueType-style text instead of the text.

Raster Fill Border

When Invert Text is Yes, use Raster Fill Border to specify a marked border dimension around 

the text object.

Filled Font Resolution

When Text Filled is Yes, set a fill resolution between 50 and 1000 microvectors per inch. 

Text Outline Filled

Choose Yes to outline the edges of raster-filled TrueType-style fonts. This vector outline tends 

to smooth the character shape after the raster-filling process.
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Note: When Text Outline Filled is Yes, the following fill sub-property appears on the Format 

tab: Text Outline Power.

Text Outline Power

Set a power level for marking TrueType text outlines. 

Tip: Typically, the outline power setting is set higher than the power level used for filling text.

Text Justification

Select left, right, or center justification for multiline text objects.

Text Curve Detail

Specify a curve resolution for TrueType-style fonts. Higher values create smoother curves especially 

when marking large font sizes. The default value is 500, but can range from 20 to 1000.

Text Width

Enter an average width (horizontal scale) for text characters. Enter zero (0) to return to WinMark’s 

default font width.

Line Spacing

Enter line spacing (leading) between lines of multiline text. Enter zero (0) to return to WinMark’s 

default spacing value.

Extra Char Spacing

Enter additional spacing (tracking) between text characters. Enter zero (0) to return to WinMark’s 

default character spacing. 

Text Radius

Enter a radius for marking text on a curve. Use Text Radius to fit text inside or outside an arc or 

circle. Positive values cause text to radius in a convex form; negative values cause text to radius in a 

concave form.
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Polyline format properties
Polyline properties (Figure 16-15) apply to polyline objects within the drawing. These properties give you 

the ability to customize polyline objects.

Figure 16-15  Format tab Polyline properties 

Polyline Fill Type

Fill the selected polyline object. Choosing Fill causes polylines to be filled by raster scanning. Choos-

ing No simply marks polylines as vector outlines.

Note: When Polyline Fill Type is Yes, the following fill sub-properties appear on the Format tab: 

Polyline Mark Outline and Polyline Outline Power.

Note: When marking filled polylines, the value of the PWM Frequency property must be greater 

than the product of the Resolution times Velocity (PWM Frequency > Resolution × 

Velocity), when Power is less than 100%. When PWM Frequency is too low, scan lines are 

broken (not marked) during the “off” portion of the PWM duty cycle. 

Polyline Mark Outline

Choose Yes to outline polyline objects. This vector outline tends to smooth the polyline shape 

after raster filling.

Tip: When raster-filling objects, use a lower Power setting than with vector objects to prevent overburn-

ing or distortion of the part substrate.

Polyline Outline Power

Set a power level for marking polyline outlines. 
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Tip: Typically, the outline power setting is set higher than the power level used for filling.

Arc format properties
Arc properties (Figure 16-16) apply to arc, circular, and elliptical objects within the drawing. These prop-

erties give you the ability to create circles, ellipses, or arcs of varying sizes.

Figure 16-16  Format tab Arc properties 

Arc Radius

Enter an exact radius for a circular object. 

Minor Arc Radius

For elliptical objects, enter a minor radius. For circles, enter the same value as the specified Arc 

Radius.

Arc Start

Use Arc Start to create an arc or semicircular object by specifying a starting angle for the object. 

Larger values move the starting position of the arc in a counterclockwise direction from the zero 

point. When Arc Start is used in conjunction with Arc End, the open arc segment can be made to 

point in any direction.

Arc End

Use Arc End to create an arc or semicircular object by specifying an ending angle for the object. 

Smaller values move the ending position of the arc in a clockwise direction from the zero point. 

When Arc End is used in conjunction with Arc Start, the open arc segment can be made to point in 

any direction.
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Tip: In WinMark v6, the Arc End property can be extended beyond 360°. This allows you to over-travel 

the start point to eliminate the “hanging chad” effect when cutting materials that exhibit melt-back 

or to make an additional partial pass when cutting through two overlapped materials.

Arc Filled

Fill the selected arc. The Arc Filled property is only available for circular or elliptical objects. Open 

arcs cannot be filled.

Note: When Arc Fill is Yes, the following fill sub-properties appear on the Format tab: Arc Mark 

Outline and Arc Outline Power.

Note: When marking filled arcs, the value of the PWM Frequency property must be greater than 

the product of the Resolution times Velocity (PWM Frequency > Resolution × Velocity), 

when Power is less than 100%. When PWM Frequency is too low, scan lines are broken 

(not marked) during the “off” portion of the PWM duty cycle. 

Arc Mark Outline

Choose Yes to outline arc objects. This vector outline tends to smooth object edges after raster 

filling.

Tip: When raster-filling objects, use a lower Power setting than with vector objects to prevent overburn-

ing or distortion of the part substrate.

Arc Outline Power

Set a power level for marking arc outlines. 

Tip: Typically, the outline power setting is set higher than the power level used for filling.

Arc Clock Wise

Choose No, the default, to mark the specified arc in a counter-clockwise direction (in relation to Arc 

Start and Arc End values). Choose Yes to mark the inverse of the specified arc in a clockwise direc-
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tion (in relation to Arc Start and Arc End values). Figure 16-17 shows the results of changing the 

Arc Clock Wise property when the Arc Start property value is 0° and the Arc End value is 270°.

Note: To mark the specified arc (as drawn) in the opposite direction, simply swap Arc Start/Arc 

End values.

Figure 16-17  Arc Clock Wise mark characteristics

0°

0°

270°

270°

Arc Clock Wise = No

Arc Clock Wise = Yes
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Bar Code format properties
Bar code properties (Figure 16-18) apply to 1D bar code objects within the drawing. You can select specific 

bar code types and customize bar code properties.

Figure 16-18  Format tab Bar Code properties 

Barcode Number

Enter a caption for the currently selected bar code object. If the text string displayed in the Property 

List is highlighted, typing will replace any current text. To edit, click once in the highlighted field 

to establish an insertion point. For bar codes that support extended character sets, click the ellipsis 

(…) to enter multiline text using the Text Caption Editor dialog box. Barcodes supporting extended 

characters sets include Code 128 (all 128 characters), Code 128 Subset A, Extended Code 3 of 9, 

Extended Code 93, MicroPDF, and PDF417. 

Note: If Auto Text Type is set to other than None, the Barcode Number string serves only as a 

placeholder and is replaced by the specified auto text during the mark session. For example, 

when serializing text, the character string entered as the Current Saved Value, not Bar-

code Number, is used for marking.

Note: Some automated text and barcode captions are updated on the display when the object is 

selected or deselected. Dates, times, and From Another Object sources are updated in this 

manner; serial numbers are updated if Save Last Serial is Yes. Serial port and disk file text is 

not updated until the source is read during the mark sequence.
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Barcode Style

Select from over twenty common bar code types. Supported formats include:

 Codabar Code 3 of 9 (Code 39) Extended Code 3 of 9

 Code 93 Extended Code 93 Code 128 (all 128 characters)

 Code 128 Subset A Code 128 Subset B Code 128 Subset C 

 Ean/Jan 8 Digit Ean/Jan 13 Digit HIBC Code 3 of 9

 Interleaved 2 of 5 Micro PDF 417 MSI Plessey 

 Portable Data File (PDF) 417 Post Net 5, 9, 11 Digit RSS14 Stacked Composite

 UCC-128 UPC-A 11 Digit UPC-E 6 Digit, 0 Type Code

 UPC-E 6 Digit, 1 Type Code UPC-E 11 Digit

Tip: Bar codes not supported by WinMark Pro can often be created using third-party software. After 

creating the bar code, save it in a bitmap (.BMP) format, and then import the bitmap code directly 

into WinMark. 

Barcode Resolution

Define line density for the rasterized bar code. This value is used as the marking resolution.

Barcode Inverted

Create a contrasting ‘negative-image” of the bar code so that spaces between the bars are marked in-

stead of the bars themselves. A “quiet zone” is added so that bar code readers can locate the first and 

last bars in the code. Barcode Inverted is useful for marking dark materials that produce a lighter, 

contrasting mark.

Barcode Quiet Zone Size

If Barcode Inverted is Yes, you can choose to increase or decrease the length of the quiet zone.

Barcode Height

Set a specific height for the long bars in the code.

Barcode Thin Width

Specify a line width for thin bars in the code. Horizontal spacing is then proportionally adjusted 

throughout the code.
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Tip: Depending on desired cycle time and material type, Barcode Thin Width should generally be set to 

mark a width equal to, or some multiple of, the spot size of the focusing lens. Assuming Barcode 

Resolution is optimized, a Barcode Thin Width value equal to the spot size means that only one 

pass is required to mark the line. Too large a value means that multiple slightly offset passes must be 

made to generate the wider line, potentially slowing cycle time. Marking too wide a line will also 

encroach on the white space between bars, causing verification problems.

Barcode Checksum

Choose Yes to append a Barcode Checksum (if applicable for the Barcode Style selected) to the 

Barcode Number value. Although the checksum is incorporated into the Barcode Number, it does 

not display as human-readable text (when Barcode Show Text is Yes).

Note: The Barcode Checksum property is suppressed for barcodes that do not support, or that 

always use, a checksum.

PDF 417 X/Y Ratio (for PDF 417 and Micro PDF 417 barcodes only)

Set the barcode cell X/Y (height to width) ratio by entering an integer value between 1 and 10. The 

default value is 4, which is the ratio that most barcode scanners read best.

PDF 417 Security Level (for PDF417 barcodes only)

Choose from one of nine levels of data security (error correction and detection). Each higher level of 

security adds additional overhead and physical size to the printed symbol. Association for Automatic 

Identification and Mobility (AIM) standards recommend a security, or error correction, level of 2. 

The default value of 0 produces the most compact code.

PDF 417 Truncated (for PDF417 barcodes only)

When Yes, a truncated PDF 417 code is created. This creates a more compact code by removing or 

truncating the right-most side of the barcode; however, this is more susceptible to damage. 

MicroPDF Reader Init (for MicroPDF 417 barcodes only)

Set to Yes to embed a reader initialization symbol in the code.

MicroPDF Mode (for MicroPDF 417 barcodes only)

This property indicates which MicroPDF size enumeration mode is used. Mode values range from 

0 to 32 with 0 being the smallest code size. Higher mode values allow a larger number of encodable 

data characters and a higher graphical data density by varying the number of data columns and data 

rows in the code.
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MicroPDF 128 Code Emulation (for MicroPDF 417 barcodes only)

This property causes the barcode scanner to read the code is if it was a Code 128 barcode.    

Property value functions are listed below:

0 = No emulation

1 = Linked C1; Linked UCC/EAN-128 emulation (Transmit ]C1 char)

2 = Unlinked C1; UCC/EAN-128 emulation (Transmit ]C1 char)

3 = C0; Default encoding mode

4 = C2; Code 128 emulation (transmit ]C2 char)

MicroPDF Disable Macro Character (for MicroPDF 417 barcodes only)

Determines whether macro character substitution is enabled or disabled. The default setting, No, 

allows macro characters.

Barcode Show Text

Choose Yes to include human-readable text as part of the bar code object.

Barcode Text Position

If Barcode Show Text is Yes, select one of six locations for the placement of human-readable text.

Barcode Text Font

Select any TrueType formatted font on your computer system to use for the human-readable text 

included in the bar code. The barcode library does not recognize OpenType (.OTF) or PostScript 

(.PFB) fonts.

Tip: Human-readable bar code text always uses filled TrueType formatted fonts. To shorten cycle times, 

set Barcode Show Text to No, create a new text object, and set Font Type to Stroke. If Barcode 

Number is a static value, simply enter this information into the text object’s Text Caption. If Bar-

code Number is variable, use From Another Object and Assign From properties to link bar code 

and text objects so that data remains synchronized throughout a mark session. 

Barcode Text Size

Enter a text size for the human-readable text included in the bar code.
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Barcode Thick to Thin Ratio

For barcode formats that allow it, define a ratio for the width between thin bars/thin spaces and 

thick bars/thick spaces in the bar code. Based on the selected ratio (2:1, 2.5:1, or 3:1), horizontal 

spacing of thick bars/thick spaces is proportionally adjusted throughout the code.

2D Code format properties
2D code properties (Figure 16-19) apply to 2D code objects within the drawing. You can choose to mark 

either Data Matrix or QR Code formats and customize 2D code properties.

Figure 16-19  Format tab 2D Code properties 

2D Barcode Text

Enter single or multiline text up to 500 characters. If the text string displayed in the Property List is 

highlighted, typing will replace any current text. To edit, click once in the highlighted field to es-

tablish an insertion point. Click the ellipsis (…) to enter multiline text using the Text Caption Editor 

dialog box.

2D Barcode Fixed Cell Size

If 2D Barcode Fixed Cell Size is No, then cells are sized to fit the existing bar code bounding box. If 

set to Yes, then overall 2D bar code size is based on the number of cells and the individual cell size as 

specified by 2D Barcode Cell Size.

2D Barcode Cell Size

Specify the size of an individual 2D bar code cell when 2D Barcode Fixed Cell Size is Yes.
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2D Barcode Inverted

Create a contrasting “negative-image” of the bar code. The spaces between the cells are marked 

instead of the cells themselves and a “quiet zone” is added so that 2D code readers can locate the 

outside edges of cells. This feature is used for marking dark materials that produce a lighter, contrast-

ing mark.

2D Barcode Quiet Zone

Defaults to Yes, if 2D Barcode Inverted is selected. This property creates a one-cell (Data 

Matrix) or four-cell (QR Code) quiet zone, around the code to aid readability.

2D Barcode Bitmap

Choose Yes to mark 2D code cells as standard bitmap (raster) squares. Select No to mark cells as 

unfilled vector circles. At small code sizes, the unfilled vector circle is properly read as a ‘cell’ with 

the primary advantage of substantially reduced cycle times. See WinMark Pro Application Note #1, 

Marking 2D Matrix Codes, at http://www.winmark.com/products/winmark_ApplicationsNotes.html 

for details on setting up and using this property.

2D Barcode Rounding Percentage

When 2D Barcode Bitmap is No, enter the amount of rounding percentage applied to vector 

circles that make up individual cells. A value of 100% marks circles, while a value of 0% marks 

a vector square. Entering a value of 50% produces a rounded rectangle with a corner radius 

that is one-quarter the cell size.

2D Barcode Circle Radius

For bitmap- or vector-style codes, enter a value less than 100% to scale down the marked cell size. 

Smaller diameter cells eliminate print growth errors and improve barcode grading. 

2D Barcode Style

Select Data Matrix, QR Code, or Micro QR Code styles.

2D Barcode Shape

If 2D Barcode Style is Data Matrix, choose between square and rectangular code formats. 

Rectangular codes are useful for marking long thin parts but are limited to less than 98 digits or 

72 alphanumeric characters. Entering characters beyond this limit forces the code to revert to 

a square.

Error Correction Mode

If 2D Barcode Style is QR Code or Micro QR Code, choose from one of four error correction 

modes. High Density creates the most compact code while Ultra High Reliability produces the 

highest accuracy when reading dirty or damaged codes.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
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Data Input Mode

If 2D Barcode Style is QR Code or Micro QR Code, choose Automatic, the default setting, or 

Manual data input. Manual input is used when multiple data types (numeric, alphanumeric, 

Kanji, and binary) are contained within a single data string.

For Manual data entry only, a character mode must precede the data string. Valid character 

modes are: N – Numeric; A – Alphanumeric; K - Kanji (Data Character String consists of shift 

JIS codes); and B - Binary (in Binary mode, the data is first preceded by the number of data 

characters represented as a four digit decimal number.)

To create a QR Code using Manual data input containing the numeric character data 

string “123456789012345”, enter the following string in the 2D Barcode Text property: 

N1234567890123454. To enter data in Manual mode using more than one character mode, 

place a comma between the first data string and the new character data mode. For example to 

enter the numeric data string “12345” and the alphanumeric string “QRCode”, enter the fol-

lowing string for 2D Barcode Text: N12345,AQRCode.

Spot format properties
Spot properties (Figure 16-20) apply to spot objects within the drawing. 

Figure 16-20  Format tab Spot properties 

Spot Lase Duration

Enter a lasing duration in milliseconds. Spot Lase Duration is useful when marking a spot or drilling 

thru holes in material. The minimum lase duration is 0.001 milliseconds while the maximum dura-

tion is 1 hour (3600 seconds).
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Bitmap format properties
Bitmap properties (Figure 16-21) apply to imported bitmap images within the drawing. 

Figure 16-21  Format tab Bitmap properties 

Bitmap Inverted

When set to Yes, imported bitmap (raster) images are inverted to create a contrasting “negative-

image” of the bitmap. As shown in Figure 16-22, dark areas are laser marked, while light areas are 

unmarked. Use this feature to mark dark materials that produce a lighter, contrasting mark. 

Figure 16-22  Normal and inverted bitmap images 

Note: After changing Resolution and/or resizing the image, test mark the bitmap image. Use the 

Color Reduction Method property (Format tab) to change the color reduction algorithm 

as required. Any changes are performed on the original image, which is stored by WinMark 

during importation. Note that the screen display does not necessarily indicate the improved 

mark quality, so test marks are required.
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Tip: For best results when marking bitmap (raster) images, set a Resolution value that corresponds to 

100–150% of the spot size generated by the selected focusing lens. For example, a 200 mm lens with 

a spot size of 0.011" is capable of marking approximately 91 discrete dots per inch. Although Reso-

lution values are somewhat material-dependent, generally, start with a Resolution equal to 200–300 

when using an 80 mm lens; 143–214 for a 125 mm lens; 91–136 for a 200 mm lens; and 50–71 when 

marking with a 370 mm lens.

Color Reduction Method

When importing color (as opposed to monochrome) bitmaps, choose a Color Reduction Method 

from among Bayer Dithering, Error Diffusion, Halftone, Threshold, or Grayscale. 

Color images

Bayer Dithering, Error Diffusion, Halftone, and Threshold methods covert color images into mono-

chrome (1-bit) images suitable for laser marking. The differences in Bayer Dithering, Error Diffusion, 

and Halftone reduction methods are in the changes made to the size, shape, and spacing of pixels in 

the bitmap in order to create an illusion of shading, since all pixels in a 1-bit image are either black 

(marked) or white (unmarked). The Threshold import method uses a slider to customize the black/

white threshold level in the range from 0 – white to 255 – black (the default is 128).

Figure 16-23 shows an original 8-bit image and the resulting 1-bit image after being processed 

through WinMark Pro’s Error Diffusion color reduction algorithm. 

Figure 16-23  8-bit black and white image versus 1-bit Error Diffusion reduction
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Note: Imported bitmap images are now resized according to the Resolution setting specified on 

the Tools/General Settings…/Object Defaults tab. Previously, WinMark Pro increased or de-

creased bitmap image size corresponding to a fixed bitmap resolution of 600 DPI. WinMark 

Pro does not resample bitmap images but rather resizes them to preserve the image’s total 

pixel count – the overall dimensions of a 96 DPI image imported into WinMark at 300 DPI 

are automatically resized to 32% of the original height and width.

Tip: Many times after choosing an initial Color Reduction Method when importing images into 

WinMark Pro, bitmaps are resized or Resolution is altered. Because bitmap images are resolution-

dependent (created for a particular display size and resolution), changing image size or resolution 

tends to degrade display and mark quality of the bitmap. If you must vary image size or resolution 

from the original settings, do so and then click Color Reduction Method. In some cases, changing 

the reduction method produces better results.

Grayscale images

Choose Grayscale (Figure 16-24) to convert color bitmaps into 8-bit grayscale images (an 8-bit gray-

scale image provides 256 levels of gray ranging from 0–white to 255–black). For Grayscale bitmaps, 

Power and Min Power Threshold properties on the Marking tab set the limits of laser power used to 

mark black (255) and white (0) pixels respectively. 

Figure 16-24  8-bit black and white image versus 8-bit Grayscale reduction 

Tip: Before marking a Grayscale image, create a matrix of filled squares as shown in Figure 16-25. By 

choosing various ranges for Power and Velocity, you can quickly determine settings that provide the 

best dynamic range for your particular image.
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Figure 16-25  Sample Power/Velocity matrix file 

Threshold Level

When the Color Reduction Method is set to Threshold, fine-tune the image’s black/white threshold 

level for best reproduction within the range from 0 – white to 255 – black (the default is 128).

Bitmap Scan Type

Choosing Normal treats each scan line in a bitmap image as a sequence of microvectors that includes 

the corresponding Pline Start Delay, Pline End Delay, and Off Vector Delay times. Selecting Con-

tinuous forces each scan line to mark at a constant Velocity and Power, while cycling laser power on 

or off according to the bitmap data. Grayscale images are always marked using the Continuous scan 

method.

Note: Bi-Directional Raster is automatically disabled when Bitmap Scan Type is Continuous.

Note: If Bitmap Scan Type is Normal or the Color Reduction Method is other than Grayscale 

(which uses a Continuous scan method), then the value of the PWM Frequency property 

must be greater than the product of the Resolution times Velocity (PWM Frequency > 

Resolution × Velocity), when Power is less than 100%. When PWM Frequency is too low, 

scan lines are broken (not marked) during the “off” portion of the PWM duty cycle.

Randomize Bitmap

When marking Grayscale images, choose Yes to mark individual continuous scan lines in a 

random order. This helps eliminate any “banding” characteristics exhibited by the laser.
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Radial Marking

With WinMark v6 and Flyer/Fenix Flyer heads you can perform radial marking on imported bitmap 

objects. Set Radial Marking to Yes and then setup part rotation using a rotary indexing method (like 

a stepper motor). Use Part Moving Input/Step Command Output properties below to indicate 

when marking or part rotation should occur. See WinMark Pro Application Note #8, WinMark Pro 

v6’s New Radial Marking Property, on the WinMark web site at http://www.winmark.com/products/

winmark_ApplicationsNotes.html for detailed setup information.

Note: Part Moving Input and Step Command Output commands run in the ‘MarkDrawing’ loop 

and are independent of any automation created on the Drawing’s Automation tab.

Part Moving Input

Use the Part Moving Input property to indicate part movement (rotation) is occurring. When 

the specified input is Set (active), WinMark waits—until the Timeout (msec) property value 

is exceeded. When parts handling equipment Clears this input (when part movement has 

halted), WinMark marks a single raster line.

Step Command Output

The specified Step Command Output is Set (active) after marking to indicate that the raster 

line is complete and part movement (rotation) can begin. Flyer/Fenix Flyer automatically 

Clears (low or inactive) the specified output when the Part Moving Input is next Set (acti-

vated).

Timeout (msec)

Enter a timeout value in milliseconds (or –1 to wait indefinitely) for the next Part Moving 

Input transition to occur. When a Step Command Output transition occurs, the Part Moving 

Input must also transition—low/high or high/low—within the specified timeout period or the 

mark session will abort.

All tab
All applicable properties from Special, Automation, Marking, and Format tabs are included on this tab.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_ApplicationsNotes.html
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17 Event Builder 
commands

Event Builder commands (Figure 17-1) are available at five different stages (On Before Mark Session, On 

Before Mark Piece, On After Mark Piece, On After Mark Session, and On Abort Session) in the auto-

mation loop. These commands, described below, perform automation functions during the marking pro-

cess. In most cases, these automation events are assigned to a specific property of the target mark object.

Figure 17-1  Event Builder dialog box 

AskUserInput

Prompt the operator for keyboard input and assigns the resulting alphanumeric string to the specified 

target object and target property. 

Note: The AskUserInput event is not available when operating in Flyer/Fenix Flyer stand-alone mode.

Command Details:

User Prompt

Create a custom User Prompt for the User Input dialog box. 

Use Default

If a new operator input string is not required for every mark, set Use Default to mark a predefined text 

string using From Current Property Value or From Default Text entries. 
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Default Text

Mark a default text string if specific operator input is not required. The text entered here is marked 

when Use Default is set to From Default Text.

Tip: AskUserInput is often assigned to the Text Caption property of a text object.

AssignDate

Allows you to create and assign a standard or customized date code format to a target object and target 

property (see Figure 17-2), typically a Text Caption property. 

Command Details:

Date Format

Click Date Format in the Command Details frame and then click the down arrow to select from a 

list of predefined standard or custom date formats or click the ellipsis (…) to open the Date Format 

Customization dialog and create new custom formats.

Figure 17-2  Event Builder - AssignDate command dialog boxes
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To create a custom date format:

1 In the Date Format Customization dialog box click the Add Format button.

2 If desired, type a descriptive name in the Format Name box.

3 Browse the Available Format Commands box for available date or time formats.

4 Double-click the desired format commands or click in the Format Definition String box and type in 

commands to create a custom format string.

5 When done, click the Close button.

Note: In WinMark Pro v6, custom date formats are saved in the mark file as well as in the develop-

ment computer’s System Registry. This prevents an “undefined” format error from occurring 

when files with custom date formats are loaded on different computers or on a Flyer head 

operating in stand-alone mode.

Tip: The Example Date box shows how the Format Definition String will look when marked. You can add 

spaces, dashes, or other fixed alphanumeric text within the string by typing characters between 

definitions in the Format Definition String box.

CallDLLFunc

Call a custom user-written Dynamic Link Library (DLL) function. The DLL can pass a property and user 

arguments into WinMark Pro by specifying a DLL Filename, an export Function Name, and up to three user 

arguments. 

Note: The CallDLLFunc event is not available when operating in Flyer/Fenix Flyer stand-alone mode.

Command Details:

DLL Filename

Enter the path and filename that points to the desired DLL file.

Function Name

Enter the DLL export function name (specified in the DLL’s .def file).

User Arg #1

Enter the first argument, if any.

User Arg #2

Enter the second argument, if any.
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User Arg #3

Enter the third argument, if any.

To activate a DLL from WinMark Pro, an event must be defined in the Event Builder via the Automation 

tab for the drawing. The following steps illustrate how to define a DLL using the example provided in the 

WinMark Pro Samples folder:

1 Open a New drawing and then place a text object on the Drawing Canvas.

2 Click the Drawing Canvas to select the Drawing object and then select the Automation tab from the 

Property List.

3 Select the marking event to be defined, such as On Before Mark Piece, and click the ellipsis (…).

4 In the Event Builder dialog box, click Add in the Commands frame.

5 In the field labeled 1 in the Commands frame, click the down arrow and select CallDLLFunc from 

the drop-down list.

6 In the Command Details frame, enter the DLL path and filename (C:\Program Files\WinMark\

Samples\Sample Dll\CommPortDll.dll); the DLL export Function Name (ReadSerialPort), found in 

the CommPortDll.def file; and up to three user arguments (in this example, only two are used – com1 

for User Arg#1 and 10000 for User Arg #2).

7 In the Target Object and Property frame, select a target object (Text1) and corresponding object prop-

erty (Text Caption). Your Event Builder dialog should look similar to the one shown in Figure 17-3.

Figure 17-3  Event Builder - CallDLLFunc command dialog box

8 Click OK. When the drawing is marked, the DLL is executed. 
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This example opens the ComPortDll and calls SerialPortRead. If no data is read within the timeout period 

(10000 ms or 10 seconds), then the mark session aborts. If data is available on the designated serial port 

(COM1), then WinMark Pro reads the data, inserts a carriage return (CR) and line feed (LF) when a new 

line character is received, terminates the data input, and initiates the marking sequence when a “MARK” 

string is received. Serial data is stored in the szPropBuffer buffer and the bBufferChanged flag is set to a non-

zero value. The flag tells WinMark that the received data should replace the current marking data. 

To implement the DLL/WinMark interface, the DLL must use an argument structure with the following 

members:

struct _DLLStruct

{

char szUserArg1[64]; // argument 1

char szUserArg2[64]; // argument 2

char szUserArg3[64]; // argument 3

char szPropBuffer[128]; // data buffer

WORD bBufferChanged; // data change flag (object data changed in current drawing)

void* pfnFuncCallback;

void* pfnCallbackData;

HWND hwndWinMark;

};

Export functions of the DLL must be explicitly defined in the .DEF file (e.g. function1 @1, function2 @2). 

DoBeep

Generate a beep from the computer’s speaker. 

Note: The DoBeep event is not available when operating in Flyer/Fenix Flyer stand-alone mode.

Tip: This command might be used to provide an audible prompt for user input or a signal that marking is 

complete.

DoPause

Pause program execution for the specified number of milliseconds.

Command Details:

Delay (msecs)

Enter a delay value in milliseconds. The default is 1000, which equals 1 second.
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IncSerial

Increment or decrement alphanumeric characters in currently selected text string by the specified delta 

value. Non-alphanumeric characters are ignored. This command is normally assigned to the Text Caption 

property.

Note: Unlike the serialization feature from the Auto Text Type object property, Event Builder automa-

tion does not provide the ability to save the current serial value at the end of a mark session.

Command Details:

Delta

Enter a positive integer value (to increment) or a negative value (to decrement) the serial count.

MarkingHeadOn (FH Index/Tracker heads and Fenix Laser Markers only)

Note: The MarkingHeadOn event is a legacy support property not available when operating FH Flyer 

marking heads or Fenix Flyer Laser Markers.

Define an output signal (from the Fiber Link Controller Card only!) to parts handling equipment indicat-

ing a “No End of Mark Response” signal from a Fenix/FH Series marking head. Bits labeled IGNORE are 

not changed. A “No End of Mark Response” message is generated by WinMark Pro when the head fails to 

respond after mark data has been sent. This can occur if the head has lost power or the fiber optic commu-

nication link fails during a mark session. Output connections for the MarkingHeadOn event must be made 

to the FLCC since marking head outputs are obviously unavailable if the marking head is powered down.

Command Details:

PCI Card ID

Enter a card ID corresponding to the ID of the card used for the input/output (I/O) connection. Typi-

cally, this ID number corresponds to the ID of the card used for controlling the marking head (see Tools/

General Settings … / “Device” tab/ Object Name).

Output Bit 1

This output is available only from the output mini-DIN connector on the FLCC.

Output Bit 3

This output is available only from the output mini-DIN connector on the FLCC.

Output Bit 4

Corresponds to OUT4 on Fenix/FH Series marking heads. This output is also available from the output 

mini-DIN connector on the FLCC.

Output Bit 5

Corresponds to OUT5 on Fenix/FH Series marking heads. This output is also available from the output 

mini-DIN connector on the FLCC.
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Output Bit 6

Corresponds to OUT6 on Fenix/FH Series marking heads. This output is also available from the output 

mini-DIN connector on the FLCC.

Output Bit 7

Corresponds to OUT7 on Fenix/FH Series marking heads. This output is also available from the output 

mini-DIN connector on the FLCC.

MatchDigitalState

Read the input bit pattern of the Flyer/Fenix Flyer head and assign the result of this Boolean test (Yes/True 

if all bits match; No/False if not) to the target property (see Figure 17-4). The input state of bits labeled 

IGNORE are disregarded. The MatchDigitalState result is normally passed to Boolean properties such as 

Mark Object to include or exclude an object from marking. See Chapter 11, Automation basics, for a table 

showing available inputs.

Figure 17-4  Event Builder - MatchDigitalState command dialog box

Command Details:

Timeout MSecs

Use a short timeout value (milliseconds or tens of milliseconds) to complete the input status scan im-

mediately or enter a timeout value of –1, which forces WinMark to wait indefinitely for a valid match 

(or until the ESC key aborts the mark session).
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Input Bit 0

Corresponds to IN0 on Flyer/Fenix Flyer heads.

Input Bit 1

Corresponds to IN1 on Flyer/Fenix Flyer heads.

Input Bit 2

Corresponds to IN2 on Flyer/Fenix Flyer heads.

Input Bit 3

Corresponds to IN3 on Flyer/Fenix Flyer heads.

Input Bit 4

Corresponds to IN4 on Flyer/Fenix Flyer heads.

Input Bit 5

Corresponds to IN5 on Flyer/Fenix Flyer heads.

Input Bit 6

Corresponds to IN6 on Flyer/Fenix Flyer heads.

Input Bit 7

Corresponds to IN7 on Flyer/Fenix Flyer heads.

Tip: MatchDigitalState is useful for selecting one of a number of objects (or group of objects) to mark 

during a single mark session. For example, if your production process randomly places different 

products on the marking conveyor asynchronously, the mark file can be configured to mark one of a 

number of specific marks as determined by the state of marking head inputs. See Chapter 11, Auto-

mation basics, for a table showing available inputs.

Follow the steps below to set up a demonstration file containing three different objects and then automate 

the file so that only one of the objects marks on each pass through the automation loop depending on the 

status of input bits IN3 and IN4. MatchDigitalState works by evaluating the status, high or low, of the 

actual input bit(s) against the specified match values and assigns a Boolean value of True or False to the 

target object and target property.

Configure MatchDigitalState automation as follows:

1 Open a new mark file and place three text objects on the Drawing Canvas. Give each text object a 

different caption so that they are uniquely identified.

2 Click any blank area on the Drawing Canvas or highlight Drawing in the Property List and then click 

the Automation tab.
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3 On the Automation tab, click the ellipsis (…) to the right of On Before Mark Piece to open the 

Event Builder dialog.

4 Click the Add button to add a new command.

5 Click on the drop down arrow and select MatchDigitalState.

6 Set the Timeout Msecs value (in the Command Details frame) to 100.

7 Set the Input Bit 3 state to ‘Clear – 0’ and Input Bit 4 to ‘Set – 1’. Leave all other bits set to ‘Ignore’.

8 In the Target Object and Property frame, select the first of the three text objects as the target object, 

and select Mark Object as the target property.

9 Follow Steps 4 and 5 to add a second MatchDigitalState command, but set Input Bit 3 to ‘Set – 1’, set 

‘Input Bit 4 to ‘Clear – 0’, select the second text object as the target object, and choose Mark Object 

as the target property. The Timeout Msecs value should be set to ‘0’.

10 Follow Steps 4 and 5 to add a third MatchDigitalState command, but set Input Bit 3 to ‘Set – 1’, set 

Input Bit 4 to ‘Set – 1’, select the third text object as the target object, and choose Mark Object as 

the target property. . The Timeout Msecs value should be set to ‘0’. At this point, the Event Builder 

should look similar to the view shown in Figure 17-5 although your text object names may differ.

Figure 17-5  Event Builder dialog box for MatchDigitalState demo
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11 Click OK, then save the mark file.

The Timeout Msecs property determines how many milliseconds WinMark Pro waits for input status to 

match the specified values before returning a value of False to the target object and property. WinMark 

Pro continuously checks the status of the input bits until the required bit pattern is matched or until 

the timeout value expires. As soon as the input pattern matches the specified input state, any remaining 

timeout period is ignored and WinMark Pro advances to the next step in the automation sequence. 

Tip: When an Event Builder dialog contains a series of MatchDigitalState events and you require a 

timeout value, set a Timeout Msecs value for the first MatchDigitalState (for example, 100 msecs as 

described in the sample above) and set the Timeout Msecs value for remaining MatchDigitalState 

events to zero (0). This assures a consistent, timed response that is not dependent on the order in 

which the match is recognized.

The demo file described above is configured so that only one of the three MatchDigitalState commands 

will set its corresponding target object and property to True, provided that the state of the inputs are 

held steady during the succession of MatchDigitalState evaluations. This results in only one object being 

marked for each pass through the mark loop (see the Automation Flowchart under the Help menu). No 

mark is made if the states of the inputs do not match one of the three MatchDigitalState input conditions.

Once your MatchDigitalState automation works as desired, you can add ‘start mark’ inputs and setup the 

mark file to execute the mark loop as many times as desired using the basic automation scheme described 

in Chapter 11, Automation basics.

ReadFromSerialPort

Read a line of text from the specified serial port. The value read can be used to dynamically set the value 

of any target property. Since one text string is read from the serial port each time ReadFromSerialPort is 

called, you must end the line with a Carriage Return (CR) character to provide the ‘end of data’ delimiter. 

For multi-line text strings, use a Line Feed (LF) character to force a line wrap and then end the last line 

with a Carriage Return.

Note: The ReadFromSerialPort event is not available when operating in Flyer’s stand-alone mode. In-

stead go to WinMark’s Automation tab and use the Disk File Text (Fixed or Sequential) property.

Command Details:

COM Port

Specify a serial communications port on your computer, and then click the down arrow to see a list of 

available com ports detected on your computer. Click the ellipsis (…) to view and modify serial port 

settings (Figure 17-6) as required by your serial communications network. WinMark Pro v6 supports 

serial transfer rates between 2400–115200 baud.
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Figure 17-6  Event Builder - ReadFromSerialPort - Serial Port Settings dialog box 

Timeout MSecs

Set a communications port timeout period in milliseconds. The mark will fail if information is not 

available at the port within the specified time. Entering a timeout value of –1 forces WinMark Pro to 

wait indefinitely until a message is received or the ESC key cancels the mark session.

Close After Read

Use Close After Read to determine whether the com port remains open or is closed after each serial 

port read. The default setting is No, which means the computer’s com port is opened during the initial 

com port read and remains open throughout the mark session. Choosing Yes forces the com port to 

close after each read operation for cases where subsequent serial data must be ignored. The com port is 

reopened when the next serial port read is commanded.

Tip: While the Auto Text Type property simply assigns incoming serial data to the Text Caption proper-

ty of the selected text object, the Event Builder’s ReadFromSerialPort event provides much greater 

flexibility. For example, you can assign the serial port data to almost any marking or format property 

of the text object like Text Caption, Font Type, Text Height, etc.

ReadLineFromFile

Read a line of text from a text (.txt) file and assign it to any target property. Since one line of text is read 

each time ReadLineFromFile is called, you must end the string with a Carriage Return (CR) to provide 

the ‘end of data’ delimiter. 

Command Details:

Filename

Enter the path and filename that points to the desired text file on your computer.

The format of the text source path depends on whether the file will be accessed by WinMark Pro, or a 
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custom ActiveX application, (Windows OS) or by a Flyer head operating in Stand-alone mode (Linux 

OS). For Windows operations, pathnames must be written using a backslash (\) character; for example, 

C:\MarkFileFolder\TextFile.txt. For Linux operations, pathnames must be written using a forward slash 

(/) character; for example, /network/MarkFileFolder/TextFile.txt.

File Wrap

When No, WinMark marks each line in the file only once. If set to Yes, WinMark loops through the 

text file continuously.

Tip: Flyer/Fenix Flyer’s Circular File feature:

FH Flyer marking heads and Fenix Flyer Laser Markers have the ability to sequentially read up to 

ten specially named data (.txt) files. This feature provides the ability to update network data files 

using a third-party process while WinMark is marking another data file.

To setup this Circular File feature, simply create one to ten data files using the format: 

“filename.0.txt”, “filename.1.txt”, …, up through “filename.9.txt” (without quote marks); where 

filename can be any name, but must be the SAME name for all ten files. Enter the name of the 

first file in the list for ReadLineFromFile’s Filename property. After reading all lines of data in 

“filename.0.txt”, Flyer will open “filename.1.txt” and continue marking. If Flyer does not see the 

next logical index in the series, it loops back to “filename.0.txt” and continues marking. Note that 

while WinMark has a file open for marking, you can use a separate third-party process to update 

closed files without interfering with the mark process

ReadyStatus (Fenix Laser Markers only)

Note: The ReadyStatus event is a legacy support property not available when operating FH Flyer mark-

ing heads or Fenix Flyer Laser Markers.

Define an output signal (from either the Fenix Laser Marker or the FLCC) to parts handling equipment 

indicating that Fenix did not mark due to a fault. Bits labeled IGNORE are not changed. This command 

queries Fenix for status after completion of a mark and sends the user-defined output signal if the marking 

head is not ready due to an error.

Command Details:

PCI Card ID

Enter a card ID corresponding to the ID of the card used for the input/output (I/O) connection. Typi-

cally, this ID corresponds to the ID of the card used for controlling the marking head (see Tools/General 

Settings…/”Device” tab/Object Name). 

Output Bit 1

This output available only from the output connector on the FLCC.
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Output Bit 3

This output available only from the output connector on the FLCC.

Output Bit 4

Corresponds to OUT4 on Fenix/FH Series marking heads.

Output Bit 5

Corresponds to OUT5 on Fenix/FH Series marking heads.

Output Bit 6

Corresponds to OUT6 on Fenix/FH Series marking heads.

Output Bit 7

Corresponds to OUT7 on Fenix/FH Series marking heads.

RestoreProperty

Restore the specified target property’s value from a disk file. The disk file name is your mark file name ap-

pended with a .dat extension and is always located in the C:\Program Files\WinMark folder. Refer to the 

SaveProperty event for more detail.

Note: The RestoreProperty event is not available when operating in Flyer/Fenix Flyer stand-alone 

mode.

SaveProperty

Save the specified target property’s value to a disk file. The .dat file is always located in the C:\Program 

Files\WinMark folder. The disk file name is your mark file name appended with a .dat extension. When 

using automation or serialization in your mark file, SaveProperty / RestoreProperty events are useful to 

ensure your mark file always close and reopen with a known or default set of property values.

Note: The SaveProperty event is not available when operating in Flyer/Fenix Flyer stand-alone mode.

Tip: Multiple SaveProperty and RestoreProperty events can be defined for a single drawing. Even 

though the data is stored in a single .dat file, a separate entry is created for each Target Object and 

corresponding Target Property.

SetDigitalState

Set individual output bits on the FH Flyer marking head or Fenix Flyer Laser Marker to the specified 

values. Bits labeled IGNORE are not changed. See Chapter 11, Automation basics, for a table showing 

available outputs.
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Command Details:

Output Bit 0

Corresponds to OUT0 on Flyer/Fenix Flyer heads.

Output Bit 1

Corresponds to OUT1 on Flyer/Fenix Flyer heads.

Output Bit 2

Corresponds to OUT2 on Flyer/Fenix Flyer heads.

Output Bit 3

Corresponds to OUT3 on Flyer/Fenix Flyer heads.

Output Bit 4

Corresponds to OUT4 on Flyer/Fenix Flyer heads.

Output Bit 5

Corresponds to OUT5 on Flyer/Fenix Flyer heads.

Output Bit 6

Corresponds to OUT6 on Flyer/Fenix Flyer heads.

Output Bit 7

Corresponds to OUT7 on Flyer/Fenix Flyer heads.

WaitDigitalState

Wait for a specific input pattern to be read on FH Flyer marking head or Fenix Flyer Laser Marker inputs. 

Program execution continues if the required state is met before the specified timeout interval, if not, the 

mark will fail. Input bits labeled IGNORE are disregarded. See Chapter 11, Automation basics for a table 

showing available inputs.

Command Details:

Timeout MSecs

Use a short timeout value (milliseconds or tens of milliseconds) to complete the input status scan im-

mediately or enter a timeout value of –1, which forces WinMark to wait indefinitely for a valid match 

(or until the ESC key aborts the mark session).

Input Bit 0

Corresponds to IN0 on Flyer/Fenix Flyer heads.

Input Bit 1

Corresponds to IN1 on Flyer/Fenix Flyer heads.
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Input Bit 2

Corresponds to IN2 on Flyer/Fenix Flyer heads.

Input Bit 3

Corresponds to IN3 on Flyer/Fenix Flyer heads.

Input Bit 4

Corresponds to IN4 on Flyer/Fenix Flyer heads.

Input Bit 5

Corresponds to IN5 on Flyer/Fenix Flyer heads.

Input Bit 6

Corresponds to IN6 on Flyer/Fenix Flyer heads.

Input Bit 7

Corresponds to IN7 on Flyer/Fenix Flyer heads.
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18 ActiveMark™ (ActiveX®) 
technology

The ActiveMark (ActiveX) technology chapter includes sections:

 ActiveMark control overview

 XY coordinate system

 ActiveMark control events, properties, and methods

Important Note: When developing your automated control system using ActiveX® control methods, 

do not place input automation into the mark file. Instead, perform any input auto-

mation functions within the ActiveX control program. By doing this, your control 

program remains in charge of pre- mark and post-mark automation and WinMark’s 

MarkDrawing control method only maintains control of the operating system 

long enough to control laser on/off commands during the actual marking process. 

Performing input automation within the mark file may prevent the ActiveX control 

program from regaining control of the operating system if the specified input state 

does not occur.

Important Note: If the WinMark Pro v6 ActiveX control is drawn directly on a Visual Basic form, an 

instantiation error will occur in design mode unless you close the form before run-

ning your VB code. 

ActiveMark control overview
For best results, use the WinMark Pro application to layout drawing elements and then load and automate 

the drawing via the ActiveMark™ (ActiveX) control to create customized marking solutions. The custom-

ized WinMark Pro ActiveX control software usually does the following:

 Loads one or more WinMark Pro drawings into the control

 Operates in either WinMark control mode or Flyer stand-alone control mode

 Manipulates the objects in the drawings either through property modification, position, or transforma-

tions

 Synchronizes with custom part handling

 Marks the drawing

Most ActiveX control methods return a numerical or Boolean value to the calling program. Returned 

values are one of seven types:

BOOLEAN – returns a Boolean (1=True, 0=False) value to indicate if the command was successful.

FLOAT – returns a floating-point value.

INTEGER – returns an integer value.
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LONG – returns a long integer value.

SHORT – returns a short integer value.

STRING – returns an alphanumeric string.

VOID – no value returned by control method.

Sample Visual Basic® and Visual C++® code is provided in the WinMark\Samples\VisualBasicSample and 

WinMark\Samples\VisualCPlusSample folders respectively.

Additional VB code samples are available on the WinMark Pro web site at http://www.winmark.com/prod-

ucts/winmark_activexsamples.html.

Important Note: We strongly recommend that all mark files run under ActiveX control use inches as 

the unit of measure. The calling program must calculate the conversion to inches 

from other units of measure. Unpredictable object placement may result if the Show 

Units Type property in the mark file is set to millimeters or centimeters.

In order to be recognized by the Synrad WinMark control (.ocx), ActiveX control methods and prop-

erty names must be called using their internal name. These internal names are written without spaces in 

English. For example to add a text object with an Object Name and Text Caption when the Application 

Language is Spanish, you would follow this convention: 

mh.AddText “Objeto 1 Del Texto”, 0, 0, “Accionada por Synrad!”

To change the Text Caption of an object (when the Application Language is German) and then com-

mand WinMark to mark the text using two Mark Passes, follow this convention: 

mh.SetStringProp “Text1”, “TextCaption”, “Energie durch SYNRAD!”

mh.SetIntProp „Text1”, „MarkPasses”, 2

XY coordinate system
XY object positions specified in WinMark Pro are not Cartesian coordinates (refer back to Figure 4-7). On 

WinMark’s Drawing Canvas, X-coordinate values are negative to the left of the origin; positive to the right 

while Y-coordinate values are negative above the origin and positive below.

ActiveMark control events, properties, and 
methods 
For an up-to-date list of WinMark v6 ActiveMark events, properties, and methods, download our 

WinMark Pro v6 ActiveX Control document (PDF format) from the WinMark web site at: http://www.

winmark.com/products/winmark_activexsamples.html.

Note: Flyer and Fenix Flyer system parameters cannot be changed by ActiveX methods while the head 

is in a stand-alone mark session. System parameters may be changed only if the stand-alone head 

is idle.

http://www.winmark.com/products/winmark_activexsamples.html
http://www.winmark.com/products/winmark_activexsamples.html
http://www.winmark.com/products/winmark_activexsamples.html
http://www.winmark.com/products/winmark_activexsamples.html
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19 Flyer Modbus protocol
The Flyer Modbus protocol chapter includes sections:

 Register-based Modbus implementation

 User-defined Modbus implementation

 Modbus command documentation

FH Flyer marking heads and Fenix Flyer Laser Markers (running firmware version 3.08 or above), can be 

controlled remotely using the SYNRAD external Ethernet communications server (SynComm). Syn-

Comm operates over an Ethernet network using the Modbus® protocol and allows users to access various 

marking head functions via Flyer’s Ethernet port. There are two distinct “flavors” of SYNRAD’s Modbus 

implementation. The first is a basic set of register-based commands and the second is an extended set of 

commands using Modbus user-defined function codes. 

Register-based Modbus implementation
The register-based implementation uses Modbus function codes 3, 4, 6, and 16 that many PLCs support. 

Your Modbus master device (PLC) can read or write to dedicated registers in the Flyer/Fenix Flyer head 

to Get/Set I/O status, Get mark status, Get error codes, Get/Load mark files into RAM, Get/Set mark file 

properties, and Get/Set Flyer system parameters.

User-defined Modbus implementation
The user-defined function implementation provides an extended set of commands that includes advanced 

Filestore and head management options; however, user-defined Modbus functions are less widely supported 

by the PLC community. To use user-defined functions, your Modbus master device (PLC) must support 

Modbus user-defined function codes in the ranges of 65–72 or 100–110 hexadecimal.

With the user-defined implementation, there are three different protocols available: (1) a Modbus/IP pro-

tocol for interaction with Programmable Logic Controllers (PLCs) or other MODBUS network devices; 

(2) a Modbus-Asynchronous protocol (a SYNRAD-modified Modbus protocol) for peer-to-peer communi-

cations; and (3) a SmartFH protocol, provided as legacy support for customers who have upgraded exist-

ing FH Smart systems to FH Flyer and wish to continue using custom programs written specifically for FH 

Smart marking heads. 

Modbus command documentation
For complete details about using Modbus register-based or user-defined commands, see the WinMark Pro 

Application Note #5: Modbus® I/P Communication Protocol for Controlling Flyer/Fenix Flyer Marking Heads 

located on the WinMark web site at: http://www.winmark.com/products/winmark_ApplicationsNotes.

html. This document describes all the information necessary to control an FH Flyer marking head or Fenix 

Flyer Laser Marker using Modbus protocols including detailed descriptions of the SynComm/Modbus 

packet structure and all of the Flyer/Fenix Flyer commands available through SynComm. 

In addition, refer to http://www.winmark.com/products/winmark_activexsamples.html on the WinMark 

web site for sample Visual Basic and Visual C++ code illustrating how to easily incorporate Flyer’s Modbus 

functionality into your custom marking application.

http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.winmark.com/products/winmark_activexsamples.html
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20 Troubleshooting
The Troubleshooting chapter includes sections:

 Flyer/Fenix Flyer

 Stand-alone mode

 Tracking mode 

 Automation I/O 

 Graphics imports 

 ActiveMark 

 Laser Marking FAQ 

 Resources 

Flyer/Fenix Flyer

Symptom:

 Flyer/Fenix Flyer and WinMark Pro are connected via USB, WinMark is open, and Flyer/Fenix Flyer 

is powered up, but the Mark button (and the “Device” (Flyer) tab) display “Device ID 0” and do not 

indicate an active Flyer device.

Possible Causes:

 Communication between Flyer/Fenix Flyer and WinMark Pro is not synchronized and WinMark has 

recognized, and defaulted to, a Fiber Link Controller Card (FLCC) previously installed in the marking 

computer.

Close and then re-open WinMark Pro while the Flyer/Fenix Flyer head is powered up. This action forces 

WinMark Pro to re-initialize communications with Flyer. If communication is not established after this 

step, then close WinMark, power down the Flyer/Fenix Flyer head, wait 30 seconds, and then reapply 

power. Wait another 30 seconds for the Flyer/Fenix Flyer head to re-boot and then open WinMark Pro.

Symptom:

 WinMark Pro v6 is installed, Flyer/Fenix Flyer is powered up, and the USB Communication cable is 

connected between Flyer/Fenix Flyer and the computer, but WinMark Pro v6 does not “see” the Flyer 

head. The “Search for heads again” option does not locate the head, forcing WinMark Pro v6 to open 

in demo mode with the Mark button grayed out.

Possible Causes:

 FH Flyer’s USB device driver is not installed. 

Important Note: Before installing, re-installing, or upgrading WinMark, make sure the Flyer/Fenix 

Flyer head is powered down or the USB cable is disconnected. If the head is on and 

connected, Windows will assign a generic USB driver or fail to update the Flyer 

device driver.
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In the Windows® Control Panel, open the Add Hardware Wizard and follow the instructions to scan for 

new Devices and install the appropriate Device Drivers. If this fails, restart your computer and/or reinstall 

WinMark Pro v6 Laser Marking Software. The first two screen shots in Figure 20-1 show that a hardware 

device exists, but a corresponding driver is not installed. The screen shot on the right-hand side shows the 

Flyer Laser Marking Device is properly installed and functioning.

Figure 20-1  Windows Device Driver displays 

Symptom:

 Flyer/Fenix Flyer is powered up and connected to WinMark Pro v6 via USB, WinMark is open, but 

the Mark button is grayed out and does not indicate an active device.

Possible Causes:

 Communications between Flyer and WinMark Pro are not synchronized.

In WinMark Pro, under the Devices menu, chose Flyer USB and select the appropriate Flyer/Fenix Flyer 

device. If a Flyer device is not available or the selection is grayed out, close and then re-open WinMark 

Pro while the Flyer head is powered up. This action forces WinMark Pro to re-initialize communications 

with Flyer/Fenix Flyer. If communication is not established after this step, then close WinMark, reboot 

your computer, power down the Flyer/Fenix Flyer head, wait 30 seconds, and then reapply power. Wait 

another 30 seconds for the Flyer/Fenix Flyer head to re-boot and then open WinMark Pro. 

Symptom:

 The laser mark produced by Flyer/Fenix Flyer is much larger or much smaller than the image drawn on 

WinMark Pro’s Drawing Canvas.

Possible Causes:

 The lens size specified in WinMark Pro does not match the lens installed on Flyer/Fenix Flyer.



WinMark Pro v6.3 User Guide

199Commands & Properties  

Chapter 20 – Troubleshooting 

Check that the lens specified in WinMark Pro matches the lens currently installed on Flyer/Fenix Flyer. 

In WinMark, go to the Tools menu, select General Settings… , and then click the “Device” (Flyer) tab. 

Check the Lens property to ensure the chosen lens is from the FH/Flyer list.

Symptom:

 No marks or very light marks appear on the part.

Possible Causes:

 The part is not positioned at the point of focus.

Locate the Final Test Report shipped with your marking head to determine the actual working distance of 

the focusing lens. Measure working distance from the bottom of the focusing lens mount to the surface of 

the part to be marked. Adjust the Z-axis of the mounting platform or the marking surface as required to 

obtain the correct working distance.

Symptom:

 Mark quality deteriorates over time and/or laser power must be increased to maintain mark quality.

Possible Causes:

 The focusing lens has become coated with marking debris or vapor.

Carefully inspect and clean the lens as described in the Maintenance/Troubleshooting chapter of the FH 

Flyer Marking Head Operator’s Manual or the Fenix Flyer CO
2
 Laser Marker Operator’s Manual.

Symptom:

 The Flyer/Fenix Flyer head is powered up, but no mark is made when the Test Mark pushbutton is 

pressed or when marking is commanded through WinMark Pro.

Possible Causes:

 The laser is not enabled.

Check that the laser’s Ready light is illuminated. On Fenix Flyer, Series 48, and Evolution lasers, check 

that the Lase indicator is glowing dimly (tickle mode) and that it appears brighter (lasing mode) as the 

mark is made. On Firestar lasers, check that RDY (Ready) and SHT (Shutter) indicators are lit and that 

the LASE indicator illuminates as the mark is being made. Refer to your laser’s Operator’s Manual if indi-

cators do not illuminate as described.

 The Laser Control cable is not connected between the laser and the Flyer marking head.

Refer to Connecting in the Getting Started chapter of the FH Flyer Marking Head Operator’s Manual for 

information on connecting the Laser Control cable between Flyer and your particular laser.

 The Fast Acting Safety Interlock (FASI) feature is enabled.

When the FASI feature is enabled (If the FASI Enable property on the “Device” (Flyer) tab under Tools/

General Settings… is Yes), then you must apply a 5 V–24 VDC signal on input IN3 to fire the laser.
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Symptom:

 Flyer is not marking properly or there are indications of operational faults within the head.

Possible Causes:

 Flyer/Fenix Flyer has, or is experiencing, one or more fault or error conditions.

Before contacting SYNRAD Technical Support, download and review Flyer’s Error Logs. To do this, go to 

the Tools menu in WinMark Pro, highlight Get Flyer Head Logs, and select Main Message Log. WinMark 

prompts you for a location in which to save the .log file (the default is the WinMark installation folder – 

C:\Program Files\WinMark). After the file is saved to your hard drive, it opens to display a recent history 

of Flyer operation.

Stand-alone mode

Symptom:

 Flyer/Fenix Flyer does not respond to WinMark Pro. The Filestore window displays few, if any files, 

and the blue starburst icon (the stand-alone Mark button) is flashing on-off. 

Possible Causes:

 The Flyer/Fenix Flyer head is in a stand-alone mark session—either actively marking or waiting for an 

input.

To abort the mark session, press the ESC key on the marking computer’s keyboard.

Symptom:

 The Flyer/Fenix Flyer head is powered up, but the head will not connect to and communicate with 

WinMark Pro through Ethernet or USB connections. 

Possible Causes:

 Flyer will not connect to Ethernet or USB ports while waiting for an input during a stand-alone mark 

session.

Press the ESC key on the marking computer’s keyboard to abort the mark session. If Flyer/Fenix Flyer fails 

to respond, disconnect power from the head and then attach the appropriate Ethernet or USB connection 

between Flyer and your computer. Re-apply power to Flyer/Fenix Flyer. When the head boots up, it will 

re-establish communication with the computer before beginning the stand-alone mark session.

Tracking mode

Symptom:

 FH Flyer/Fenix Flyer does not track moving parts.

Possible Causes:

 Tracking is not enabled.

In WinMark Pro v6, check that Track Marking Object (on the Drawing object’s Marking tab) is Yes.
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 Encoder pulses are not being read by the Flyer/Fenix Flyer head.

Close WinMark Pro and open Digital Scope (DigScope.exe). Rotate the conveyor or position encoder and 

verify that input IN1 and input IN2 toggle as the encoder rotates through its range of motion.

 The part sensor signal is not being read by the Flyer/Fenix Flyer head.

Close WinMark Pro and open Digital Scope (DigScope.exe). Trigger the part sensor and verify that input 

IN0 toggles as the part sensor activates.

 Part movement is not being sensed in the proper direction.

In WinMark Pro, toggle the Invert Encoder Direction property on the “Device” (Flyer) tab under Tools/

General Settings… .

 A physical part sensor is not installed.

Enable the Internal Part Trigger property on the “Device” (Flyer) tab under Tools/General Settings… and 

then enter a Part Pitch value.

 A position encoder is not installed.

Enable Encoderless Tracking on the “Device” (Flyer) tab under Tools/General Settings… and then enter a 

Product Line Speed value equal to conveyor or part velocity.

Symptom:

 Characters or graphics within the mark are missing.

Possible Causes:

 The mark is not being completed within the extents of the Tracking Window.

Open the mark file in WinMark Pro and ensure that the mark is positioned as close to the upstream edge 

of the Drawing Canvas as possible. 

 Line speed is set too fast.

Lower line speed.

 The mark is being made too slowly for the required line speed.

Open the mark file in WinMark Pro and do the following: (1) shorten mark time by changing fonts, 

decreasing font size, or reducing line spacing; (2) simplify or eliminate graphic objects in the mark; or (3) 

reduce graphic object size or resolution.

Symptom:

 Tracking marks are skewed or distorted.
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Possible Causes:

 The Encoder Resolution value is set improperly.

Load and mark the appropriate linestackxxx.mkh file (located in the WinMark software folder). Refer to 

Tracking hardware - position encoder in the Tracking chapter in the FH Flyer Marking Head Operator’s Man-

ual or the Fenix Flyer CO
2
 Laser Marker Operator’s Manual for instructions on how to fine-tune encoder 

resolution settings.

 The Product Line Speed value is set improperly.

If Encoderless Tracking is specified, check that Product Line Speed on the “Device” (Flyer) tab under 

Tools/General Settings… is equal to conveyor or part velocity. Adjust Product Line Speed as required to 

fine-tune tracking to actual part motion.

 Line speed is set too fast.

Lower line speed.

 The actual part motion vector is different from the value entered as the Motion Vector.

Check that actual part motion under the marking head equals the entered Motion Vector on the “Device” 

(Flyer) tab under Tools/General Settings…. WinMark Pro v6 and FH Flyer/Fenix Flyer support Motion Vec-

tor values in 0.01° increments.

Automation I/O

Symptom:

 The Flyer/Fenix Flyer head is not responding to automation inputs or the automation controller is not 

“seeing” Flyer/Fenix Flyer outputs.

Possible Causes:

 I/O voltage levels are incorrect.

Verify that I/O signals are in the correct voltage range of 5 V to 24 VDC for Flyer/Fenix Flyer heads. Use a 

voltmeter to measure your I/O signals while they are connected to Flyer’s DB-25 User Interface connector 

or Fenix Flyer’s DB-25 Marking Head I/O connection.

Note: Flyer’s input/output voltage range is different from previous FH heads (Index/Tracker) where the 

allowable voltage range was 15 V–40 VDC. Flyer/Fenix Flyer I/O voltages must be in the range of 

5 V–24 VDC.

 I/O wiring is not properly connected to the marking head.

Double-check field wiring to ensure that input/output signals are routed to the correct pins on the User 

Interface/Marking Head I/O connector and that their respective return (ground) paths are wired to the 

proper pins. Refer to the Technical Reference chapter in the FH Flyer Marking Head Operator’s Manual 

or the Fenix Flyer CO
2
 Laser Marker Operator’s Manual for information about connecting signals to/from 

Flyer/Fenix Flyer. This section also contains information about converting an existing FH Index or Tracker 

system for Flyer-compatibility.
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Important Note: Flyer’s DB-25 User Interface/Marking Head I/O connector pinout does not match the 

pinout on the FH Smart DB-25 Parts Handling Control connector.

Use Digital Scope (DigScope.exe), shown in Figure 20-2, to verify proper I/O functionality between Flyer/

Fenix Flyer and the automation controller. Digital Scope’s input “buttons” pop-in as an input is activated 

(when the correct voltage level is applied). Press an output “button” to activate an output.

Figure 20-2  Synrad Digital I/O Scope dialog box 

Graphics imports
The Graphics imports section includes subsections:

 Vector graphics

 Bitmap graphics

Vector graphics

Symptom:

 The vector import filter dialog box appears, but when the progress bar ends and the dialog closes there 

is no import object on the Drawing Canvas and no additional objects are listed in the Object List.

Possible Causes:

 The graphics file was created and saved using a newer version of software than is supported by Win-

Mark’s File Import Filters.

Open the graphics file using the graphics program that originally created it. Use the program’s “Save As…” 

or “Export” command to resave the file in an older format. Refer to the SupportedFileFormats document on 

the WinMark Pro web site for a list of compatible graphics formats and versions. For example, you create 

an EPS graphics file using Adobe® Illustrator® version 10. Current WinMark Pro File Import Filters only 

import EPS files created in versions 4.0 through 7.0. You must resave the file in an Illustrator version 7.0, 

or earlier, format in order to import the file. 
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To import vector files from more recent programs such as AutoCAD 2008 or Adobe® Illustrator® CS3, 

WinMark Pro v6 provides Copy/Paste and Drag/Drop functionality. This feature allows you to Copy or 

Drag a graphic from your open drawing program and Paste or Drop it onto the Drawing Canvas. Because 

graphics files often contain multiple data formats internally, a dialog box opens when more than one ac-

ceptable format is available. In general, choose Vector Image for best marking results.

Bitmap graphics

Symptom:

 Imported bitmap graphics are rescaled when imported into WinMark Pro.

Possible Causes:

 The graphics file was created and saved at a resolution other than the Resolution setting specified on 

the Tools/General Settings…/Object Defaults tab.

WinMark Pro does not resample bitmap images during importation. WinMark Pro “expects” imported 

bitmaps to match the Resolution setting shown on the Tools/General Settings…/Object Defaults tab; if not, 

then image size is increased or decreased accordingly – the change in image size is inversely proportional to 

the change in image resolution. 

Figure 20-3 shows the results of importing three filled squares when WinMark’s default Resolution is set to 

600. Each square measured one inch by one inch when drawn and was separately imported into WinMark 

Pro in a .TIF (bitmap) format. The square on the left is saved at 600 DPI and imports as designed; it 

measures one-inch across. The center square is saved at 300 DPI. Since the resolution increased by a factor 

of two to 600 DPI during importation, image size decreased by a factor of two. This imported square now 

measures one-half inch on a side. The right-hand square illustrates the third case. This time, the one-inch 

square is saved at 900 DPI and then imported into WinMark Pro. Since image resolution decreased by 

67% during importation (600/900), image size increased by a factor of 1.5 (1/.67). The imported square 

now measures one and one-half inches on a side.

Figure 20-3  Bitmap image size/resolution comparison

Note: Older versions of WinMark Pro increased or decreased bitmap image size corresponding to a fixed 

bitmap resolution of 600 DPI.
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Symptom:

 Color bitmap mark quality is not as good as expected.

Possible Causes:

 The Color Reduction Method property is not optimized.

Because laser marking (with the exception of the 8-bit Grayscale Color Reduction Method) is a mono-

chrome–black and white or on/off–process, color or continuous-tone bitmaps are converted to 1-bit images 

when imported. This conversion is accomplished using Bayer Dithering, Error Diffusion, or Halftone algo-

rithms. These algorithms create the illusion of color or continuous-tone by varying the size, shape, and/

or spacing of the dots making up the image just as books, newspapers, and magazines do. WinMark Pro v6 

retains a copy of the original bitmap image in memory after importation. After changing bitmap Resolu-

tion and/or resizing the image, use the Color Reduction Method property (on the Format tab) to change 

the color reduction algorithm as required. Although WinMark Pro now displays a more accurate view of 

actual mark quality, test marking is still recommended.

Use the Grayscale Color Reduction Method to mark true 8-bit images. An 8-bit grayscale image provides 

256 levels of gray ranging from 0 (white) to 255 (black). WinMark Pro reproduces grayscale images by al-

locating 255 levels between the Min Power Threshold and the specified Power percentage. The Grayscale 

Color Reduction Method can be used to reproduce fine images on “hard” surfaces or to engrave “softer” 

materials.

 The Resolution property value is not correct.

When marking bitmap (raster) images, set a Resolution value that corresponds to the spot size of the fo-

cusing lens. For example, a 200 mm focusing lens with a spot size of 0.011” is capable of marking approxi-

mately 91 discrete microvectors per inch. As a rule, set bitmap Resolution equal to 200 when using an 80 

mm lens; 143 for a 125 mm lens; 91 for a 200 mm lens; and 48 when marking with a 370 mm lens. Higher 

Resolution values cause raster scan lines to overlap; the higher the Resolution, the greater the overlap. 

Start with the minimum specified Resolution for the selected lens and, if necessary, increase Resolution in 

multiples of the recommended values such as 2×, 3×, etc). 

Symptom:

 When importing a metafile (a graphics format containing both vector and raster graphics) into 

WinMark Pro the last raster object to import is “garbled”.

Possible Causes:

 An incompatibility exists with Windows® 2000 and Windows® XP operating systems.

Edit the graphics file so that vector and bitmap objects import separately.
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ActiveMark

Symptom:

 The ActiveX® application appears to “freeze” after the MarkDrawing method is called.

Possible Causes:

 Input automation commands are specified in the .mkh mark file.

Performing input automation within the mark file may prevent the ActiveX application program from 

regaining control of the operating system if the MarkDrawing method is called and input signals are not 

available. Set up input automation functions within the ActiveX application (not in the .mkh file) so that 

your application or user-interface remains in charge of all pre-mark and post-mark automation. WinMark 

Pro’s MarkDrawing method should only maintain control of the operating system long enough to control 

laser on/off commands during the actual marking process.

Symptom:

 The WinMark Pro ActiveX control is not available after upgrading to a newer version of WinMark 

(Microsoft® Visual C++® only).

Possible Causes:

 WinMark Pro’s ActiveX control was not updated in the MS Visual C++ project.

After installing (or upgrading), WinMark’s ActiveX control must be added (or updated) in the Visual C++ 

project. See Adding ActiveX controls.pdf on the WinMark web site for instructions on adding or updating 

ActiveX controls in Visual C++. Remember that the C++ application must be built to include the new 

control changes.

Laser Marking FAQ 
SYNRAD’s Laser Marking FAQ is available for downloading or browsing from the WinMark Pro web site 

at http://www.winmark.com/. You can also access the Laser Marking FAQ directly from WinMark by click-

ing Help/Synrad WinMark FAQ. Our Frequently Asked Questions database answers many common mark-

ing questions in categories including General troubleshooting, WinMark Pro automation, Tracking operation, 

ActiveX, and others. The Laser Marking FAQ also includes links to various SYNRAD technical bulletins.

Resources 
See the Release Notes provided with each build of WinMark Pro for the latest information on new features, 

bug fixes, and miscellaneous issues.

Our WinMark Pro Application Notes provide detailed information on a variety of laser marking topics. 

See the WinMark web site at http://www.winmark.com/products/winmark_ApplicationsNotes.html for a 

complete listing.

Your SYNRAD Regional Sales Manager can provide reference materials including Outline & Mount-

ing drawings, Operator’s Manuals, Technical Bulletins, Application Newsletters, and much more. Most 

of these materials are also available directly from SYNRAD’s web site at http://www.synrad.com/, the 

WinMark Pro web site at http://www.winmark.com.

http://www.winmark.com/
http://www.winmark.com/products/winmark_ApplicationsNotes.html
http://www.synrad.com/
http://www.winmark.com
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Symbols

1-bit images  84, 175, 205

1D bar codes

creating,  31, 51

2D Barcode Bitmap property  116, 153

description,  115, 172

2D Barcode Cell Size property

description,  115, 171

2D Barcode Circle Radius property  52, 154

description,  116, 172

2D Barcode Fixed Cell Size property

description,  115, 171

2D Barcode Inverted property

description,  115, 172

2D Barcode object  109, 144, 156

2D Barcode Quiet Zone property

description,  115, 172

2D Barcode Rounding Percentage property

description,  116, 172

2D Barcode Shape property

description,  116, 172

2D Barcode Style property  31, 52

description,  116, 172

2D Barcode Text property  27, 31, 52, 173

description,  171

2D Code format properties  171–173

2D codes  145

creating,  31, 52

2D Code Tool  31, 52

description,  27

2D code types  52

8-bit images  84, 175, 176, 205

.BMP file  49, 86, 168

.CDR file  84

.CGM file  49

.DAT file  191

.DXF file  49, 50, 84, 86

“units” information,  83

.EMF file  83, 84

.EPS file  32, 49, 84, 203

.FHZ file  100

.JPG file  86

.LOG file  95, 200

.MKH mark file  15, 21, 86, 95, 102, 103, 130, 

 206

.NET framework  5, 12, 13

.OCX file  75, 77, 195

.OTF file  110

.PFB file  110, 159, 170

.PS file  86

.SYF file  110

.TIF file  49, 204

.TTF file  110, 159

.TXT file  141, 142, 190

.WMF file  49, 84

A

About Synrad WinMark dialog box  99–100

About Synrad WinMark... menu command

description,  99–100

Head Info button,  100

temperature status,  100

ActiveMark  16, 19, 56, 64, 76, 101, 118

basics,  74

control overview,  194–195

control updating,  206

events,  74, 195

input automation note,  74, 194

introduction,  74

loading C++ control,  76–77

loading VB control,  75

methods,  195

OCX file,  75, 77, 195

properties,  195

sample projects,  77

trademark,  xiv

units of measure note,  19, 77, 103, 195

white paper,  74

troubleshooting,  206
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ActiveMark (ActiveX) technology chapter    

 194–195

ActiveMark automation chapter  74–77

ActiveX. See ActiveMark

Add Format button  140

Agency compliance. See Compliance

Align button  22

Align... menu command

description,  90

shortcut button,  22, 90

Align Objects dialog box  90

Allow External Part Trigger property

description,  126

All tab  28, 130, 136

Drawing properties,  135

Object properties,  178

American National Standards Institute (ANSI)   

 LS-2, LS-3

Application Language property  195

description,  104

Application Notes  101, 206

Application properties  94, 101

Application Settings

Application Settings tab,  102–104

“Device” (Flyer) tab,  118–130

Drawing defaults tab,  104–106

Object Defaults tab,  106–117

Application Settings chapter  102–130

Application Settings dialog box  18, 19

Application Settings tab  19, 26, 82, 87, 94

properties,  102–104

Arc Clock Wise property

description,  165–166

Arc End property  166

description,  164–165

Arc Filled property

description,  165

Arc format properties  164–166

Arc Mark Outline property

description,  165

Arc Outline Power property

description,  165

Arc Radius property

description,  164

Arc Start property  165, 166

description,  164

Arc Tool  25, 32

description,  27

Array Angle property  59

description,  157

Array Columns property  58

description,  157

Array format properties  58, 157

Array Rows property  59

description,  157

Ask Mark Count property

description,  135

Ask Starting Serial property  137

description,  138

AskUserInput Event Builder command  180

Default Text,  180

description,  179–180

Use Default,  179

User Input dialog box,  179

User Prompt,  179

AssignDate Event Builder command

Date Format,  180

description,  180–181

Assign Date Format property  139

description,  140–141

Assign From property  114, 146, 170

description,  144

Assign UID/Composite property

description,  145

Association for Automatic Identification and  

 Mobility (AIM)  169

Automation  61–73

additional peripheral cards,  61

basic automation sequence,  64–68

event sequence,  64–68

inputs,  62
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I/O configuration,  61–63

I/O voltage levels,  63, 202

multiple marking heads,  61

outputs,  62–63

serialization,  69–73

state diagram,  65

system configuration,  61

troubleshooting,  202–203

Automation basics chapter  61–73

Automation events  130–133

Automation flowchart  56, 64, 72, 130, 188

illustration,  101

Automation Flowchart menu command

description,  101

Automation List  71

Automation tab  28, 56, 63, 64, 65, 66, 69, 71,  

 72, 114, 135, 136, 139, 141, 142, 143,  

 144, 145, 178, 182, 186, 188

description,  130–133, 137–146

Drawing properties,  130–135

Object properties,  137–146

Auto Text File Wrap property  141

description,  142

Auto Text Type property  69, 146, 158, 167,  

 184, 189

 description,  137–145

Auto Text Within Array property

description,  145

Auto Text Without Marking property

description,  145–146

B

Banner Marking property  104, 130

description,  134

Banner Tracking Angle Adjustment property

description,  125

Banner Window Interval property

description,  134

Banner View Size property

description,  104

Barcode Checksum property

description,  113, 169

Bar Code format properties  167–171

Barcode Height property

description,  113, 168

Barcode Inverted property  51, 52

description,  168

Bar code library  51, 113, 168

Barcode Number property  27, 31, 51, 114,  

 169, 170

description,  167

Barcode object  109, 144, 156

Barcode Quiet Zone Size property

description,  113, 168

Barcode Resolution property  51, 53, 109, 169

description,  168

Bar codes  31, 51–52

supported formats,  168

Barcode Show Text property  51, 169

description,  113–114, 170

Barcode Style property  31, 51, 169

description,  113, 168

Barcode Text Font property

description,  114, 170

Barcode Text Position property

description,  114, 170

Barcode Text Size property

description,  114, 170

Barcode Thick to Thin Ratio property

description,  114, 171

Barcode Thin Width property

description,  113, 168–169

Bar Code Tool  31, 51

description,  27

Basic concepts, WinMark Pro  16

Basic Operation section  43–77

Batch marking  58–60

Bayer Dithering, Color Reduction Method  84,  

 175, 205

Bi-Directional Raster property  46, 109, 116,  

 156, 177

description,  110, 153
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Bitmap format properties  174–178

Bitmap graphics

resizing,  84, 149, 176

resolution,  109, 176, 204

troubleshooting,  204–205

Bitmap Inverted property  148

description,  174–175

Bitmap object  109

rotation,  91

Bitmap Raster Delay property

description,  123

Bitmap resolution  109, 176, 204

Bitmap Scan Type property  153

continuous,  110, 116, 123

description,  116, 177

normal,  116

BMP file  49, 86, 168

C

CallDLLFunc Event Builder command

description,  181–183

DLL Filename,  181

Function Name,  181

User Arg #1,  181

User Arg #2,  181

User Arg #3,  182

Cascade menu command

description,  98

Caution

definition,  LS-1

Center for Devices and Radiological Health  

 (CDRH)  LS-3,  LS4–LS5

CDR file  84

Center button  22

Center on Field menu command  59

description,  91

shortcut button,  22, 91

CGM file  49

Choose Import Type dialog box  83

Circle object  84, 149

creating,  32

Circular File feature

description,  142, 190

Clearing Day of Month property

description,  139

Clearing Day of Week property

description,  139

Clearing Hour property

description,  139

Clearing Interval property  137

description,  139

Clearing mark  127

Clearing Mark Interval property

description,  127

Clearing Mark On Begin Mark Session property  

description,  127

Clearing Minute property

description,  139

Clearing Month property

description,  139

Clipboard  88

Close Comport After Read property  142

description,  143

Code of Federal Regulations (CFR)  LS-2,  

 LS-4, LS-5

Color Reduction Method property  174, 177

Bayer Dithering,  84, 175, 205

Color images,  175–176

description,  175

Error Diffusion,  84, 175, 205

Grayscale,  84, 116, 175, 176, 177, 205

Grayscale images,  176–177

Halftone,  84, 175, 205

Column Spacing property  59

description,  157

Command line switch  36

Commands & Properties section  79–206

Compliance  LS-4–LS-6

CDRH,  LS-4–LS-5

EU,  LS-5–LS-6

FCC,  LS-5

Com Port Timeout property  142
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description,  143

Composite code  145

Configure Marking Order dialog box  92

Connect to Ethernet Flyer menu command

description,  98

Contact information  xvi

Control modes

Stand-alone control mode,  16

Stand-alone Master Control File,  17

WinMark control mode,  16, 73

Coordinate system  27

Copy button  21

Copy menu command

description,  88

shortcut button,  21, 88

Copy/Paste functionality  83, 204

Copyright information  xiv, 99

Creating a drawing chapter  30–34

Cross-hatching  84

CTRL key  26, 89

“current active file” menu command

description,  98

Current Head File property

description,  119

Current Saved Value property  70, 137, 158,  

 167

description,  139

Customer Service  xvi

Custom Test Mark... menu command

description,  95

Cut button  21

Cut menu command

description,  88

shortcut button,  21, 88

D

Danger

definition,  LS-1

explosive atmospheres,  LS-2

eye protection,  LS-1

immediate lasing,  39

laser radiation,  LS-1, 39, 45, 57, 60, 72

Data Input Mode property

description,  116, 173

Data Matrix code  27, 52, 116

Data Matrix code format  171, 172

Date Code Text property  137, 146

description,  139–141

Date Format Customization dialog box  140,  

 181

DAT file  191

Default Mark File Directory property

description,  103

Define Shifts button  140

Delay properties  53, 149–153

Delete menu command

description,  88

Demo mode  73

Device drivers  14, 197, 198

“Device” (Flyer) tab  18, 23, 24, 27, 29, 94,  

 100, 102, 130, 197, 199, 201, 202

all properties,  118–130

I/O properties,  129

interface properties,  118–120

maintenance properties,  127

set-up properties,  121–124

stand-alone properties,  128–129

tracking properties,  124–126

Device Simulation dialog box  17, 35

Devices menu  97, 198

Connect to Ethernet Flyer,  98

FH/Fenix,  98

Flyer Ethernet,  97

Flyer USB,  97

“Device” tab. See “Device” (Flyer) tab

DHCP  119

note,  119

Digital Scope  12, 14, 30, 37, 201, 203

description,  41

display,  41



Index  212

WinMark Pro v6.3 User Guide

Duty Cycle Slider,  42

icon,  41

Input Bit Status,  41

Lase On/Off,  42

Laser Timeout:,  42

Output Bit Status,  42

Disk File Text (Fixed) property  137, 188

description,  144

Disk File Text (Seq) property  137, 188

description,  141–142

DNS Server IP Address property

description,  120

DoBeep Event Builder command

description,  183

DoPause Event Builder command

Delay (msecs),  183

description,  183

Drag and drop functionality  83, 204

Drawing  28, 57, 59, 63, 66, 70, 71, 105, 110,  

 130, 133, 178, 182, 186

creating,  30–34

modifying,  40

opening,  39

Drawing Canvas  16, 17, 18, 21, 22, 24, 25,  

 26, 27, 28, 30, 31, 32, 33, 35, 36, 47,  

 48, 49, 57, 59, 70, 82, 83, 86, 90, 91,  

 92, 93, 103, 104, 105, 107, 108, 112,  

 117, 121, 122, 125, 130, 133, 134,  

 136, 137, 147, 148, 149, 154, 158,  

 182, 186, 195, 198, 201, 203, 204

description,  27–28

Drawing Defaults tab  94

properties,  104–106

Drawing Editor  12, 37, 40, 57, 58, 103

description,  20–29

Drawing Canvas,  27–28

Flyer Filestore,  28

Help Window,  29

Main Window,  20

Mark button,  23

Object List,  28

Property List,  28–29

Slide Bar,  28

Stand-alone Toolbar,  23

Status Bar,  29

Toolbar,  21–22

Tool Box,  25–27

Drawing object  28, 71, 130, 182, 200

Drawing properties  94, 102, 104

All tab,  135

Automation tab,  130–133

Marking tab,  133–135

Tracking tab,  130

Drawing properties chapter  130–135

Draw Tools menu command

description,  93

Duplicate menu command

description,  88

Duty Cycle Slider  42

DWG file  3

“units” information,  83

DXF file  3, 49, 50

“units” information,  83

Dynamic Host Configuration Protocol   

 See DHCP

E

Edit commands  87–88

Edit menu  18, 87–88, 89

Copy,  88

Cut,  88

Delete,  88

Duplicate,  88

Paste,  88

Redo,  87

Select All,  88

Undo,  87

Emergency Off pushbutton  123

EMF file  83, 84

Enable Abort Input (Input 7) property

description,  129

Enable Marking Head Ready Output (Output 6)  

property

description,  129

Encoderless Tracking property  201, 202

description,  126
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Encoder Resolution property  202

description,  125

“end mark” signal  132, 135

End of data delimiter  141, 142, 143, 144, 188,  

 189

Enter key  30

Enter Password dialog box  17, 40, 103

EPS file  32, 49, 203

Error Correction Mode property

description,  116, 172

Error Diffusion, Color Reduction Method  84,  

 175, 205

Error Logs  200

ESC key  45, 56, 70, 133, 135, 143, 185, 189,  

 192, 200

Ethernet IP Address or Host Name property

description,  119

Ethernet MAC Address property

description,  119

Ethernet port,  25, 97, 128, 196

Ethernet security  96

Ethernet security password  96

Ethernet to Serial Converter IP Address prop-

erty

description,  128

EU requirements  LS-5–LS-6

Event 0  65

description,  66

Event 1  65

description,  67

Event 2  65

description,  67

Event 3  66

description,  68

Event 4  66

description,  68

Event Builder  64, 70, 182

Event Builder commands  130, 179–193

AskUserInput,  179–180

AssignDate,  180–181

CallDLLFunc,  181–183

DoBeep,  183

DoPause,  183

IncSerial,  184

MarkingHeadOn,  184

MatchDigitalState,  147, 185–188

ReadFromSerialPort,  188–189

ReadLineFromFile,  189–190

ReadyStatus,  190–191

RestoreProperty,  191

SaveProperty,  191

SetDigitalState,  191–192

WaitDigitalState,  192–193

Event Builder commands chapter  179–193

Event Builder dialog box  131, 132, 133, 179,  

 182, 187, 188

Event sequence  64–68

Execute Auto Text When property  144, 145

description,  146

Exit menu command

description,  87

Explode menu command  84, 147

description,  90

Exporting mark file  86

External Communications Server property

description,  128

Extra Char Spacing property

description,  113, 162

European Union (EU) requirements

laser safety,  LS-5–LS-6

electromagnetic interference,  LS-6

F

F1 key  16, 23, 39, 56, 86, 87

FASI Enable property  199

description,  123

Fast Acting Safety Interlock (FASI)  42, 45, 123,  

 131, 199

description,  63–64

Fast Preview check box  38
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Federal Communications Commission (FCC)   

 LS-4

caution to the user,  LS-5

requirements,  LS-5

Fenix

trademark,  xiv

Fenix Flyer Filestore. See Filestore

FH/Fenix menu command

description,  98

Fiber Link Controller Card (FLCC)  4, 6, 63, 64,  

 98, 184, 190, 197

Field Height property  27, 121, 122

description,  123

Field Offset X property

description,  105, 134

Field Offset Y property

description,  105, 134

Field Rotation property

description,  105, 134

Field Scale X property  135

description,  106, 134

Field Scale Y property  135

description,  106, 134

Field Transform Org X property

description,  105, 134

Field Transform Org Y property

description,  105, 134

Field Width property  27, 121

description,  122

File commands  81

File development chapter  35–36

File Import Filters  14, 82, 83, 84, 112, 203

supported file types,  85

File import notes  83–85

File Import Tool  49, 50

File menu  30, 32, 39, 40, 73, 81–87

Exit,  87

Import...,  82

Mark...,  86

New,  81

Open...,  82

Print All Properties...,  82

Print Drawing...,  82

Quick Mark,  86–87

“recent file”,  87

Save,  82

Save As...,  82

Save File to Head,  82

Filestore  13, 16, 24, 25, 28, 29, 35, 40, 70,  

 82, 93, 128, 138, 160, 161, 200

Filled Font Resolution property  48, 53, 55,  

 159

description,  161

Fill types  84, 85

Final Test Report  199

Firestar

trademark,  xiv

Fixed To Position property

description,  156

FLCC. See Fiber Link Controller Card

Flowchart

automation,  101

mark session,  56

Flyer

boot-up time,  17, 197, 198

Flyer Ethernet menu command

description,  97

Flyer Files menu command  28

description,  93

Flyer Filestore. See Filestore

Flyer Filestore window  29

description,  28

Flyer IP Address Range menu command

description,  96

Flyer IP Address Ranges dialog box  96

Flyer Kernel Version property

description,  119

Flyer Modbus protocol chapter  196

Flyer tab. See “Device” (Flyer) tab

Flyer U-Boot Version property

description,  119
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Flyer USB menu command

description,  97

Focusing lens. See Lens

Fonts

ascenders/descenders,  91, 110–111

Fonts folder  31, 47, 110, 159

Font Type property  31, 47, 48, 170, 189

description,  110, 159

Food and Drug Administration (FDA)  LS-4

Format tab  27, 28, 31, 32, 47, 48, 51, 53, 55, 

 58, 59, 70, 84, 91, 136, 162  174, 205

Object properties,  155–178

Freehand Tool  25

description,  26

From Another Object property  114, 137, 146,  

 159, 167, 170

description,  144–145

From Current Property Value  179

From Default Text  179

G

General Settings dialog box  102

General Settings... menu command  18, 19,  

 29, 130, 199

Application Settings tab,  102–104

“Device” (Flyer) tab,  118–130

description,  94

Drawing defaults tab,  104–106

Object Defaults tab,  106–117

Get Flyer Head Logs menu command  200

description,  95

Getting Started section  1–42

Graphics file formats  85

Graphics files  49

importing,  32–33

import notes,  83–85

scaling,  112

units,  33

troubleshooting,  203–205

Graphic Tool  32

description,  27

Grayscale, Color Reduction Method  84, 116,  

 175, 176, 205

Grayscale images  83, 110, 176, 177

Grid lines  103

Grid Offset X property

description,  103

Grid Offset Y property

description,  103

Grid Spacing property  104, 110

description,  103

Group menu command  107, 156

description,  89

Group objects  84, 107

H

Halftone, Color Reduction Method  84, 175,  

 205

Halt marking  56

warning,  45

Hardlock  24, 25, 35, 73

driver,  14, 15

file transfer note,  13

installation,  13–14

parallel port,  13–14, 15

USB,  13, 15

Hardware compatibility  8

Hatch fills  84

Hazard information  LS-1–LS-3

additional laser safety information,  LS-3

general hazards,  LS-1–LS-3

other hazards,  LS-3

terminology,  LS-1

Head Configuration Log  95

Head Info button  99

description,  100

Help menu  99–101, 188

About Synrad WinMark...,  99–100

Automation Flowchart...,  101

Synrad WinMark ActiveX Control Help,  101

Synrad WinMark FAQ,  101

Synrad WinMark on the Web,  101

Upgrade Flyer Firmware,  100
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Help Window  93

description,  29

Hexadecimal Count property  137

description,  138

I

I/O properties  129

Important Note

description,  LS-1

Import Arcs as Polylines property  33

description,  112

Importing arcs  33

Importing graphics  32

Import... menu command  32

description,  82–86

notes,  83–85

IncSerial Event Builder command

Delta,  184

description,  184

Input Bit Status  41

Input IN0  64, 65, 66, 67, 68, 71, 126, 131,  

 132, 186, 201

Input IN0-IN2  62

Input IN0-IN3  62

Input IN0-IN5  62

Input IN0-IN7  61, 62

Input IN1  186, 201

Input IN2  186, 201

Input IN3  42, 63, 64, 123, 131 186, 193, 199

Input IN3-IN7  62

Input IN4  186

Input IN5  186

Input IN6  186

Input IN7  129, 186

Input/output configuration  61–63

Input/output voltage levels  63, 202

Input  62

FH Smart,  62

Flyer/Fenix Flyer,  62

Index/Tracker, and Fenix,  62

Installation  11–15

Hardlock,  13–14

un-installing,  15

USB driver,  14

WinMark Pro,  11–15

Installation chapter  10–15

Interface properties  118–120

Interface Type property

description,  119

Internal Part Trigger property  201

description,  126

Interseg Break Angle property

description,  116, 153

Interseg Delay property  9, 116, 150, 153

description,  110, 152

Introduction chapter  3–9

Inventory  10

Invert Encoder Direction property  201

description,  126

Invert Text property  159

description,  161

Invert X Axis property

description,  106, 135

Invert Y Axis property

description,  106, 135

I/O

voltage levels,  63

testing  41

I/O voltage levels  63, 202

IP address range

restricting,  96

IP Gateway property

description,  120

IP Netmask property

description,  119
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J

JPEG file  49, 86

K

Keyboard Locked property

description,  123

Key marking parameters  52–53

Keyswitch  45, 63

L

Lase On/Off  42

Laser Control cable  199

Laser Duty Cycle display box  42

Laser Institute of America  LS-3

Laser Marking FAQ  9, 57, 59, 101, 206

Laser Output is PWM property

description,  123

Laser Safety handbook  LS-3

Laser safety information  LS-1–LS-6

Laser Timeout:  42

Last Bootup Log  95

Launcher window. See WinMark Launcher

Lens property  18, 27, 199

description,  121–122

No Lens,  122

Lens Selection dialog box  17, 18

Lens size  121–122

changing,  18

depth of field,  122

field sizes,  122

focused spot size,  122

optimal,  27

selecting,  17, 199

working distance,  122

Lens Spot Size property

description,  117, 154

License, WinMark Pro  xv

Line Spacing property

description,  113, 162

Line Tool  25

description,  26

Log file  39, 95, 129, 200

M

Main Bar menu command

Also See Toolbar

description,  93

Main Log  95

Main Messages Log  95, 200

Maintain Aspect Ratio  32

Maintenance properties  127

Main Window  28

description,  20

Mark Array property

description,  157

Mark button  16, 24, 47, 48, 49, 57, 60, 72,  

 73, 86, 87, 197, 198

description,  23

Stand-alone control mode,  23, 86, 200

WinMark control mode,  23

Mark Count property  38, 56, 57, 59, 66, 70,  

 74, 133, 142

description,  135

Mark Current File on Canvas button

description,  24

MarkDrawing method  56, 74, 178, 194, 206

Mark field

maximum,  27, 122

optimal,  27, 122

Mark file

compatibility,  9

development,  35–36

exporting,  86

optimization,  54–55

Marking basics chapter  45–55

Marking Head Firmware Version property

description,  119

Marking Head I/O connection  202, 203
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MarkingHeadOn Event Builder command

description,  184

Output Bit 1,  184

Output Bit 3,  184

Output Bit 4,  184

Output Bit 5,  184

Output Bit 6,  185

Output Bit 7,  185

PCI Card ID,  184

Marking parts  39–40

Marking parts chapter  56–60

Marking tab  28, 47, 48, 49, 50, 51, 52, 54,  

 55, 57, 58, 59, 70, 130, 135, 136, 

 142, 145, 146, 149, 154, 176, 178, 200

Drawing properties,  133–135

Object properties,  146–178

Marking Window  125

Mark Log  87, 95, 129, 145

format,  39

window,  39

Mark... menu command  73

description,  86

Mark Object property  145, 146, 185, 187

description,  107, 146–147

Mark On Startup property

description,  129

Mark optimization  54–55

Mark Pass Delay property

description,  108, 147

Mark Passes property  53, 195

description,  107, 147

Mark Pitch  126

Mark Preview window  38, 105, 134

Mark session  69, 133

description,  56

Mark session flowchart  56, 64, 72

Master Control File (MCF)  17, 129

MatchDigitalState Event Builder command   

 71, 89, 107, 147

description, 185 – 188

Input Bit 0,  186

Input Bit 1,  186

Input Bit 2,  186

Input Bit 3,  186, 187

Input Bit 4,  186, 187

Input Bit 5,  186

Input Bit 6,  186

Input Bit 7,  186

Timeout MSecs,  185, 187, 188

Material processing

hazards,  LS-2, LS-3

Material Safety Data Sheets (MSDS)  LS-2

Measurement units

changing,  19

Menu commands  81–101

MicroPDF code  114–115

MicroPDF Code 128 Emulation property

description,  115, 170

MicroPDF Disable Macro Character property

description,  115, 170

MicroPDF Mode property

description,  115, 169

MicroPDF Reader Init property

description,  114, 169

Micro QR Code  27, 52, 116

format,  172, 173

Minor Arc Radius property

description,  164

Min Power Threshold property  176, 205

description,  148

Mirror menu command

description,  92

Mirror X

shortcut button,  22, 92

Mirror Y

shortcut button,  22, 92

MKH file  15, 21, 130, 206

Modbus I/P protocol  16, 128, 196

Modbus User Function property

description,  128

Modify Drawing… menu command  40

Motion Vector property  202
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description,  125

Multiple head operation

important note,  97

N

Network share  142

Network Share Available property

description,  120

New button  21, 30

New menu command  30, 121, 182

description,  81

shortcut button,  21, 30, 81

New Height  32

New Width  32

No Cross Gap property

description,  135

No Cross property

description,  135

No Lens  122

None property

description,  137

Non-proportional scaling  106, 121

Note

description,  LS-1

Notepad  95

Nudge Spacing property

description,  104

O

Object %  38

Object Defaults tab  26, 33, 50, 84, 89, 94,  

 107, 149, 156, 176, 204

properties,  106–117

Object delays  9, 53

Object format properties  156

Object Height  91

Object Left Pos property

description,  156

Object List  29, 57, 59, 66, 70, 93, 130, 136,  

 203

description,  28

Object Name property  195

description,  118, 136

Object properties  94, 102, 136–178

Object properties chapter  136–178

Object properties

All tab,  178

Automation tab,  137–146

Format tab,  154–178

Marking tab,  146–154

Special tab,  136

Objects commands  89–94

Objects menu  34, 59

Align...,  90

Center on Field,  91

Explode,  90

Group,  89

Mirror,  92

Set Marking Order...,  92

Transformations...,  91

Unexplode,  90

Ungroup,  90

Use Objects For Defaults...,  92

Object Top Pos property

description,  156

Object Transformations dialog box  32, 34, 49,  

 91, 111, 160

Maintain Aspect Ratio checkbox,  111

Occupational Safety and Health Administration  

 (OSHA)  LS-3

Online Technical Manual,  LS-3

OCX file  75, 77, 195

Off-line mark file development  35–36

Off Vector Delay property  9, 150, 177

description,  110, 152

Off Vector Resolution property

description,  117, 153

Off Vector Velocity property  54, 149

description,  117, 152

On Abort Session automation  56, 129, 179
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description,  133

On After Mark Piece automation  179

description,  132

On After Mark Session automation  56, 179

description,  133

On Before Mark Piece automation  179, 182,  

 187

description,  132

On Before Mark Session automation  179

description,  131

On-line mark file development  35

Open button  21, 32

Open dialog box  27, 32, 39, 49, 50, 82, 100

Open Drawing On Head property  40

Open... menu command  39

description,  82

shortcut button,  21, 82

Open Network Mark File button

description,  25

Open Type Font property

description,  110, 159

OpenType fonts  31, 47, 84, 91, 109, 110, 159, 

 170

Optimal Field Height property  27

description,  123

Optimal Field Width property  27

description,  123

Optimization  54–55

Optimize Vector Import property

description,  112

Origin lines  103

description,  27

Operating System (OS) compatibility  7

OTF file  110, 159, 170

Output Bit Status  42

Output OUT0  192

Output OUT0-OUT7  61, 62

Output OUT1  192

Output OUT2  192

Output OUT2-OUT7  62

Output OUT3  192

Outputs OUT3-OUT6  62

Output OUT4  65, 66, 67, 68, 71, 184, 191,  

 192

Output OUT4/OUT5  62

Output OUT4-OUT7  62

Output OUT5  184, 191, 192

Output OUT6  129, 185, 191, 192

Output OUT6/OUT7  62

Output OUT7  124, 185, 191

Outputs  62–63

FH Smart,  62

Flyer/Fenix Flyer,  62

Index, Tracker, and Fenix,  63

Over-temperature warning output  124

P

Parallel port  13–14, 24, 25

Part marking  56–60

batch marking,  58–60

piece marking,  57–58

Part Moving Input property

description,  178

Part Pitch property  201

description,  126

Part sensor  201

Password  17, 40, 103

Flyer IP address range  96

Paste button  21

Paste menu command

description,  88

shortcut button,  21, 88

PDF 417 Security Level property

description,  114, 169

PDF 417 Truncated property

description,  114, 169
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PDF 417 X/Y Ratio property

description,  114, 169

PFB file  110, 159, 170

Piece %  38

Piece Count  38

Piece Count dialog box  135

Piece marking  57–58

Pline End Delay property  9, 33, 150, 177

description,  109, 151

Pline Start Delay property  9, 33, 54, 177

description,  109, 150–151

negative values,  54, 151

Polyline Fill Type property

description,  163

Polyline format properties  163–164

Polyline Mark Outline property

description,  163

Polyline object  109, 149

Polyline Outline Power property

description,  163–164

Polyline Set  84, 90, 147, 149

Position encoder  201

Positioning objects  34

PostScript fonts  31, 47, 110, 159, 170

Power Adjustment property

description,  124

Power property  27, 47, 48, 49, 50, 51, 52, 54,  

 55, 57, 58, 70, 124, 161, 163, 165,  

 176, 177, 205

description,  53, 108, 148

Power Wizard

trademark,  xiv

Print All Properties... menu command

description,  82

Print dialog box  82

Print Drawing button  21

Print Drawing... menu command  86

description,  82

shortcut button,  21, 82

Product Line Speed property  201, 202

description,  126

Progress window  38, 40

Properties menu command

description,  93

Property List  26, 27, 31, 32, 57, 58, 59,   

66, 69, 93, 130, 136, 149, 158, 167,   

171, 182, 186

description,  28–29

PS file  86

PWM Frequency property  161, 163, 165, 177

description,  149

Q

QR Code  27, 52, 116

QR Code format  171, 172, 173

Quick Mark menu command  73

description,  86–87

Quiet zone  51, 168, 172

R

Radial Marking property

description,  178

Randomize Bitmap property

description,  177

Raster Fill Border property  159

description,  161

Raster marking  54–55

description,  46, 161, 163, 165, 172

Raster Scan Direction property  110, 153

description,  109, 156

ReadFromSerialPort Event Builder command

Close After Read,  189

COM Port,  188

description,  188–189

Timeout MSecs,  189

ReadLineFromFile Event Builder command

description,  189–190

Filename,  189–190

File Wrap,  190
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ReadyStatus Event Builder command

description,  190–191

Output Bit 1,  190

Output Bit 3,  191

Output Bit 4,  191

Output Bit 5,  191

Output Bit 6,  191

Output Bit 7,  191

PCI Card ID,  190

“recent files” menu command

description,  87

Rectangles

creating,  32

Rectangle Tool  25, 32

description,  26

Redo menu command

description,  87

Reference materials  xvi

Release notes  3, 206

Remote Interlock  63

Remote Keyswitch  63

Remote Reset input  45

Requirements

marking head,  4

operating system,  4

WinMark Pro,  4

Resize objects  91

Resizing bitmaps  84, 149, 176

Resolution

bar codes,  51, 53

bitmap setting,  205

imported bitmaps,  176, 204

Resolution property  49, 50, 52, 54, 57, 58, 84,  

 108, 109, 117, 154, 161, 163, 165,  

 174, 175, 176, 177, 204, 205

description,  53, 108–109, 149

RestoreProperty Event Builder Command

description,  191

Rising Edge Part Sense property

description,  125

Rotate objects  91

Rotate -45 button

shortcut button,  22, 91

Rotate +45 button

shortcut button,  22, 91

Row Spacing property  59

description,  157

S

Sales and Applications  xvi

Sample mark files  101

Samples folder  13, 32, 49, 50, 182

Save As dialog box  39, 82

Save As... menu command

description,  82

Save button  21

Save Current File to Filestore button

description,  25

Save File to Head menu command

description,  82

Save Flyer Files dialog box  82

Save Last Serial property  69, 137, 139, 159,  

 167

description,  138

Save menu command

description,  82

shortcut button,  21, 82

SaveProperty Event Builder command

description,  191

Save Serial Name property  69, 70, 137

description,  138

Scaling objects  33, 91

Select All menu command  18, 89

description,  88

Select Ethernet IP Address dialog box  98,  

 119, 120

Selection Tool  34

description,  26

Sensor Distance property

description,  125
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Serialization  69–73

automated marking,  72–73

automation setup,  71–72

marking setup,  70

serial number setup,  69–70

Serial Number Delta property

description,  137–138

Serial Number Mask property  137

description,  138

Serial Number property

description,  119

Serial Number Text property  69

description,  137–139

Serial Piece Step property  137

description,  138

Serial Port Settings dialog box  143, 189

Serial Port Text property  138

description,  142–143

Set Date and Time dialog box  95

Set Digital After Mark automation  68, 71

description,  133

Set Digital Before Mark automation  67, 71

description,  132

Set Digital Before Piece automation  66, 71

description,  131

SetDigital commands  65, 124

SetDigitalState Event Builder command

description,  191–192

Output Bit 0,  192

Output Bit 1,  192

Output Bit 2,  192

Output Bit 3,  192

Output Bit 4,  192

Output Bit 5,  192

Output Bit 6,  192

Output Bit 7,  192

Set Flyer Time menu command

description,  95

Set Marking Order... menu command

description,  92

Set-up properties  121–124

Share Domain property

description,  120

Share Name property

description,  120

Share Password property

description,  120

Share ReadOnly property

description,  120

Share Server property

description,  120

Share Username property

description,  120

Shift key  27, 32

Shortcut to WinMark icon  17

Show Array property

description,  157

Show Common Props property

description,  103

Show Grid property  82, 86

description,  103

Show Left Ruler property

description,  104

Show Origin property  86

description,  103

Show Top Ruler property

description,  104

Show Units Type property  125

ActiveMark (ActiveX) note,  19, 77, 103, 195

description,  103

Slide Bar

description,  28

SmartFH Client IP Address property

description,  129

Snap to Grid property  26, 27

description,  104

Special tab  28, 178

description,  136

Object Name,  136

Object properties,  136 

Specifications

Default delay values,  150

Flyer/Fenix Flyer lenses,  122
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Spot format properties  173

Spot Lase Duration property  27, 32

description,  173

Spot Mark Duration property

description,  117, 154

Spot Marking Style property  149

description,  117, 154

Spots

creating,  32

Spot size  122

Spot Tool  32, 117, 154

description,  27

Stand-alone control mode  16–17, 128, 138,  

 159, 170

Mark button,  23

troubleshooting,  200–202

Standalone Marking property  23, 24, 86

description,  128

Standalone Mark Log Level property

description,  129

Stand-alone Master Control File  17

Stand-alone properties  128–129

Stand-alone Toolbar  23–25, 93

Start-F1 button  23, 39, 47, 48, 49, 56, 60, 65,  

 72, 73, 87

Starting WinMark Pro chapter  16–19

Start marking immediately after Launcher loads 

check box  39

‘start mark’ signal  56, 63, 65, 66, 67, 68, 71, 

125, 131, 132, 133, 135, 188

Startup Drawing property  40

description,  129

Startup Option settings  39

Startup Options… dialog box  94

Startup Options... menu command  12

description,  94

State diagram  64

sample,  65

Status Bar

description,  29

Status Bar menu command

description,  93

Status indicator  100

Step Command Output property

description,  178

Stroke Font property  47

description,  110, 160

Stroke fonts  31, 46, 47, 91, 111, 113, 159,  

 170

description,  110, 160

Switch IO Output 7 property

description,  124

SYF file  110

SynComm. See External Communications  

 Server property

SYNRAD

European headquarters,  xvi

registered trademark,  xiv

worldwide headquarters  xvi

Synrad WinMark ActiveX Control Help menu  

 command

description,  101

Synrad WinMark control  75, 76, 195

Synrad WinMark dialog box  47, 48, 49, 56,  

 58, 60, 72, 87

Synrad WinMark FAQ menu command

description,  101

Synrad WinMark icon  17

Synrad WinMark Launcher dialog box  86, 87

Synrad WinMark on the Web menu command

description,  101

System Registry  11, 12, 37, 41, 69, 138, 140,  

 181

T

TAB key  91, 111, 160

Technical support  xvi, 9

Temperature status  

description,  100
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indicator,  100

Temperature Status indicator  100

Test Mark button  64, 95, 123, 199

Text

creating,  30–31

Text Bold property  159

description,  111, 160

Text Caption Editor dialog box  26, 30, 31, 47,  

 48, 52, 69, 137, 158, 159, 167, 170,  

 171

Text Caption property  114, 137, 139, 141,  

 142, 144, 145, 146, 180, 182, 184,  

 189, 195

description,  158–159

Text Curve Detail property  48, 55, 159

description,  112, 162

Text Filled property  47, 48, 85, 159

description,  112, 161

Text format properties  158–162

Text From Com Port property  142

description,  143

Text Height property  16, 47, 48, 53, 91, 111, 

  189

description,  110, 160

variations note,  110–111

Text Italics property  159

description,  111, 161

Text Justification property  31

description,  112, 162

Text object  84, 109, 144, 149, 156, 182, 186,  

 195

Text Outline Filled property  159, 162

description,  161

Text Outline Power property  159, 161, 162

description,  162

Text Radius property

description,  162

Text Source Filename property  141

description,  142, 144

Text Tool  30, 47, 48, 69

description,  26

Text Underline property

description,  112

Text User Prompt property  143

description,  144

Text Width property

description,  112, 162

Threshold Level property

description,  177

TIF file  49, 204

Tile menu command

description,  98

Time Offset: Days property  139

description,  141

Time Offset: Hours property  139

description,  141

Time Offset: Minutes property  139

description,  141

Timeout (msec) property

description,  178

Toggle Lase button  42

Toggle Property Window button  22, 29

Toolbar  21–22, 29, 30, 34, 57, 60, 81, 82, 86, 

 87, 88, 90, 91, 92, 93

Toolbars dialog box  93

Tool Box  30, 31, 32, 47, 93

description,  25–27

Tools menu  18, 19, 29, 94–96, 130, 199, 200

Custom Test Mark...,  95

Flyer IP Address Range,  96

General Settings...,  94

Get Flyer Head Logs,  95

Set Flyer Time,  95

Startup Options...,  94

Virtual Laser Marking...,  95

Total Time  38

Tracker marking

properties,  124–126

troubleshooting,  200–202

Tracking tab  29

description,  130

Tracking Window  201



Index  226

WinMark Pro v6.3 User Guide

Track Marking Object property  125, 130, 134,  

 200

description,  133

Trademark information  xiv

Transformations... menu command

description,  91

shortcut button,    22, 34, 91

Transform button  22, 34, 91

Troubleshooting

ActiveMark,  206

automation I/O,  202–203

Flyer/Fenix Flyer,  197–200

graphics imports,  203–205

Stand-alone mode,  200

Tracking mode,  200–202

Troubleshooting chapter  197–206

TrueType Font property  48

description,  110, 159

TrueType fonts  31, 47, 48, 84, 85, 91, 109,  

 110, 111, 112, 113, 114, 156, 159,  

 160, 161, 162, 170

TTF file  110, 159

TXT file  141, 142, 190

U

UID/Composite property  137

description,  145

Undo Depth property  87

description,  104

Undo menu command  90

description,  87

Unexplode menu command  84

description,  90

Ungroup menu command  84

description,  90

Unique Identification (UID)  145, 159

Upgrades

software,  5

Upgrade Flyer Firmware menu command

description,  100

Upload Current Mark File button

description,  24

USB Communication cable  11, 14, 197

USB device driver  3, 4, 197–198

installation,  13, 14

installation note,  14

USB port  13, 14, 24, 25, 73, 97

Use Control File property

description,  129

Use DHCP property

description,  119

Use Group Properties property  89

description,  107, 156

Use Object For Defaults... menu command

description,  92

Use Quadrature Encoder property

description,  125

User Entry Text property  137

description,  143–144

User Input dialog box  179

User Interface connector  202, 203

Use Simulated Head  17

V

Vector graphics  49, 50–51, 84

troubleshooting,  203–204

units,  33

Vector Import Scale property  33, 83

description,  112

Vector Import Scale Value property  33

description,  112

Vector marking  54

description,  46–48

Velocity property  47, 48, 49, 50, 51, 52, 54,  

 55, 57, 58, 70, 117, 161, 163, 165,  

 176, 177

description,  53, 108, 148

Version information  5–6

View commands  92–94

View menu  28, 92–94, 98

Draw Tools,  93
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Flyer Files,  93

Main Bar (ToolBar),  93

Properties,  93

Status Bar,  93

Work Book,  94

Zoom Extents,  92

Zoom In,  93

Zoom Out,  93

Zoom Page,  93

Virtual Laser Marking... menu command

description,  95

Visual Basic

sample code,  77, 195

Visual C++

sample code,  77, 195

Voltage levels

I/O,  63, 202

W

Wait Digital After Piece automation  68, 71

description,  132

Wait Digital Before Piece automation  64, 67,  

 71

description,  131

WaitDigital commands  65

WaitDigitalState Event Builder command  71

description,  192–193

Input Bit 0,  192

Input Bit 1,  192

Input Bit 2,  193

Input Bit 3,  193

Input Bit 4,  193

Input Bit 5,  193

Input Bit 6,  193

Input Bit 7,  193

Timeout MSecs,  192

Warning

air contaminants,  LS-2

definition,  LS-1

halt marking,  45

hazardous radiation exposure,  LS-2

immediate marking,  24

laser safety precautions,  LS-2

Wait Digital inputs,  132

Warranty information  xv

Web Access Log  95

Web Error Log  95

Window commands  98

Window menu  98

Cascade,  98

“current active file”,  98

Tile,  98

Windows Control Panel  198

Windows’ Fonts folder. See Fonts folder

Windows Log File  39

WinMark control mode  16, 73, 142

Mark button,  23

WinMark Digital Scope chapter  41–42

WinMark Digital Scope. See Digital Scope

WinMark Launcher  12, 14, 30, 37–40, 41, 94

description,  37–40

display,  38

Fast Preview check box,  38

icon,  38

Launcher window,  16, 23, 37, 56, 65, 72, 

87, 105

Launcher window, stand-alone mode,  40

Mark Log window,  39

Mark Preview window,  38

minimizing,  40

Progress window,  38

stand-alone mode,  40

Write to Log File check box,  39

Zoom to Fit check box,  38

WinMark Launcher chapter  37–40

WinMark Pro

basic concepts,  16

CD,  10, 11

clean installation,  11–12

command line switch,  36

compatibility,  7–8, 9

control modes,  16–17

coordinate system,  27

demo mode,  35–36

Drawing Editor,  20–29

file development,  35–36

File Import Filters,  14

Hardlock installation,  13–14

icon,  17, 36
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initial start-up,  17

installation,  10–15

installation requirements,  4

introduction,  3

legacy version information,  5–6

license,  xv

Lite,  6

mark file compatibility,  9

menu commands,  81–101

new features,  3

operating system requirements,  4

registered trademark,  xiv

release notes,  3, 206

samples folder,  13

setting measurement units,  19

ship kit contents,  10

starting,  16–19

System Registry settings,  11–12

technical support,  xvi, 9

un-installing,  15

upgrades,  5

version/build numbers,  5

web site,  3, 5, 6, 9, 74, 77, 100, 101, 125, 

128, 134, 178, 195, 196, 206

WinMark Pro Drawing Editor chapter  20–29

WinMark Pro menu commands chapter  81– 

 101

WMF file  49, 84

Wobble On property

description,  108, 147

Wobble properties  147–148

Wobble Step Size property

description,  108, 147–148

Wobble Style property

description,  108, 148

Wobble Thickness property

description,  108, 147

Work Book menu command  98

description,  94

Work Book tabs  94, 98

Working distance  122, 199

Working Distance property

description,  122

Write to Log File check box  39

X

XY coordinate system  27, 195

X-Y Origin Lines. See Origin lines

Y

Z

Z-axis  199

Zoom Extents button  22

Zoom Extents menu command

description,  92

shortcut button,  22, 92

Zoom In button  21

Zoom In menu command

description,  93

shortcut button,  21, 93

Zoom Out button  21

Zoom Out menu command

description,  93

shortcut button,  21, 93

Zoom Page button  21

Zoom Page menu command

description,  93

shortcut button,  21, 93

Zoom to Fit check box  38

Zoom Tool

description,  26
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